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OContent of this Instruction Manual
O DPP is used for Digital Photo Professional.
O ` indicates the selection procedure of the menu.

Example: [Digital Photo Professional] menu ` 
[Quit Digital Photo Professional].

O Square brackets are used to indicate items such 
as menu names, button names and window 
names that appear on the computer screen.

O Text inside < > indicates a key on the keyboard.
O ** indicates a reference page.

Click to move to the relevant page.
O  : Marks helpful information when a problem 

arises.
O  : Marks tips for using the software skillfully.
O  : Marks information that should be read 

before use.
O  : Marks additional information you may find 

helpful.

© CANON INC. 2012     CCS-M034DPPME-000

OSwitching Between Pages
O Click on arrows on the bottom right of the screen.

 : next page
 : previous page
 : return to a page you had previously 

displayed
O Click on the chapter headings on the right side 

of the screen to switch to the contents page of 
that chapter. Also, click the item you want to 
read about on the table of contents to move to 
the relevant page.

OHelp and Shortcut Keys
O For information about using DPP, refer to Help 

from the [Help] menu.
O Refer to the “Shortcut Key List” in the Help for a 

list of shortcut keys which are helpful for quick 
operation.

RAW Image Processing, Viewing and Editing Software

Digital Photo Professional
Ver. 3.11

Instruction Manual

CO
PY



1

1
2
3
4
5

Introduction

Contents at 
a Glance

Basic 
Operation

Advanced 
Operation

Advanced 
Image Editing 
and Printing

Editing 
JPEG/TIFF 

Images

Index

Processing 
Large Numbers 

of Images

Reference

CANON SOFTWARE LICENSE AGREEMENT
IMPORTANT - READ THIS AGREEMENT BEFORE USING THE SOFTWARE ON THE CD-ROM 
IN THIS BOX. BY USING THE SOFTWARE, YOU AGREE TO BE BOUND BY THE TERMS OF 
THIS AGREEMENT.
This is a license agreement (the [Agreement]) between you and Canon Inc. ([Canon]). 
IF YOU DO NOT AGREE TO THE TERMS AND CONDITIONS OF THIS AGREEMENT, DO NOT 
USE THE SOFTWARE PROGRAM ON THE CD-ROM AND THE USER MANUAL IN THIS BOX 
(COLLECTIVELY, THE [SOFTWARE]) AND RETURN THE SOFTWARE WITHIN 30 DAYS FROM 
THE DATE OF PURCHASE TO YOUR POINT OF PURCHASE FOR A REFUND.
In consideration of the right to use the SOFTWARE, you agree to abide by the terms and conditions 
of this Agreement.
1. LICENSE: Canon grants you the non-exclusive right to use the SOFTWARE only on a single 

computer. You may physically transfer the SOFTWARE from one computer to another provided 
that the SOFTWARE is used on only one computer at a time. You shall not install or use the 
SOFTWARE on a network, multiple CPU, multiple site arrangement, or any other hardware 
configuration where the SOFTWARE is accessible to more than one CPU or to more than one 
user.

YOU SHALL NOT ASSIGN, SUBLICENSE, RENT, LEASE, LOAN, CONVEY OR OTHERWISE USE, 
TRANSFER, COPY, TRANSLATE, CONVERT TO ANOTHER PROGRAMMING LANGUAGE, 
ALTER, MODIFY, DECOMPILE OR DISASSEMBLE THE SOFTWARE, IN WHOLE OR IN PART, 
EXCEPT AS EXPRESSLY PROVIDED IN THIS AGREEMENT.
2. BACK-UP COPY: You may make one copy of the SOFTWARE solely for back-up purposes, or 

copy the SOFTWARE onto the permanent storage device (e.g. a hard disk) of your computer 
and retain the original for back-up purposes. Any other copying of the SOFTWARE is a violation 
of this Agreement. You must reproduce and include the copyright notice on the back-up copy.

3. SUPPORT AND UPDATES: Canon is not responsible for providing maintenance or support for 
use of the SOFTWARE. No updates, fixes or support will be made available for the 
SOFTWARE.

4. LIMITED WARRANTY AND LIMITATION OF LIABILITY: It is your responsibility to choose, 
maintain and match the hardware and software components of your computer system. Thus 
Canon does not guarantee uninterrupted service or correction of errors or that the functions or 
performance of the SOFTWARE will meet your requirements. THE SOFTWARE IS LICENSED 
ON AN [AS IS] BASIS AND WITHOUT WARRANTY OF ANY KIND. The CD-ROM storing the 
SOFTWARE is warranted only against defective material under normal use for a period of ninety 
(90) days after purchase from an authorized Canon dealer as evidenced by your sales receipt. 
Your sole remedy for a defective CD-ROM shall be replacement of the same without charge 
when returned by you at your expense to your point of purchase and proven to be defective 
upon inspection. The replacement CD-ROM will be warranted for the remainder of the original 
ninety (90) day warranty period of the defective CD-ROM. The limited warranty does not apply if 
the failure of the CD-ROM resulted from accident, abuse or misapplication of the SOFTWARE 
and shall not extend to anyone other than the original user of the SOFTWARE.

EXCEPT AS SPECIFICALLY SET FORTH IN THIS PARAGRAPH 4, CANON, CANON’S 
SUBSIDIARIES, DISTRIBUTORS AND DEALERS DISCLAIM ALL WARRANTIES, EXPRESS OR 
IMPLIED, INCLUDING ANY WARRANTY OF MERCHANTABILITY OR FITNESS FOR A 
PARTICULAR PURPOSE, WITH RESPECT TO THE SOFTWARE.

NEITHER CANON NOR ANY OF CANON’S SUBSIDIARIES, DISTRIBUTORS OR DEALERS IS 
LIABLE FOR ANY DAMAGES HOWSOEVER CAUSED, INCLUDING WITHOUT LIMITATION, 
DIRECT, CONSEQUENTIAL OR INCIDENTAL LOSS OR DAMAGE INCLUDING LOSS OF 
PROFITS, EXPENSE OR INCONVENIENCE HOWSOEVER CAUSED OR ARISING OUT OF THE 
SOFTWARE OR THE USE THEREOF.
NEITHER CANON, NOR ANY OF CANON’S SUBSIDIARIES, DISTRIBUTORS OR DEALERS 
SHALL HAVE ANY OBLIGATION TO INDEMNIFY YOU AGAINST ANY CLAIM OR SUIT 
BROUGHT BY A THIRD PARTY ALLEGING THAT THE SOFTWARE OR THE USE THEREOF 
INFRINGES ANY INTELLECTUAL PROPERTY OF SUCH THIRD PARTY.
5. TERM: This Agreement is effective upon your using the SOFTWARE and remains in effect until 

expiration of all copyright interests in the SOFTWARE unless earlier terminated. You may 
terminate this Agreement by destroying the SOFTWARE. This Agreement will also terminate 
without notice to you if you fail to comply with any of the terms of this Agreement and you must 
then promptly return the SOFTWARE. In addition, Canon may enforce its other legal rights.

6. U.S. GOVERNMENT RESTRICTED RIGHTS NOTICE: The SOFTWARE is provided with 
restricted rights. Use, duplication or disclosure is subject to restrictions as set forth in either 
subparagraph (c) (1) (ii) of the Rights in Technical Data and Computer software clause at 
DFARs 252.227-7013 or subparagraph (c) (1) and (2) of the Commercial Computer Software 
Restricted Rights Clause at FAR 52.227-19, as applicable.

7. SEVERABILITY: In the event that any provision of this Agreement is declared or found to be 
illegal by any court or tribunal of competent jurisdiction, such provision shall be null and void 
with respect to the jurisdiction of that court or tribunal and all the remaining provisions of this 
Agreement shall remain in full force and effect.

8. CONTROLLING LAW: The terms of this Agreement as it relates to purchases of the Software in 
the United States of America shall be governed and construed in all respects in accordance with 
the laws and regulations of the State of New York, without reference to choice of law principles. 
The terms of this Agreement as it relates to purchases of the Software in Canada shall be 
governed by the laws of the province of Ontario.

9. OWNERSHIP: All rights, including but not limited to copyrights and trade secret rights, to the 
SOFTWARE belong to Canon, its affiliated corporations and third party licensors. Your use of 
the SOFTWARE is subject to the United States, Canada and other applicable copyright and 
trademark laws and nothing in this Agreement constitutes a waiver of the rights of Canon, its 
affiliated corporations and third party licensors under such laws.
Nothing contained in Paragraph 1 shall be construed to give Canon any ownership rights in any 
images, graphics or textual material that you save in connection with the Software.

10.ACKNOWLEDGEMENT: BY USING THE SOFTWARE, YOU ACKNOWLEDGE THAT YOU 
HAVE READ THIS AGREEMENT, UNDERSTOOD IT, AND AGREE TO BE BOUND BY ITS 
TERMS AND CONDITIONS. YOU ALSO AGREE THAT THIS AGREEMENT IS THE 
COMPLETE AND EXCLUSIVE STATEMENT OF AGREEMENT BETWEEN YOU AND CANON 
CONCERNING THE SUBJECT MATTER HEREOF AND SUPERSEDES ALL PROPOSALS 
OR PRIOR AGREEMENTS, VERBAL OR WRITTEN, AND ANY OTHER COMMUNICATIONS 
BETWEEN THE PARTIES RELATING TO THE SUBJECT MATTER HEREOF. NO 
AMENDMENT TO THIS AGREEMENT SHALL BE EFFECTIVE UNLESS SIGNED BY A DULY 
AUTHORIZED OFFICER OF CANON.

READ CAREFULLY BEFORE USING!
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Introduction
Digital Photo Professional (hereinafter, “DPP”) is a high-performance 
RAW image processing, viewing and editing software for EOS DIGITAL 
cameras. It is often thought that RAW images are difficult to handle 
compared with ordinary JPEG images, but using DPP, you can perform 
advanced edits and print RAW images with ease. 

RAW Images and Their Features

A RAW image is image data that has recorded output data of imaging 
sensor. Because image processing does not occur inside the camera 
when a photo is taken and the photo has been recorded in the special 
form of “RAW image data + Image processing conditions information at 
the time of shooting”, special software is needed to view or edit the 
image.
* “RAW” means “in a natural condition” or “not processed or refined”.

If described in terms of film, the concept of a RAW image is a shot 
image not yet developed (latent image).
With film, the image appears for the first time when it is developed. In 
the same way, for RAW images too, you cannot view them as images on 
your computer unless you perform subsequent image signal processing.
Therefore, even though it is digital, this processing is called 
“development”.

DPP automatically carries out this “development” processing when 
RAW images are displayed in DPP.
As a result, RAW images displayed in DPP are images whose 
development processing has been completed.
With DPP, you can view, edit and print RAW images without having to be 
particularly conscious of the development processing.

What is a RAW Image?

What is RAW Development?

When is RAW Development done?

RAW images are recorded in the format “RAW image data + Image 
processing conditions information at the time of shooting”. When you 
open a RAW image in DPP, the image is automatically developed and 
you can view the image as an image to which image processing 
conditions at the time of shooting have been applied.
Even if you perform various adjustments to the image you have opened 
(it undergoes automatic development processing each time), only the 
image processing conditions (development conditions) change and the 
“original image data itself” remains unaffected. Consequently, image 
deterioration is not a problem and it is the perfect image data for users 
who want to get creative with their images after they have been shot. 
In DPP, the “Image processing conditions information” that can be 
adjusted is called a “Recipe”.

What Advantages Does a RAW Image Have?

RAW image data 

Image processing conditions information
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Main Features of DPP
Following are the main tasks you can perform with images you have 
downloaded to your computer.

O View and organize RAW images
O Real-time adjustment of a RAW image

O Various image adjustments while maintaining the original image
O Freely apply a Picture Style
O View your image before and after adjustment in the same window

O Trimming and adjusting the angle of an 
image

O Change image size
O Correction of lens aberration
O Automatic/manual dust erasure processing
O Convert from a RAW image to a JPEG or 

TIFF image and save
O Process large numbers of RAW images in batches
O Transfer the image to image editing software

O Print a RAW image
O View and organize JPEG and TIFF images
O Real-time adjustment of JPEG and TIFF 

images
O Various image adjustments while maintaining the original image

O Print JPEG and TIFF images
O Color management compatibility

O CMYK simulation for commercial printing

System Requirements

* Core2 Duo or higher is recommended
O This software program is not compatible with UFS (UNIX File System) 

formatted disks.
O Check the Canon website for the latest system requirements, 

including supported OS versions.

Supported Images
This software supports the following image types.

*1 Compatible with RAW images shot with EOS D6000 or EOS D2000 
that have been converted to RAW images using the CR2 Converter 
and have the “.CR2” extension.
For information on CR2 Converter, refer to Canon’s web site.

*2 • Only models where Digital Photo Professional is listed in the “Data 
Type” item in the “Specifications” section near the end of the 
Camera User Guide.

• Use the dedicated CameraWindow application to download images 
from a PowerShot camera to a computer. See the Software Starter 
Guide for details.

• Lens aberration correction can only be used with some camera and 
lens models.

• Automatic dust erasure processing and other EOS DIGITAL specific 
functions cannot be used.

OS Mac OS X 10.6 to 10.7
Computer Macintosh with one of the above OS installed
CPU* Intel processor
RAM Minimum 1GB

Display Resolution : 1024 × 768 or more
Colors : Thousands or more

Image type Extension

RAW images 

RAW images*1 shot with EOS DIGITAL 
cameras, excluding EOS DCS1 and 
EOS DCS3
RAW images*2 shot with PowerShot 
cameras

.CR2
.TIF

.CRW

JPEG images Exif 2.2, 2.21 or 2.3-compatible JPEG 
images .JPG, .JPEG

TIFF images Exif-compatible TIFF images .TIF, .TIFF
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Downloading Images to Your Computer
O Download images by connecting your camera and 

computer ¿ p.7

O Download images using a card reader ¿ p.9

Viewing and Checking RAW Images
O Quickly enlarge parts of an image ¿ p.11
O Sort images (check marks, rating) ¿ p.18, p.19
O Display an image shot simultaneously as a RAW 

image and JPEG image as a single image ¿ p.22

O Display the images in the thumbnail list display at high 
resolution ¿ p.23

O Check shooting information such as the shooting date ¿ p.10, p.23

Editing RAW Images (Adjusting)
O Adjust brightness/darkness
O Use automatic adjustment
O Change the Picture Style

¿ p.12, p.26
¿ p.33
¿ p.26

O Sharpen the modulation and contrast of colors (contrast) ¿ p.29
O Make skin tone look healthier (color tone) ¿ p.29
O Make the image colors more vivid (color saturation) ¿ p.29
O Make an image sharp (sharpness) ¿ p.31
O Adjust an image to make color tone more natural 

(white balance) ¿ p.27

O Change an image to black-and-white or sepia tones 
(monochrome) ¿ p.30

O Trim an image and adjust the angle of an image ¿ p.38
O Specify an aspect ratio that matches the size of the 

paper on which an image is to be printed ¿ p.38

O Erase dust shot with the image ¿ p.73, p.75
O Erase unwanted parts of an image ¿ p.77

O Auto correct RAW images with the Auto Lighting Optimizer ¿ p.61
O Adjust brightness of shadows/highlights ¿ p.57
O Reduce image noise ¿ p.62
O Correct lens aberration ¿ p.63
O Use the Digital Lens Optimizer ¿ p.69
O Use a Picture Style file ¿ p.59
O Edit efficiently ¿ p.34
O Edit an image while comparing the image before and 

after adjustment ¿ p.53

O Synchronize multiple images ¿ p.54
O Display an area beyond the set range as a warning 

indicator (Highlight/Shadow warning) ¿ p.55

O Restore an adjusted image to its condition at the time 
of shooting ¿ p.43

O Composite images ¿ p.78
O Create HDR (High Dynamic Range) images ¿ p.81

Printing
O Print well on a Canon printer ¿ p.43, p.87, p.88
O Faithfully reproduce the color of the subject 

when printing ¿ p.43, p.87, p.88

O Print with the shooting information ¿ p.85
O Print a thumbnail list of images ¿ p.86
O Approximate the color seen on screen with your 

printing results ¿ p.93

Conversion of Images
O Convert a RAW image to a JPEG image ¿ p.42, p.99 
O Edit in Photoshop ¿ p.77, p.100
O Perform batch processing ¿ p.99
O Edit (adjust) a JPEG image ¿ p.103

Contents at a Glance
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Basic Operation
The basic operational flow – from how to download to your computer 
images shot with a camera to checking, editing, saving and printing a 
downloaded RAW image – is explained here.

Starting up DPP.........................................................  6
Main Window Display ...................................................  6

Downloading an Image to Your Computer ................  7
Downloading Images Using Your Card Reader............  9

Viewing an Image ....................................................  10
View Images as Thumbnails in the Main Window ...... 10

Changing the Size of Thumbnail Images................ 10
Enlarge and View an Image in the Edit Window......... 11

Enlarging and Viewing a Specific Area................... 11
Adjusting an Image..................................................  12

About the Tool Palette ................................................ 12
About Recipes ............................................................ 12

Saving an Image......................................................  13
Saving......................................................................... 13

Printing an Image ....................................................  14
Printing ....................................................................... 14

Quitting DPP............................................................  14

CO
PY



6

1
2
3
4
5

Introduction

Contents at 
a Glance

Basic 
Operation

Advanced 
Operation

Advanced 
Image Editing 
and Printing

Editing 
JPEG/TIFF 

Images

Index

Processing 
Large Numbers 

of Images

Reference

Starting up DPP
Click the Dock icon.

¿DPP starts up and the main window ([Folder] window) appears.

Click

Main window ([Folder] window)

In the main window, you can use tabs to select either the [Folder] 
window or the [Collection] window. The [Folder] window displays the 
images in folders on your computer, while the [Collection] window (p.36) 
displays images selected randomly by the user from one or more folders 
and gathered together. 
Unless noted otherwise, the [Folder] window will be described as the 
main window from this point on.

Main Window Display

[Folder] window

[Collection] window
CO
PY
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Downloading an Image to Your Computer
Connect the camera and computer with the cable provided and 
download the images saved on the memory card inserted in the camera.
For downloading images, start up the camera software “EOS Utility” 
from DPP and use.

1 Select the save destination for the images.
O Select the save destination in the folder area on the left of the 

main window.
O When creating a folder, see p.50.

2 Start up EOS Utility.
O Select the [Tools] menu ` [Start EOS Utility].

¿EOS Utility starts up.

EOS Utility
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3 Connect your camera and computer and turn the 
camera on.
O Connect the camera and your computer with the interface cable 

provided with the camera and turn the camera on.
O For detailed instructions on connecting your camera and 

computer, refer to the “EOS Utility Instruction Manual” (PDF 
electronic manual).

4 Download images.

¿Downloading of images begins.
¿The downloaded images are saved in the folder selected in step 

1 and are displayed in the main window of DPP.
¿The downloaded images are sorted by date into folders and 

saved.

Click

Using EOS Utility to download images makes it easier to organize your 
images as they are downloaded, sorted and saved into folders by date.

Advantages of using EOS Utility to download images

O You cannot start up EOS Utility in the [Collection] window 
(p.6, p.36).

O When EOS Utility has been started up from DPP, you cannot use 
the following functions.
• Quick check window view (p.16)
• Trimming and adjusting the angle of an image (p.38, p.111)
• Digital Lens Optimizer (p.69)
• Compositing images (p.78)
• Creating HDR (High Dynamic Range) images (p.81)
• Dust erasure processing (copy stamp function) 
(p.73 to p.77, p.114 to p.118)

• Batch change file names (rename function) (p.101)
• Printing with shooting information (p.85)
• Printing a thumbnail list (contact sheet printing) (p.86)
• Printing using Easy-PhotoPrint EX or Easy-PhotoPrint 
(Plug-in printing) (p.43, p.46)

• Transferring images to Photoshop (p.77)
• Batch saving images (batch processing) (p.99)CO
PY
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You can also download images to the computer using a third-party card 
reader.

1 Load the memory card into the card reader.

2 Open a removable disk icon in the folder area and 
move the [DCIM] folder inside to a suitable place 
such as to the [Desktop].

¿The [DCIM] folder is downloaded to your computer.
O All images are saved in folder units inside the [DCIM] folder.

Downloading Images Using Your Card Reader 3 Display the images downloaded to your computer.
O In the [DCIM] folder copied to your desktop, select the folder 

where the shot images are saved.

¿ Images in the folder are displayed in the main window of DPP.

By selecting the memory card folder directly in DPP, the images in the 
folder are displayed in DPP and you can check the shot images.

Checking before downloading images

O Copying to your computer may take time when there is a large 
number of shot images saved in the memory card.

O For details on the [DCIM] folder structure and the file names of 
shot images, refer to “Folder Structure and File Names in the 
Memory Card” in the “EOS Utility Instruction Manual” (PDF 
electronic manual).
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Images downloaded to your computer are displayed as a thumbnails list 
in the main window. You can double-click an image to open the edit 
window and display the image at large size.

View Images as Thumbnails in the Main Window

Main window
Rotate selected image

Click to select the image
Display thumbnails of all the images inside the 
folder selected in the folder area on the left

O Images displayed with the [ ] icon are movie files and cannot 
be played back in DPP. Please use “ImageBrowser EX”, which is 
compatible with EOS DIGITAL movie files.

O If the message [Insufficient memory.] appears, there are too many 
images in one folder. Decrease the number of images in one 
folder such as by dividing them into smaller folders.

O When aspect ratio information is attached to the shot image with the 
EOS-1D X, EOS-1D Mark IV, EOS-1Ds Mark III, EOS-1D Mark III, EOS 
5D Mark III, EOS 7D, EOS 60D, EOS REBEL T4i/650D or EOS REBEL 
T3i/600D, the image is displayed as a trimmed image (p.38, p.111).

O For a list of main window functions, see p.124.

Changing the Size of Thumbnail Images
You can change the size of the thumbnail images displayed in the main 
window and display them with shooting information attached.

Select the [View] menu ` desired item.

¿The display changes to the selected item.

Viewing an Image
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¿The edit window appears.

¿ It may take time for the image to redraw itself.
O Click the [ ] in the upper left of the edit window to close the edit 

window.

Enlarge and View an Image in the Edit Window

Double-click

Edit window Tool palette

O By selecting the [View] menu ` [AF Point] in the edit window, you can 
display the AF points selected in the camera at the time of shooting.
However, AF points are not displayed for images whose image size 
has been changed and then been converted and saved (p.42, p.134), 
images for which you selected an effect other than [Shot settings] as 
correction of fisheye lens distortion aberration, or images which have 
had settings specified during RAW processing on the camera for 
distortion correction and chromatic aberration correction.

O For a list of edit window functions, see p.127.

Enlarging and Viewing a Specific Area
Double-click the area you want to enlarge.

¿The area you double-clicked is enlarged to 100% (actual pixel 
size). If you wait for a while, it changes to a clearer display.

O Double-click again to revert to the full view.
O To change the display position, drag on the image or drag the 

enlargement display position of the tool palette.

Double-click

Tool palette enlargement display position

Change the enlargement 
display position by 
dragging

Select the [View] menu ` [200% view] or [50% view].

To display an image in an enlargement ratio other than 100%

You can change the enlargement ratio when you double-click (p.91).
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Adjusting an Image
You can perform a variety of image adjustments, such as adjusting the 
brightness or changing the Picture Style of an image using the tool 
palette of the edit window. You can easily restore an image to its original 
settings with the [ ] button even if you have made the wrong 
adjustment. Try out the various adjustments.
As an example, the procedure to adjust the brightness of an image is 
explained here.

¿The image brightness changes in real time according to the 
amount of adjustments.

Reverts the image to 
the original settings
Drag the slider left or 
right

Tool palette

Select the [View] menu ` [Tool palette].

The tool palette does not display

You can adjust images with the tool palette by switching between the 
[RAW], [RGB], [NR/ALO] and [LENS] tab sheets according to your 
editing requirements.
Because adjustment made with the tool palette (it undergoes automatic 
development processing each time) only changes the image processing 
conditions, the “original image data itself” remains unaffected. 
Therefore, there are no problems with image deterioration that arise with 
editing and you can readjust your images any number of times.
See Chapter 2 onwards for more detailed information on the various 
functions of the tool palette.

In DPP, all the adjustment contents (image processing conditions 
information) made with the tool palette is saved to an image as data 
called a “Recipe” (p.96).

About the Tool Palette

About Recipes

For a list of tool palette functions, see p.128.
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Saving an Image
If you perform the save operation described here, you can save all the 
adjustment contents (recipe) made with the tool palette to the RAW 
image.

Select the [File] menu ` [Save].

¿Your adjustment contents (recipe) are saved to the image.

With DPP, you can perform the following types of saving according to 
your requirements. For detailed information on each saving method, see 
Chapter 2 onwards.
O Save (p.41)

Add adjustment contents (recipe) made with the tool palette to a RAW 
image and save.

O Save as (p.41)
Add adjustment contents (recipe) made with the tool palette to a RAW 
image and save as a separate RAW image. The original RAW image 
remains unaffected.

O Add thumbnail to image and save* (p.23)
Create a new thumbnail image for the main window and save to each 
image.
The quality of images in the main window improves and images 
redraw themselves more quickly.

O Convert and save (p.42)
Convert adjusted RAW image to a JPEG or TIFF image and save. 
The original RAW image remains unaffected.

O Batch process (p.99)
Convert in batches adjusted multiple RAW images to JPEG or TIFF 
images and save.
The original RAW images remain unaffected.

* Option available in the main window.

Saving
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Printing an Image
You can print images with a printer. As an example, the procedure to 
print one image on one sheet of paper is described here.

To set the paper size etc., select the [File] menu ` [Page setup].

With DPP, you can perform the following types of printing according to 
your requirements. For detailed information on each printing method, 
see Chapter 2 onwards.
O Print one image (p.49)
O Print using a Canon inkjet printer (p.43, p.46)
O Print with a high-end Canon printer (p.87)
O Print with shooting information (p.85)
O Printing a thumbnail list (contact sheet printing) (p.86)

1 Select the [File] menu ` [Print].

¿The [Print] dialog box appears.

2 Print.
O Specify the optimum settings for photograph printing in the 

printer’s print settings dialog box and click the [Print] button.
¿Printing begins.

To change the paper size

Printing

Quitting DPP
In the main window, select the [Digital Photo 
Professional] menu ` [Quit Digital Photo 
Professional].

¿DPP quits.

A confirmation dialog box for saving the images appears when you 
try to quit DPP without saving the adjusted image. Click the [Yes to 
all] button to save the adjustment contents (recipe) to all the images 
adjusted.
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Advanced Operation
A more advanced operation – from efficiently checking images, to 
various ways of editing an image, printing a RAW image using a Canon 
printer and sorting images – is explained here.

Efficiently Checking/Sorting Images......................... 16
Sorting Images...........................................................  18

Attaching Check Marks..........................................  18
Setting Ratings ......................................................  18

Sorting Images in the Main Window ..........................  19
Attaching Check Marks in the Main Window .........  19
Setting Ratings in the Main Window ......................  19

Arranging Images in the Main Window......................  20
Arranging by Type .................................................  20
Arranging Freely ....................................................  21

Displaying a RAW Image and JPEG Image as a Single 
Image.........................................................................  22
Improving the Quality of an Image in the Main Window... 23
Checking Image Information......................................  23

Editing an Image ...................................................... 25
About the RAW Tool Palette......................................  25

Editing with the Tool Palette in the Main Window..  25
Adjusting Brightness ..................................................  26
Changing a Picture Style ...........................................  26

Picture Style File....................................................  27
Adjusting Color Tone by Changing White Balance....  27
Adjusting Color Tone Using Click White Balance ......  28
Adjusting Contrast .....................................................  29
Changing Color Tone and Color Saturation...............  29

Adjusting Monochrome ..........................................  30
Adjusting Image Sharpness.......................................  31

Detailed Setting of Image Sharpness ..................... 32
Automatically Adjusting Brightness and Color (Tone 
Curve Assist) .............................................................. 33

Editing Efficiently .....................................................  34
Editing in the Edit Image Window............................... 34
Changing the Thumbnail Display Position to a Horizontal 
Position....................................................................... 36
Gathering and Editing Images in the Collection Window ... 36

Trimming and Adjusting the Angle of an Image.......  38
Applying Adjustment Contents to Other Images......  41
Saving Editing Results.............................................  41

Saving Editing Contents to a RAW Image.................. 41
Saving as a JPEG or TIFF Image............................... 42

Re-Editing an Image................................................  43
Printing an Image ....................................................  43

Printing Photographs with Canon Inkjet Printers 
Compatible with Easy-PhotoPrint EX ......................... 43
Printing Photographs with Canon Inkjet Printers 
Compatible with Easy-PhotoPrint ............................... 46
Printing Photographs with a Printer other than Canon 
Inkjet Printers.............................................................. 49

Organizing Images ..................................................  49
Deleting an Unwanted Image ..................................... 49
Creating a Folder for Saving Images.......................... 50
Moving Images ........................................................... 50
Moving Images in Folders .......................................... 51
Registering Frequent-Use Folders (Bookmark 
Registration) ............................................................... 51

Organizing Bookmarks ........................................... 51
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Efficiently Checking/Sorting Images
You can enlarge images displayed as thumbnails in the main window 
and efficiently check each image. You can attach check marks and sort 
images into five groups.

1 Display the quick check window.
O Click the [Quick check] button.

¿The quick check window appears.

2 Click the [Next] or [Previous] button to switch 
between images to be checked.

O All the images displayed in the main window can be checked in 
the quick check window.

Quick check window

3 Double-click the area you want to enlarge.

¿The area you double-clicked is enlarged to 50% view. 
O To change the display position, drag on the image.
O Double-click again to revert to the full view.
O To quit, click the [OK] button.

Double-click

When [AF Point] is checkmarked, you can display the AF points 
selected in the camera at the time of shooting. However, AF points 
are not displayed for images which have had their image size 
changed and then been converted and saved (p.42, p.134), which 
have had settings specified during RAW processing on the camera 
for distortion correction and chromatic aberration correction, which 
are composited, or which are created as HDR (High Dynamic 
Range) images.
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O To check only selected images
You can use the quick check window to check only selected images 
by selecting the desired images from those displayed in the main 
window and then performing step 1.

O Switch between images using the keyboard
You can also switch between images by pressing the < > + <�> or 
< > + <�> keys. 

O Switch between screens using the keyboard
You can also switch between full screen display/normal screen 
display by pressing the < > + <F11> keys.

O Operate using the menu
Each operation can also be performed with the menu which appears 
by clicking on the image while holding down the <control> key.

Convenient functions of the quick check window

O The enlargement ratio when an image is enlarged is half (50%) of 
the 100% (actual pixel size).

O You can change the enlargement ratio to 100%, when an image is 
enlarged (p.91).

O For a list of quick check window functions, see p.132. CO
PY
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You can sort images by attaching check marks or setting ratings 
(indicated with [ ] marks) for each subject or theme.

Attaching Check Marks
Display the image you want to attach a check mark 
to, and then click any one of [ ] to [ ].

Sorting Images

¿The selected check mark appears in the upper left of the window.

Click

Check mark

O Click the [Clear] button to remove the check mark.

O The values of check marks attached to images in DPP version 3.8 
or earlier are maintained as they are.

O You can also attach check marks from the menu that appears by 
clicking on an image in the main window while holding down the 
<control> key.

Setting Ratings
Display the image you want to rate, and then click 
any one of the [ ].

¿The rating is set and an icon corresponding to the selected [ ] 
appears in the upper left of the window.
(Window shown with a rating of three [ ])

O To set [Reject], click the [Reject] button. Click the [Reject] button 
again to cancel.

Click (changes to [ ] after 
clicking [ ])

Rating icon

O To cancel the rating, click the same [ ] as when the setting was 
made on the right of the window.

As the file structure of the image data is changed when a rating is 
set to an image, it may not be possible to check the image 
information in third-party software.

You can also set ratings (including [Reject] setting) from the menu 
that appears by clicking on an image in the main window while 
holding down the <control> key.
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You can also sort images in the main window by attaching check marks 
or setting ratings (indicated with [ ] marks) for each subject or theme.

Attaching Check Marks in the Main Window
Select the images you want to attach a check mark 
to, and then click any of [ ] to [ ] in the toolbar.

O Click the check mark in the toolbar again to remove the check 
marks.

Sorting Images in the Main Window

Select

Click

¿The selected check mark appears in the upper left of the image 
frame.

Check mark

Setting Ratings in the Main Window
Select the images you want to rate, and then click 
any of the [ ] in the toolbar.

O To cancel the rating, click the same [ ] as when the setting was 
made in the toolbar.

O [Reject] cannot be set with the toolbar. Set [Reject] with the 
[Label] menu or the quick check window (p.18).

Select

Click (changes to [ ] 
after clicking [ ])

¿The rating is set and an icon corresponding to the selected [ ] 
appears in the image frame.
(Window shown with a rating of three [ ] as an example)

Rating icon
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Click on desired images while holding down the < > key. To select 
multiple consecutive images, click on the first image, and then click on 
the last image while holding down the <shift> key.

You can display a large number of images by setting the size of 
thumbnail images to small (p.10). Then, by selecting the [View] menu ` 
[Rating] and removing check marks so that ratings no longer appear in 
the image frame, you can display still more thumbnail images in the main 
window.

To select multiple images in the main window

To display more thumbnails in the main window

O The [Label] menu can also be used to attach check marks and set 
ratings.

O By selecting the [Edit] menu ` [Check mark] or [Rating] ` image 
selection criteria, you can refine criteria for selecting 
checkmarked or rated images.

O You can display and change the rating settings set in DPP with 
other bundled software and on an EOS-1D X, EOS 5D Mark III, 
EOS 7D (firmware version 2.0.0 or later), EOS 60D, EOS REBEL 
T4i/650D, EOS REBEL T3i/600D, or EOS REBEL T3/1100D 
camera.
• EOS Utility version 2.9 or later: 

Ratings set in DPP are displayed. However, [Reject] is not 
displayed and you cannot change rating settings.

• On an EOS-1D X, EOS 5D Mark III, EOS 7D (firmware version 
2.0.0 or later), EOS 60D, EOS REBEL T4i/650D, EOS REBEL 
T3i/600D, or EOS REBEL T3/1100D camera:
Ratings set in DPP are displayed in the playback screen. You 
can also change rating settings. However, you cannot display or 
change settings for [Reject].

O Reversely, you can also display and change with DPP the rating 
settings set for still images on an EOS-1D X, EOS 5D Mark III, 
EOS 7D (firmware version 2.0.0 or later), EOS 60D, EOS REBEL 
T4i/650D, EOS REBEL T3i/600D, or EOS REBEL T3/1100D 
camera.

You can arrange images in the order of the types of check marks you 
have attached to images, or in the order of date and time at which the 
images were shot. You can also freely arrange images by moving them 
individually.

Arranging by Type
Select the [View] menu ` [Sort] ` desired item.

¿The images are arranged in the order according to the selected 
item.

Arranging Images in the Main Window
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Sort item Description

Rating: ascending 
order

Sorted in order of fewest [ ].

Rating: descending 
order

Sorted in order of most [ ].

File name Images are sorted by file name in alphanumeric 
order (0 to 9 J A to Z).

Shooting Date/Time Images are sorted by shooting date and time 
from the earliest.

RAW priority Images are sorted in the following order: RAW 
images J JPEG images J TIFF images.

Check mark1 - 
Check mark5

Images with check marks take priority and are 
sorted in number order.

When check marks from 1 to 5 have been set, the images are sorted as 
follows:
Check mark1 selected: 1J2J3J4J5
Check mark2 selected: 2J3J4J5J1
Check mark3 selected: 3J4J5J1J2
Check mark4 selected: 4J5J1J2J3
Check mark5 selected: 5J1J2J3J4

Check mark sorting order

Arranging Freely
Drag and drop the image to the desired location.

¿The image moves to the desired location.
O You can also select multiple images (p.20) and move them.
O The order of rearranged images is maintained until you quit DPP 

or select another folder in the folder area.
O Select the [View] menu ` [Sort] ` [File name] to revert to the 

order before the images were rearranged.

You can maintain the order of rearranged images even if you quit DPP 
or select another folder in the folder area.
O Maintain order without changing image file names

You can use the [View settings] tab sheet in the [Preferences] to 
maintain the order of images without changing the image file names 
(p.91).

O Maintain order and change image file names
You can use the rename function to maintain the order of images and 
change the image file names all at once in the order they were 
rearranged (p.101). 

Maintaining the order of rearranged images
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You can display and handle a RAW image and JPEG image shot 
simultaneously as a single image. In particular, you can halve the 
number of images displayed in the main window and you can streamline 
the checking of a large number of images shot simultaneously.

1 Select the [Digital Photo Professional] menu ` 
[Preferences].

2 Select the [View settings] tab sheet and checkmark 
[Display only CR2 images for CR2 and JPEG files of 
the same name].

¿The main window display updates and the simultaneously shot 
RAW image and JPEG image are displayed as a single image 
with the [ ] mark (p.126).

Displaying a RAW Image and JPEG Image as a Single Image

Images that can be displayed as a single image are images shot with a 
camera that shoots RAW images with the extension “.CR2” and JPEG 
images simultaneously. Images that have been simultaneously shot with 
a camera that shoots RAW images with the extension “.CRW” or “.TIF” 
cannot be displayed as a single image.

O Image displayed
The RAW image is displayed in all windows.

O Edited image
The content which has been adjusted with any of DPP’s functions (the 
tool palette etc.) will be applied to the RAW image only. 
However, if you have used the following functions, the adjustments 
will be applied to both the RAW image and the JPEG image.
• Deleting an image (p.49)
• Moving or copying an image (p.50)
• Checkmarks (p.18, p.19)
• Rating (p.18, p.19) 
• Rotating an image (p.124, p.132, p.133)
• Attaching a thumbnail to an image and saving (p.23)

O Images added to the [Collection] window
When you add a RAW image and JPEG image displayed as a single 
image to the [Collection] window, the single image is marked with the 
[ ] mark. However, because the RAW and JPEG images are 
actually added individually, the number of images shown on the 
[Collection] tab sheet increases by 2 (p.125).

RAW images with the extension “.CR2” can be displayed as a 
single image

When a single image is displayed

In step 2, if you uncheck [Display only CR2 images for CR2 and 
JPEG files of the same name], the RAW image and JPEG image 
are displayed as separate images.
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Create a new thumbnail image for the main window and save to each 
image. 
The quality of images in the main window improves and images redraw 
themselves more quickly.

With all the images selected, select the [File] menu ` 
[Add thumbnail to image and save].

Improving the Quality of an Image in the Main Window

The quality is improved for any JPEG or TIFF image. While the image 
quality improves regardless of the thumbnail size (p.10), selecting [Large 
thumbnail], with its larger display size, shows the improvement more 
clearly than [Medium thumbnail] and [Small thumbnail].

The extent of the improvement in quality

A large number of images may take some time to add.

1 Select the image for which you want to check the 
image information.

2 Click the [Info] button.

¿The image information window appears (p.24).

Checking Image Information
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3 Select a tab sheet and check information.
[Shooting Information] tab sheet [Metadata] tab sheet

O Shooting information is displayed in the [Shooting Information] 
tab sheet, while IPTC* information appended to the image after 
shooting is displayed in the [Metadata] tab sheet. 
IPTC* information provides additional comments on images, 
such as captions, credits and the shooting location. The 
information is sorted into 5 different categories and can be 
viewed by selecting [Description], [IPTC Contact], [IPTC Image], 
[IPTC Content] or [IPTC Status] from the list box in the [Metadata] 
tab sheet.
IPTC* information can only be appended to JPEG/TIFF images 
using Photoshop (CS3 or later).
* International Press Telecommunications Council (IPTC)

O The contents of the [Shooting Information] tab sheet will vary 
depending on the camera model.

O Difference with the [Thumbnail with information]
Detailed shooting information for each image is displayed in the 
image information window. However, if you want to only check the 
main shooting information, you can check it for each image in [View] 
menu ` [Thumbnail with information] (p.10).

Convenient uses in the main window
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Editing an Image
This section explains how to adjust an image using the tool palette in the 
edit window.
You can easily restore an image to its original condition with the [ ] 
button even if you have made the wrong adjustment. Try out the various 
adjustments.
How to make adjustments using the [RAW] tool palette functions, and 
how to adjust automatically with the [RGB] tool palette are explained in 
this section.

¿The image changes in real time according to adjustments 
performed with the tool palette. 

O To revert to the condition before the last operation performed on 
the tool palette, select [Undo] in the [Edit] menu or press < > + 
<Z> keys.

Edit window Tool palette

O You can rotate an image in the [Adjustment] menu.
O You can adjust an image while comparing the image before and 

after adjustment (p.53).
O You can synchronize multiple images and edit while comparing 

them (p.54).
O See p.127 for a list of edit window functions, and p.128 for a list of 

tool palette functions.

You can adjust images with the tool palette by switching between the 
[RAW], [RGB], [NR/ALO] and [LENS] tab sheets according to your 
editing requirements.
Adjustments similar to those that can be performed with the functions of 
your camera can be performed using the functions of the [RAW] tool 
palette. When the camera settings were incorrect during shooting, or 
when the shooting result is not what you visualized, you can get closer 
to what you envisaged with the [RAW] tool palette which is similar to the 
camera.
All functions other than [RGB] tool palette automatic adjustment, and 
each function of the [NR/ALO] and [LENS] tool palette are explained in 
Chapter 3.

Editing with the Tool Palette in the Main Window
By clicking the [Tool palette] button (p.124) in the toolbar on the main 
window, the same tool palette that appears in the edit window is 
displayed and you can edit images.

About the RAW Tool Palette
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The brightness of an image can be adjusted. Move the slider to the right 
to make the image brighter and to the left to make the image darker.

Adjusting Brightness

Reverts the image to 
the original settings
Enter a numerical 
value

Drag the slider left or right

The adjustment range is –2.0 to +2.0 (in 0.01-stop increments when 
entering a value).

If the image you shot is different to what you visualized, you can change 
the Picture Style to get closer to what you envisaged.
Even if you have saved the image (p.41) with [Monochrome] (p.30) 
selected, you can still change to another Picture Style at any point by 
simply selecting a Picture Style other than [Monochrome].

Changing a Picture Style

Reverts the image to 
the original settings
Select

O Even if the RAW image is from a camera that does not have 
Picture Style settings, you can still set a Picture Style as long as 
the RAW image is compatible with DPP (p.3).

O You can retain the [Color tone], [Color saturation], [Contrast], 
[Unsharp mask] and [Sharpness] settings, even if you change the 
Picture Style (p.92).

O [Auto] is only applied to images shot with the EOS-1D X, EOS 5D 
Mark III, EOS REBEL T4i/650D or EOS REBEL T3i/600D. 
When changing a Picture Style with several images selected, you 
can select [Auto] if images shot with the EOS-1D X, EOS 5D 
Mark III, EOS REBEL T4i/650D or EOS REBEL T3i/600D are 
included. However, [Auto] is actually applied only to images shot 
with the EOS-1D X, EOS 5D Mark III, EOS REBEL T4i/650D or 
EOS REBEL T3i/600D.

O You cannot select [Auto] with multiple-exposure RAW images 
created on the camera.
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Picture Style File
A Picture Style file is an extended function file of Picture Style. See p.59 
for how to use Picture Style files.

Picture Style Description

Standard The image looks vivid.
Ordinarily, this setting is suitable for most images.

Auto

The color tone will be adjusted to suit the scene. 
The colors will look vivid, especially for blue skies, 
greenery, and sunsets in nature, outdoor, and 
sunset scenes.

Portrait

For nice skin tones.
Effective for close-ups of women and children. By 
changing the [Color tone], you can adjust the skin 
tone (p.29).

Landscape
For vivid blues and greens.
Effective for making images of landscapes 
impressive.

Neutral
For natural colors and subdued images.
Effective for base images which are to undergo 
adjustment.

Faithful

When the subject is photographed under a color 
temperature of 5200K, the color is adjusted 
colorimetrically to match the subject’s color. 
Effective for base images which are to undergo 
adjustment.

Monochrome
For black and white images.
You can also adjust with [Filter effect] or [Toning 
effect] (p.30).

(Picture Style file 
registered in the 

camera)

Displayed when selecting an image shot with the 
Picture Style file registered in the camera.
In the list, the name of the Picture Style file is 
displayed in ( ).

[Picture Style file 
applied in DPP]

The name of the Picture Style file applied in DPP 
is displayed in [ ].

If the color tone of the photographed image does not appear natural, 
change the white balance to make it appear natural. You can make the 
color tone natural by setting the light source at the time of shooting an 
image of, for example, pale-colored flowers.

Adjusting Color Tone by Changing White Balance

Reverts the image to 
the original settings

Select

If the color tone of the image does not appear natural after changing the 
white balance, adjust the white balance using click white balance (p.28).

To make further fine adjustments to color tone after adjusting the white 
balance, you can use [Color tone] (p.29) to get closer to your 
requirements.

The color tone does not become more natural even when the 
white balance is changed

Tune with color tone

O You cannot register the adjustment results as personal white 
balance (p.98) when you have selected [Shot settings] from the 
list box.

O You cannot change or adjust white balance with multiple-
exposure RAW images created on the camera.

Refer to your camera’s Instruction Manual for details on each white 
balance setting.
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You can adjust white balance using a selected part of an image as the 
standard for white to make the image appear natural. Using click white 
balance is effective when using it in parts of an image where white color 
tone has changed under the influence of a light source.

1

2 Click on a point that is to be the standard for white.

Adjusting Color Tone Using Click White Balance

Click

The coordinates of the cursor position and the 
RGB values (8-bit conversion)

Click Reverts the 
image to the 
original settings

¿The color of the image is adjusted with the point you selected as 
the standard for white.

O If you click on another point in the image, the white balance is 
adjusted again.

O To finish click white balance, click the [ ] button again.

When there are no white areas in your image, you can adjust the white 
balance by clicking on a grey point of the image in step 2. This has the 
same adjustment result as selecting a white point.

When there are no white areas in your image

O The image is adjusted based on the average value of 5 × 5 pixel 
range from the clicked point.

O You cannot change or adjust white balance with multiple-
exposure RAW images created on the camera.
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Modulation and degree of contrast can be adjusted. Move the slider to 
the right to make contrast stronger and to the left to make contrast 
weaker.

Adjusting Contrast

Reverts the image to 
the original settings

Drag the slider left or 
right (9 steps)

Displays the value of the setting

Use [Linear] when you will be adjusting separately using image editing 
software that has advanced editing functions. Note that when [Linear] is 
checkmarked, the image will become dim.

[Linear] - A function for advanced adjustment

The Auto Lighting Optimizer (p.61) will not function when [Linear] is 
checkmarked.

Skin tone and overall color saturation can be adjusted. 
If Picture Style (p.26) is set to [Monochrome], [Color tone] and [Color 
saturation] switch to [Filter effect] and [Toning effect] (p.30).

O Color tone: Mainly used for adjusting skin tones. Move the 
slider to the right to make skin tones more 
yellow, and to the left to make skin tones 
redder.

O Color saturation: The overall color depth of the image is 
adjusted with color saturation. Move the slider 
to the right to make the color deeper, and to 
the left to make the color weaker.

Changing Color Tone and Color Saturation

Reverts the image to 
the original settings

Drag the sliders 
left or right

Displays the values of the settings

The adjustment range is –4 to +4 (in 1-stop increments).
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When the Picture Style (p.26) is set to [Monochrome], you can create 
monochrome photographs with effects similar to filtering and with the 
look of a single-color photograph.

1 Select [Monochrome] in the [Picture Style] list box.

2

Adjusting Monochrome

Reverts the image to 
the original settings

Drag the sliders 
left or right

Displays the values of the settings

O Filter effect: Creates an image where the white of clouds and the 
green of trees are emphasized in the same 
monochrome photograph.

O Toning effect: You can create a monochrome photograph to which a 
single color has been added.
You can choose from [None], [Sepia], [Blue], [Purple] 
and [Green].

Filter Example of effect

None Ordinary monochrome image without filter effect.

Yellow Blue sky is reproduced more naturally and white 
clouds emerge clearly.

Orange Blue sky becomes somewhat darker. The 
brightness of the setting sun increases further.

Red Blue sky becomes quite dark. Autumn leaves 
become clear and bright.

Green Human skin tones and lips become softer. The 
green leaves of trees become clear and bright.

To emphasize the filter effect, set the [Contrast] slider closer to the right. 

Increase the [Contrast] to emphasize the filter effect
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You can make the overall atmosphere of an image harder or softer. 
Adjustment can be made by selecting from two modes, [Sharpness] and 
[Unsharp mask].

[Sharpness]: Controls the sharpness of an image by adjusting the 
level of emphasis for the outline of the image. The 
further to the right the [Sharpness] slider is moved (the 
larger the setting), the more the edges are 
emphasized for a sharper image.

[Unsharp mask]: Adjusts the image’s sharpness more finely.
[Strength]: Shows the level of emphasis for the outline of the 

image. The further to the right the slider is moved (the 
larger the setting), the more the image’s edges are 
emphasized for a sharper image.

[Fineness]: Shows the fineness of the emphasized outline. The 
further to the left the slider is moved (the smaller the 
setting), the more fine detail can be emphasized.

[Threshold]: Sets “how much contrast difference there should be 
compared to surroundings before emphasizing 
edges”.

Adjusting Image Sharpness Select [Sharpness] from the list box and make the 
setting.

Reverts the image to 
the original settings

Drag the slider left or right
Displays the value of the setting

Select [Sharpness]

The adjustment range is 0 to 10 (in 1-stop increments).
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Detailed Setting of Image Sharpness
Select [Unsharp mask] from the list box and make 
the setting.

Drag the slider left or rightDisplays the values 
of the settings

Select [Unsharp mask]

Adjust image sharpness with the window view set to [200% view], 
[100% view] or [50% view]. If the view is set to [Fit to window] (full view), 
the effects of adjustment may seem unnatural.

The effects of sharpness adjustment appear unnatural
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In order to make the image a desirable standard image, automatically 
adjust the image tone curve (p.143). You can select the degree of 
automatic adjustment from “Standard” and “High”.

Click on the [RGB] tab sheet and click the desired 
automatic adjustment button.
O Standard: Standard automatic adjustment. Suitable for most 

images.
O High: Use when the effect achieved in standard automatic 

adjustment is not strong enough.

¿The tone curve changes as adjusted.

Automatically Adjusting Brightness and Color (Tone Curve Assist)

Reverts the tone curve 
to the original settings

High

Standard

The result of automatic adjustment (tone curve assist) may not be as 
expected with the following images:
• Images which have been shot with the proper exposure
• Images where the brightness is unbalanced
• Images which are too dark
• Images which have extreme backlighting

Images not suitable for automatic adjustment (tone curve 
assist)

If you click the [ ] button, the tone curve as well as the [Hue] and 
[Saturation] revert to the default settings. Take care when adjusting 
the [Hue] and [Saturation] individually (p.107).
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Editing Efficiently

The thumbnail display and the edit window are combined and images can 
be edited efficiently while quickly switching between images to be edited. 
Images to be edited are selected beforehand in the main window.

1 In the main window, select the images you want to edit.

2 Switch to the edit image window.

¿The main window switches to the edit image window.

Editing in the Edit Image Window

Click

3 Edit the image.

¿  It may take time for the image to redraw itself.
O The same tool palette as in the edit window is displayed and you 

can edit the image.
O To revert to the condition before the last operation performed on 

the tool palette, select [Undo] in the [Edit] menu or press < > + 
<Z> keys.

Change the size
Edit image window

Select the image to be edited
The selected image is displayed as an enlargement in the 
middle of the window

By selecting the [View] menu ` [AF Point] in the edit window or edit 
image window, you can display the AF points selected in the camera 
at the time of shooting. However, AF points are not displayed for 
images whose image size has been changed and then been 
converted and saved (p.42, p.134), images for which you selected 
an effect other than [Shot settings] as correction of fisheye lens 
distortion aberration, or images which have had settings specified 
during RAW processing on the camera for distortion correction and 
chromatic aberration correction.
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4 Double-click the area you want to enlarge.

¿The area you double-clicked is enlarged to 100% (actual pixel 
size).

O To change the display position, drag on the image or drag the 
enlargement display position (p.128) of the tool palette.

O Double-click again to revert to the full view ([Fit to window]).
O To return to the main window, click the [Main Window] button on 

the toolbar.

Double-
click

Click the [50% view] or [200% view] on the toolbar.

To display an image in an enlargement ratio other than 100%

O You can change the way the tool palette is displayed (p.92).
O You can change the enlargement ratio when you double-click 

(p.91).
O With the edit image window, you can only select images from one 

folder. To gather images from several folders for editing, see 
“Gathering and Editing Images in the Collection Window” (p.36).

O For a list of edit image window functions, see p.133.
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Select the [View] menu ` [Change thumbnail 
position].

O If you select [Change thumbnail position] again, the thumbnail 
display reverts to the vertical position.

Changing the Thumbnail Display Position to a Horizontal Position 
You can gather any randomly selected images together in the 
[Collection] window for viewing, comparison and editing. You can gather 
images from several folders as well as from only one folder, allowing you 
to work with them efficiently.

1 Select images from the [Folder] window in the main 
window, and select the [File] menu ` [Add to collection].

¿The selected images are added to the [Collection] window and the 
number of selected images is shown on the [Collection] tab sheet.

O When you add RAW and JPEG images displayed as a single 
image (p.22), the number of images shown on the [Collection] 
tab sheet increases by 2.

O You can select several images and add them to the [Collection] 
window.

O You can also add images to the [Collection] window by selecting 
images, clicking on the image while holding down the <control> 
key, and selecting [Add to collection] from the menu that appears.

O You can add up to 1,000 images to the [Collection] window.

Gathering and Editing Images in the Collection Window
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2 Select the [Collection] tab sheet.

¿The selected images are displayed in the [Collection] window.

3 Check displayed images in the [Collection] window.

4 Edit the images.
O You can now edit the images displayed in the [Collection] 

window.
¿ Images displayed in the [Collection] window are retained in the 

[Collection] window even after exiting DPP.

O Removing randomly selected images
Select the images to be removed in the [Collection] window and then 
select [Remove from collection] in the [File] menu. (You can also remove 
images from the [Collection] window by selecting the images, clicking on 
the image while holding down the <control> key, and selecting [Remove 
from collection] from the menu that appears.) 
Note that even if you remove an image from the [Collection] window, the 
original image remains unaffected.
O Removing all images
Select [Clear collection] in the [File] menu. (You can also remove all 
images from the [Collection] window by clicking while holding down the 
<control> key, and selecting [Clear collection] from the menu that 
appears.)
Note that even if you remove all images from the [Collection] window, 
the original images remain unaffected.    

To remove images from the [Collection] window

Modifications to the image are applied to the original image
Modifications made to images added to the [Collection] window are 
all applied to the original image.

O You can arrange images displayed in the [Collection] window the 
same way as in the [Folder] window (p.20, p.21). You can 
maintain the order of rearranged images even after quitting DPP 
by checkmarking [Retain sort order] on the [View settings] tab 
sheet in the  [Preferences] (p.91).

O You cannot use the following functions in the [Collection] window.
• Starting of EOS Utility (p.7), or synchronizing of folders with 

EOS Utility 
• Batch change the file name of images (p.101)
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Trimming and Adjusting the Angle of an Image
You can trim only the part of an image you need, or change the 
composition of an image where an image shot horizontally becomes 
vertical. You can also adjust the angle of an image before trimming. If 
you select [Circle] for [Aspect ratio], the area outside the specified range 
is only masked in black and the image will not be cropped.

1 Select the image to be trimmed.

2 Open the trimming/angle adjustment window.
O Click the [Trimming Angle] button.

¿The trimming/angle adjustment window appears.
¿Editing can be done once the image is displayed clearly in the 

trimming/angle adjustment window.

3 Adjust the angle of the image as needed.

O If you click [Center on Screen], you can display the trimming 
range in the center of the window.

O When correcting lens aberrations, it is recommended to perform 
lens aberration correction before adjusting the angle of the 
image.

O If you click the [OK] button after adjusting only the angle of the 
image, the image will be trimmed at the largest possible trimming 
range.

When aspect ratio information is attached to an image shot with the 
EOS-1D X, EOS-1D Mark IV, EOS-1Ds Mark III, EOS-1D Mark III, 
EOS 5D Mark III, EOS 7D, EOS 60D, EOS REBEL T4i/650D or 
EOS REBEL T3i/600D, the trimming range based on the aspect 
ratio information is displayed.

Use the mouse (click S/T) to adjust the angle or 
directly enter the adjustment angle* (0.01-degree 
increments; adjustable range: -45 to +45 degrees)

Click
(rotate 
image left 
or right in 
90-degree 
increments)

Drag* (0.01-degree increments; 
adjustment range: -45 to +45 degrees)

Trimming/angle adjustment window

Largest 
possible 
trimming 
range

* You cannot adjust the angle of images that exceed 9999 x 6666 
pixels in size.CO
PY
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4 Select a ratio and drag the trimming range.

O The trimming range can be moved by dragging.
O You can enlarge or reduce the size of the trimming range by 

dragging the four corners of the trimming range. (Not available 
when [Circle] is selected.)

O List of aspect ratios (width : height)

[Free]: You can trim an image to any size, regardless of the 
selectable ratio.

[Custom]: You can trim an image at the specified ratio.
[Circle]: The area outside the specified range is masked in 

black. The image is not trimmed.

Cancel

Select a 
trimming 
ratio

Drag the 
trimming 
range

5 Click the [OK] button to return to the main window.
¿The trimming range frame is displayed in the trimmed image 

(p.126).
¿When the trimmed image is displayed in an edit window or the 

edit image window, it is displayed in its trimmed form.
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O The trimmed range can be reverted to its original condition at 
any time
A trimmed image is displayed or printed as a trimmed image. 
However, since the image is not actually trimmed, you can always 
revert to the original image by clicking the [Reset] button in the 
trimming/angle adjustment window or performing the “Re-Editing an 
Image” procedure (p.43).

O Display of the trimmed image in each window
• Main window: The frame showing the trimming range is 

displayed on the image (p.126).
• Edit window: The image is displayed in its trimmed condition.
• Edit image window: The thumbnail image is the same as the main 

window display, and the enlarged image is the 
same as the edit window display.

O Printing a trimmed image
You can print as a trimmed image by printing it in DPP.

O The image becomes a trimmed image when converted and saved
The trimmed RAW image actually becomes a trimmed image when 
converted to a JPEG or TIFF image and saved (p.42).

O Images that have aspect ratio set will be displayed as trimmed 
images
When aspect ratio information is attached to a RAW image shot with 
EOS-1D X, EOS-1D Mark IV, EOS-1Ds Mark III, EOS-1D Mark III, 
EOS 5D Mark III, EOS 7D, EOS 60D, EOS REBEL T4i/650D or EOS 
REBEL T3i/600D, the set trimming range based on the aspect ratio 
information is displayed. Since the image is not actually trimmed, you 
can change the trimming range or revert to the condition before 
trimming.
However, when a JPEG image is shot in a [4:3], [16:9] or [1:1] aspect 
ratio set with the EOS 5D Mark III, EOS 60D, EOS REBEL T4i/650D 
or EOS REBEL T3i/600D, its trimming range cannot be changed nor 
reverted to the condition before trimming, since the image is actually 
trimmed and saved in the set trimming ratio.*
When reverting to the condition before trimming is performed based 
on the aspect ratio information at the time of shooting, click the 
[Reset] button. Also, if you want to cancel all the trimming range, click 
the [Clear] button (p.135).

About trimmed images * When shooting with EOS 5D Mark III and [Add cropping information] 
is set in Custom Functions, aspect ratio information is only set and 
the image is not actually trimmed, even for JPEG images.

O Switch between screens using the keyboard
You can also switch between full screen display/normal screen 
display by pressing the < > + <F11> keys.

O Operate using the menu
Each operation can also be performed with the menu which appears 
by clicking on the image while holding down the <control> key.

O Apply the trimmed range to another image
You can apply the trimmed range to another image by clicking the 
[Copy] button to copy the trimmed range, displaying another image 
and then clicking the [Paste] button.
To batch apply a copied trimming range to multiple images, select the 
trimmed image and the multiple images to which you want to apply 
the trimmed range in the main window, and display the trimming/angle 
adjustment window. With the trimmed image displayed, click the 
[Copy] button and then click the [Apply All] button. This will apply the 
trimming range to all the images selected when the trimming/angle 
adjustment window is displayed.
To select multiple images in the main window, click the images while 
holding down the < > key. To select multiple consecutive images, 
click on the first image, and then click on the last image while holding 
down the <shift> key.

Convenient functions of the trimming/angle adjustment 
window

For a list of the trimming/angle adjustment window functions, see 
p.135.

For images shot with ISO speed range expansion set, noticeable 
noise may make it difficult to view image details in the trimming/
angle adjustment window, so using this function is not 
recommended.
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Applying Adjustment Contents to Other Images
You can copy the image adjustment contents (recipe) adjusted with the 
tool palette and apply it to other images.
You can efficiently adjust multiple images by adjusting one image and 
applying the results of this to multiple images shot in similar shooting 
environment.

1 Select the adjusted image and then select the [Edit] 
menu ` [Copy recipe to clipboard].
¿The recipe is copied.

2 Select the image to which the recipe is to be applied 
and then select the [Edit] menu ` [Paste recipe to 
selected image].
¿The recipe is applied to the image.

The recipe (p.96) can be saved as a separate file from the image 
and loaded and applied to another image (p.97).

Saving Editing Results

All the contents (recipe) adjusted with the tool palette as well as the 
trimmed (p.38) range information can be saved to a RAW image or to a 
separate RAW image.
The adjustments made with the tool palette (p.56 to p.68) and the dust 
erase processing explained in Chapter 3 (p.73 to p.77) can also be 
saved in a RAW image.

Select the [File] menu ` desired item.

¿Your adjustments are saved to the image.

Saving Editing Contents to a RAW Image
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To view, edit and print a RAW image with software other than DPP, 
convert to a more versatile JPEG or TIFF image and save.
The image is saved as a separate image, so the RAW image remains 
unaffected.

1 Select the image to be converted.

2 Select the [File] menu ` [Convert and save].

¿The [Convert and save] window appears.

3 Specify the necessary settings, and then click the 
[Save] button.
O By default, the image is converted and saved to a JPEG image 

with the highest image quality, without changing the image size. 
Change the settings according to your requirements.

Saving as a JPEG or TIFF Image

¿The RAW image is converted to a JPEG or TIFF image which is 
then saved as a new image in the specified save destination.

Click and save

Select the save 
destination
Select an image type

Enter a file name

DPP’s RAW image development processing technology is continually 
being improved upon so that you can perform the latest image 
processing more appropriately.
Meaning that, between two differing versions of DPP, processing results 
may differ very slightly even if with the same RAW image data, or the 
results of significant editing of RAW image data with an attached recipe 
may be different.
When you want to save the developing or editing results of the version 
you are currently using as it is, it is recommended that you convert and 
save images as JPEG image or TIFF images. 

To save the developing/editing results for the version you are 
currently using

O By saving as explained on this page, a trimmed image (p.38) or 
dust-erased image explained in Chapter 3 (p.73 to p.77) actually 
becomes a trimmed image or dust-erased image.

O You can reduce the noise characteristic of JPEG images which 
occurs when you convert and save an image as a JPEG (p.89, p.90).

O You can batch convert and save multiple images (p.99).
O For a list of [Convert and save] window functions, see p.134.
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Re-Editing an Image
Only the image processing conditions are changed in images adjusted 
with the tool palette (p.25 to p.33), so the “original image data itself” 
remains unaffected. 
Also, the trimming range information of a trimmed image (p.38) is simply 
saved to the image.
For this reason, you can undo any adjustments saved (p.41) to the 
image, trimming information, and revert to the condition when last 
saved, or when the image was shot.

1 Select the image that is to be re-edited.

2 Select the [Adjustment] menu ` desired item.

¿The image reverts to the conditions of the selected item.

Printing an Image
This section explains how to print high-resolution photographs easily 
with Canon inkjet printers compatible with the Canon printing software, 
Easy-PhotoPrint EX or Easy-PhotoPrint. It also explains how to print 
photographs using other printers.

Proceed to the page for the printer you are using.
O Printing Photographs with Canon Inkjet Printers Compatible with 

Easy-PhotoPrint EX (Same page)
O Printing Photographs with Canon Inkjet Printers Compatible with 

Easy-PhotoPrint (p.46)
O Printing Photographs with a Printer other than Canon Inkjet Printers 

(p.49)

You can perform the following types of photograph printing with Canon 
inkjet printers compatible with Easy-PhotoPrint EX (hereinafter, “EPP 
EX”) :
O Simple printing of RAW images
O Printing with faithful colors

To perform this printing, it is necessary to first install EPP EX version 1.1 
or later on your computer.

Printing Photographs with Canon Inkjet 
Printers Compatible with Easy-PhotoPrint EX
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1 Select the image to be printed.

2 Start up EPP EX.
O Select the [File] menu ` [Plug-in printing] ` [Print with Easy-

PhotoPrint EX].

¿EPP EX starts up.

3 In the EPP EX window, select the [File] menu ` 
[Preferences].

¿The [Preferences] window appears.

4 In [Print Quality], select [Quality Priority], click the 
[Option] button, and then in the dialog box that 
appears, checkmark [Print with the best quality when 
you select [Quality Priority]].

Select 
Quality 
Priority

Click and checkmark [Print with the best quality 
when you select [Quality Priority]]
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5 Select the [Advanced] tab, checkmark [Enable ICC 
profile], and then click the [OK] button.
¿The [Preferences] window closes.

6 Specify the number of sheets to be printed, and then 
click [Select Paper].

Click to 
increase the 
number of 
sheets to be 
printed

EPP EX

Click

7 Select the paper type, and then click the [Layout/
Print] button.

8Specify the layout, and then click the [Print] button. 

¿Printing begins.

Click

Select the 
paper size 
and type

Click to print

Select the 
layoutCO
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O Print up to 1000 images at a time
You can print up to 1000 images selected in DPP at a time. When 
printing more than 1000 images, divide the printing into several jobs. 

O The printed image’s color is not what you expected
In the EPP EX window, select [Preferences] in the [File] menu and 
then click the [Advanced] tab in the [Preferences] window to display 
the [Advanced] tab sheet.
In the [Advanced] tab sheet, select [Enable ICC profile] in [Color 
correction for printing] and try printing using the [Perceptual] setting 
(p.144).

Additional information

DPP is also compatible for printing with Easy-PhotoPrint Pro (p.87).

You can perform the following types of photograph printing with Canon 
inkjet printers compatible with Easy-PhotoPrint (hereinafter, “EPP”):
O Simple printing of RAW images
O High quality printing using the color reproduction range of Adobe RGB 

and a Canon inkjet printer
To perform this printing, it is necessary to first install EPP version 3.5 or 
later on your computer. When using an Easy-PhotoPrint EX-compatible 
inkjet printer, it is recommended that you print using Easy-PhotoPrint EX 
(p.43). Note that since EPP is not compatible with Mac OS X 10.7, 
printing is not possible with a computer running on Mac OS X 10.7.

1 Select the image to be printed.

2 Start up EPP.
O Select the [File] menu ` [Plug-in printing] ` [Print with Easy-

PhotoPrint].

¿EPP starts up.

Printing Photographs with Canon Inkjet 
Printers Compatible with Easy-PhotoPrint
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3 In the EPP window, select the [Easy-PhotoPrint] 
menu ` [Preferences].

¿The [Preferences] window appears.

4 In [Print Quality], select [Quality Priority].

Select 
Quality 
Priority

5 Select the [Advanced] tab sheet and check that the 
EPP image compensation function is disabled.
O If not disabled, the operation of the EPP image compensation 

function may prevent images being printed with faithful color 
reproduction.

6 Specify the number of sheets to be printed, and then 
click [Next].

If checked, 
click to 
remove the 
check mark

Click to 
close the 
window

Click

Click to 
increase the 
number of 
sheets to be 
printed
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7 Check that the image compensation function is 
disabled, select the paper type and then click [Next].

8Specify the layout, and then click [Print].

¿Printing begins.

Select the 
paper type

If checked, click to remove the check marks

Click

Click to print

Select the layout

O Print up to 1000 images at a time
You can print up to 1000 images selected in DPP at a time. When 
printing more than 1000 images, divide the printing into several jobs.

O The printed image’s color is not what you expected
Change the [Rendering intents when using Easy-PhotoPrint] (p.93) to 
[Perceptual] (p.144) and print.

Additional information

DPP is also compatible for printing with Easy-PhotoPrint Pro (p.87).

CO
PY



49

1
2
3
4
5

Introduction

Contents at 
a Glance

Basic 
Operation

Advanced 
Operation

Advanced 
Image Editing 
and Printing

Editing 
JPEG/TIFF 

Images

Index

Processing 
Large Numbers 

of Images

Reference

You can print one image on one sheet of paper.

1 Select the image to be printed.

2 Select the [File] menu ` [Print].

¿The [Print] dialog box appears.

3 Set to photograph printing and print.
O Specify the optimum settings for photograph printing in the 

printer’s print settings dialog box and click the [Print] button.
¿Printing begins.

Printing Photographs with a Printer other than Canon Inkjet Printers
Organizing Images
This section explains how to delete unwanted images, create folders for 
saving images, move or copy images, etc., and organize your images.

Be aware that you cannot recover deleted images.

1 Select an unwanted image in the main window.

2 Select the [File] menu ` [Delete].

¿The image is moved to the [Trash] and is deleted from DPP.
O The images are deleted completely from your computer by 

selecting the [Finder] menu ` [Empty Trash] on the desktop.

Deleting an Unwanted Image
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You can create a folder for sorting images.

1 In the folder area, select the location where the new 
folder is to be created.

2 Select the [File] menu ` [Create new folder].

¿The dialog box for entering a folder name appears.

3 Enter a folder name and click the [OK] button.
¿The new folder is created in the folder selected in step 1.

Creating a Folder for Saving Images
You can move or copy images to a separate folder and sort by shooting 
date or themes.

Drag the image to be moved or copied.
O To move: Drag the image and release when the image is in the 

destination folder.
O To copy: Drag the image while holding down the <option> key 

and release when the image is in the destination 
folder.

¿The images are moved or copied to the destination folder.

Moving Images
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You can move or copy folders that contain images, and sort the images 
by folders.

Drag the folder to be moved or copied.
O To move: Drag the folder and release when the folder is in the 

destination folder.
O To copy: Drag the folder while holding down the <option> key 

and release when the folder is in the destination folder.

¿The folders are moved or copied to the destination folder.

Moving Images in Folders
You can register frequently used folders in bookmarks.
Registered folders appear by clicking the [Bookmark] menu.

Organizing Bookmarks
You can change a folder name or delete a folder registered in 
[Bookmark].

1 Select the folder for which a bookmark is to be 
registered.

2 Select the [Bookmark] menu ` [Add].
¿The folder selected in step 1 is registered in the [Bookmark] 

menu.
O Select a registered folder from the [Bookmark] menu to display 

images in the selected folder in the main window.

Select the [Bookmark] menu ` [Organize].
¿The [Sort bookmarks] window appears and you can change 

folder names or delete folders.

Registering Frequent-Use Folders (Bookmark Registration)

Select
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Advanced Image Editing and Printing
Various preferences including advanced image adjustment, automatic 
dust erasure processing, various printing functions for printing out work, 
and color management are explained here, geared to the user who is 
competent in the handling of third-party image editing software.

Adjusting While Comparing with the Original Image...  53
Changing How the Window is Split............................  53

Adjusting by Comparing Multiple Images................. 54
Displaying an Area Beyond the Set Range as a 
Warning Indicator (Highlight/Shadow Warning) ....... 55
Performing Advanced Editing................................... 56

Adjusting White Balance with Color Temperature .....  56
Tuning White Balance with Color Wheel ...................  56
Adjusting Dynamic Range .........................................  57
Adjusting Brightness of Shadows/Highlights .............  57
Tone Curve Adjustment .............................................  58

Example of a Tone Curve Operation .....................  59
Using a Picture Style File...........................................  59
About the RGB Tool Palette ......................................  60

Using the Auto Lighting Optimizer............................ 61
Reducing Noise........................................................ 62
Correcting Lens Aberration ...................................... 63

Compatible Cameras .................................................  63
Compatible Lenses ....................................................  63
Making Corrections....................................................  65

Effects of Distortion Aberration Correction for Fisheye 
Lenses.....................................................................  66

About Shooting Distance Information Slider ..............  68
Correcting Multiple Images at a Time........................  68

Using the Digital Lens Optimizer .............................  69
Compatible Cameras.................................................. 69
Compatible Lenses..................................................... 69
Using the Digital Lens Optimizer ................................ 70

Performing Automatic Dust Erasure Processing .....  73
Compatible Cameras.................................................. 73
Automatic Dust Erasure Processing in the Main Window... 74

Manually Erasing Dust (Repair Function)................  75
Erasing Unwanted Parts of an Image (Copy Stamp 
Function)..................................................................... 77

Transferring a RAW Image to Photoshop................  77
Setting Work Color Space .......................................  77
Compositing Images................................................  78

Compositing Methods................................................. 81
Creating HDR (High Dynamic Range) Images ........  81
Starting Up Map Utility.............................................  84
Printing with Shooting Information...........................  85
Printing a Thumbnail List (Contact Sheet Printing)..  86
Printing RAW Images on a High-End Canon Printer..  87

Printing with a High-End Canon Inkjet Printer ............ 87
Printing with a Large-Format Canon Printer ............... 88

Specifying Preferences............................................  89
General Settings......................................................... 89
View Settings.............................................................. 91
Tool Palette ................................................................ 92
Color Management ..................................................... 93
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Adjusting While Comparing with the Original Image
You can display before and after versions of an adjusted image in the 
same window and adjust while checking the adjustment results.

1 In the edit window, select the [View] menu ` [Before/
after comparison].

¿The image divides into a left and right window.
O The window on the right shows the image after editing.

2 Change the image display.
O Select the [View] menu ` [Change up/down/left/right] ` [Up/

down].

¿The layout of the two images changes to top and bottom.
O The bottom window shows the image after editing.

Images can also be displayed in the edit image window by the same 
operation.

You can change the display of the image to a single image split in two.

In the edit window, select the [View] menu ` [Display 
mode] ` [Split single image].

¿One image is divided and displayed on the left and right or top 
and bottom.

O To switch between top and bottom, and left and right, perform the 
same operation as step 2 on the left page.

Changing How the Window is Split
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Adjusting by Comparing Multiple Images
You can synchronize the display position of multiple edit windows and 
adjust images while comparing them with each other.

1 In the edit window, display the multiple images to be 
compared.

2 Align the images.
O Align the images for easy comparison.

3 Select the [Window] menu ` [Synchronize].

4 Enlarge the image.
O Enlarge and display any of the edit windows.

¿The other edit windows will also be displayed in the same 
position/enlargement ratio.

5 Move the display position.
¿ If you move the enlargement display position in one of the edit 

windows, the enlargement display position will also change in the 
other edit windows.

O To cancel synchronization, select the [Window] menu ` 
[Synchronize] again.

Synchronization only applies to the enlargement display position 
and the enlargement ratio. Adjustments to the images are not 
synchronized.
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Displaying an Area Beyond the Set Range as a Warning Indicator (Highlight/Shadow Warning) 
You can set up a warning indicator in both the highlighted part and the 
shaded part, which is effective for checking the light and dark areas and 
preventing excessive adjustment of an image. Where the area on the 
image has exceeded that set range, you can display the highlighted part 
in red and the shaded part in blue.

1 Select the [Digital Photo Professional] menu ` 
[Preferences].

2 Select the [View settings] tab sheet.

3 Enter the warning value for [Highlight] and [Shadow].

4 Click the [OK] button to close the window.

5 Display the edit window.

6 Select the [View] menu ` [Highlight]. Similarly, select 
[Shadow].
¿On the opened image, if there is an area that exceeds the value 

entered in step 3, the highlighted part of that area is displayed in 
red and the shaded part is displayed in blue.

You can also display the warning with the same operation in the edit 
image window.
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Performing Advanced Editing
This section explains how to use the advanced adjustment function on 
the tool palette in the edit window.
Adjustments made using the high-level functions of the [RAW] and 
[RGB] tool palettes, as well as the functions of the [NR/ALO] and [LENS] 
tool palette are explained in this section.

White balance can be adjusted by setting a numerical value for color 
temperature.

1 Select [Color temperature] from the [White balance 
adjustment] list box.

2 Set the color temperature.

Adjusting White Balance with Color Temperature

Displays the value of the 
setting

Drag the slider left or right

The adjustment range is 2500 to 10000K (in 100K units).

White balance can be tuned by moving a cursor in the color direction 
shown in the color wheel.

1 In the [RAW] tool palette, click the [Tune] button.

2 Tune by dragging a point.
O You can also fine-tune your adjustment by directly entering the 

adjustment values.

Tuning White Balance with Color Wheel

Enter the values 
to set

Drag

O To register adjustment results as personal white balance (p.98), 
select a setting other than [Shot settings] from the [White balance 
adjustment] list box, and then tune with the color wheel. You 
cannot register the adjustment results as personal white balance 
when you have selected [Shot settings] from the list box and have 
done any tuning.

O You cannot change or adjust white balance with multiple-
exposure RAW images created on the camera.

The adjustment range of color tone is 0 to 359 (1 unit in numerical 
value input), and the adjustment range of color saturation is 0 to 255 
(1 unit in numerical value input).
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Dynamic range (width of gradation expression) from dark points to bright 
points in an image can be adjusted.

O The horizontal axis shows the input level and the vertical axis 
shows the output level.

Adjusting Dynamic Range

Move to the left or right
Input highlight points

Move to the left or right
Input shadow points

Move downwards
Output highlight points

Move upwards
Output shadow points

You can adjust the brightness of shadows and highlights in an image. 
By adjusting shadows and highlights in an image with a restricted 
brightness, you can reduce the effects of clipping in shadows and 
highlights. 

Adjusting Brightness of Shadows/Highlights

Drag the sliders left or 
right
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You can adjust the brightness, contrast and color of a specific area by 
changing the tone curve (p.143).

1 In the tool palette, select the [RGB] tab sheet.

2 Select the tone curve mode and interpolation 
method.

Tone Curve Adjustment

<control> + click inside 
the graph to display the 
menu

3 Make adjustments.

O The horizontal axis shows the input level and the vertical axis 
shows the output level.

O The maximum number of [ ] is 8.
O To delete a [ ], double-click on the [ ].

Click to add a [ ] (point)
Adjust by dragging [ ]

Adjusts each channel
Batch adjusts RGB

O The histogram display changes according to adjustment. You can 
also fix the histogram display to the display before any 
adjustments (p.92).

O The tone curve mode and interpolation method for a tone curve 
can also be changed in [Preferences] (p.92).
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Example of a Tone Curve Operation
Makes medium tones brighter Makes medium tones darker

Makes tones harder Makes tones softer

A Picture Style file is an extended function file of a Picture Style. 
With DPP, you can apply to RAW images Picture Style files that you 
have downloaded from Canon’s web site effective for various scenes or 
Picture Style files created with “Picture Style Editor”. When using a 
Picture Style file, save it to your computer beforehand.

1 Display the image to which the Picture Style file is to 
be applied in the edit window (p.11).

2 Select the [RAW] tab sheet in the tool palette, and 
click the [Browse] button.

¿The [Open] dialog box appears.

3 Select a Picture Style file saved on your computer, 
and click the [Open] button.
¿The Picture Style file you selected is applied to an image.
O To apply a different Picture Style file, follow the procedure from 

step 2 again.

Using a Picture Style File

The Picture Style files that you can apply to the camera are files with 
the “.PF2” extension only. Furthermore, you cannot apply Picture 
Style files with the extension “.PSE” to an image; however if such a 
file is registered in the camera and the image is shot, the image will 
display correctly.
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You can adjust images with the tool palette by switching between the 
[RAW], [RGB], [NR/ALO] and [LENS] tab sheets according to your 
editing requirements.
The [RGB] tool palette functions are the same as ordinary image editing 
software, such as tone curve adjustment that is explained here, with 
which you can adjust RAW images.
However, because the adjustment width of the functions in the [RGB] 
tool palette is wider than the [RAW] tool palette, the image color may be 
saturated, or the image quality may deteriorate if you adjust too much. 
Therefore we recommend for functions other than tone curve 
adjustment (p.58) and automatic adjustment (p.33), that you adjust 
images using the same functions available in the [RAW] tool palette.
See Chapter 5 for explanations on functions of the [RGB] tool palette 
other than tone curve adjustment.

About the RGB Tool Palette

We recommend that as a general principle you edit RAW images using 
the [RAW] tool palette. However, where the adjustment width with the 
[RAW] tool palette is not wide enough and you wish to use the special 
functions in the [RGB] tool palette, we recommend that you adjust your 
images at the necessary lowest limit with the [RGB] tool palette after 
having completed basic adjustment with the [RAW] tool palette.
Use the adjustment function of the [NR/ALO] and [LENS] tool palette 
(p.129) when applying the Auto Lighting Optimizer (p.61), reducing 
noise (p.62) or correcting aberration (p.63) after you have made any 
required adjustments with the [RAW] and [RGB] tool palettes.

Using the tool palette
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Using the Auto Lighting Optimizer
If the shooting result is dark or the contrast is low, you can use the Auto 
Lighting Optimizer function to auto-correct the brightness and contrast, 
and obtain a more pleasant image.
You can also change the settings of the image shot with the camera’s 
Auto Lighting Optimizer function.
This function is compatible only with RAW images shot with EOS-1D X, 
EOS-1D Mark IV, EOS 5D Mark III, EOS 5D Mark II, EOS 7D, EOS 60D, 
EOS 50D, EOS REBEL T4i/650D, EOS REBEL T3i/600D, EOS REBEL 
T2i/550D, EOS REBEL T1i/500D and EOS REBEL T3/1100D.
* ALO stands for Auto Lighting Optimizer.

1 Select the [NR/ALO] tab sheet from the tool palette in 
the edit window or edit image window.

2 Checkmark the checkbox.

O For images shot with the camera’s Auto Lighting Optimizer 
function, the checkbox is already checked.

3 Change the settings according to your preferences.

¿Auto correction is applied to the image to match the settings.
O For images shot with the camera’s Auto Lighting Optimizer 

function, the settings at the time of shooting are applied as the 
default values.

O To cancel the Auto Lighting Optimizer, remove the check mark 
from the checkbox.

Checkmark

Select from three levels: 
Low/Standard/Strong

O When [Highlight tone priority] is set to [Enable] in EOS-1D X, EOS 
5D Mark III, EOS 7D, EOS 60D, EOS REBEL T4i/650D, EOS 
REBEL T3i/600D, EOS REBEL T2i/550D and EOS REBEL T3/
1100D, the Auto Lighting Optimizer function cannot be set.

O You cannot use the Auto Lighting Optimizer with multiple-
exposure RAW images created on the camera.
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Reducing Noise
You can reduce noise that arises in RAW images shot at night or with a 
high ISO speed.
NR is an abbreviation for “noise reduction”.

1 Select the [NR/ALO] tab sheet from the tool palette in 
the edit window or edit image window.

2 Click the [NR Preview] button.

¿The [NR Preview] window appears.

3 Adjust an image.

O You can set a noise reduction level from within a range of 0 to 20. 
The larger the setting, the larger the noise reduction effect.

O The noise reduction effect can be checked when an image is 
displayed at 100% in the NR check window.

O You can change the display position of the NR check window by 
dragging the enlargement display position in the navigator 
window.

Navigator 
window

Enlargement 
display 
position

NR check window

Drag the 
sliders

4 Click the [Apply] button.
¿Noise reduction is applied to the image and the image is 

redisplayed.

Noise reduction cannot be applied when [Viewing and saving RAW 
images] (p.89) is set to [High speed] in the [Preferences] window. 
Select [High quality] to reduce noise.

After selecting multiple images in the main window, you can set the 
same noise reduction level for the images without displaying the [NR 
Preview] window, by adjusting the noise reduction level in the [NR/ALO] 
tool palette (p.129) using the [Luminance noise reduction] and 
[Chrominance noise reduction] sliders, and then clicking the [Apply] 
button.

The noise reduction function does not work

To set the same noise reduction level for several images

O You can set the default noise reduction beforehand, using 
[Default noise reduction settings] in the [Tool palette] tab sheet in 
the [Preferences] (p.92).
• When [Apply camera settings] is selected, you can pre-set a 

noise reduction level that suits the camera settings beforehand 
as the default.

• When [Set as defaults] is selected, you can pre-set a preferred 
default setting for the noise reduction level beforehand. This is 
particularly useful for applying noise reduction to all the images 
in a folder at once, such as batch noise reduction for images 
with high ISO speeds.

However, for images with recipes attached, the noise level 
recorded in the recipe will be applied.

O If [Luminance noise] has been set, resolution may be reduced 
along with reduction of noise.

O If [Chrominance noise] has been set, color bleeding may occur 
along with reduction of noise. 

O For a list of [NR Preview] window functions, see p.131.
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Correcting Lens Aberration
You can easily make corrections to drops in peripheral illumination, 
distortions in the subject, and color blur which occur by the physical 
characteristics of the lens or slightly remaining aberration.
Please note that you can only correct RAW images which have been 
taken with the compatible cameras and lenses listed below. JPEG or 
TIFF images cannot be corrected.

*1 Requires firmware version 1.1.1
*2 Requires firmware version 1.0.6

EOS-1D X EOS-1D Mark IV EOS-1Ds Mark III

EOS-1D Mark III EOS-1D Mark II N EOS-1Ds Mark II

EOS-1D Mark II EOS-1Ds EOS-1D

EOS 5D Mark III EOS 5D Mark II EOS 5D*1 

EOS 7D EOS 60D EOS 50D

EOS 40D EOS 30D*2 EOS REBEL 
T4i/650D

EOS REBEL 
T3i/600D

EOS REBEL 
T2i/550D

EOS REBEL 
T1i/500D

EOS DIGITAL REBEL 
XSi/450D

EOS DIGITAL REBEL 
XTi/400D DIGITAL

EOS REBEL 
T3/1100D

EOS DIGITAL REBEL 
XS/1000D

_ _

Compatible Cameras

Fisheye, ultra wide, and wide angle lenses
EF 14mm f/2.8L USM EF 14mm f/2.8L II USM*3

EF 8-15mm f/4L USM Fisheye*3 EF 15mm f/2.8 Fisheye*3 

EF 20mm f/2.8 USM EF 24mm f/1.4L USM

EF 24mm f/1.4L II USM*3 EF 24mm f/2.8

EF 24mm f/2.8 IS USM*3 EF 28mm f/1.8 USM

EF 28mm f/2.8 EF 28mm f/2.8 IS USM*3

EF 35mm f/1.4L USM EF 35mm f/2

Standard and medium telephoto lenses
EF 50mm f/1.2L USM*4 EF 50mm f/1.4 USM

EF 50mm f/1.8 EF 50mm f/1.8 II

EF 85mm f/1.2L USM EF 85mm f/1.2L II USM*5

EF 85mm f/1.8 USM EF 100mm f/2 USM

Telephoto lenses
EF 135mm f/2L USM EF 135mm f/2.8 

(with Softfocus mechanism)

EF 200mm f/2L IS USM*3 EF 200mm f/2.8L USM

EF 200mm f/2.8L II USM EF 300mm f/2.8L IS II USM*3 

EF 300mm f/2.8L IS USM EF 300mm f/4L IS USM

EF 400mm f/2.8L IS USM EF 400mm f/2.8L IS II USM*3 

EF 400mm f/5.6L USM EF 400mm f/4 DO IS USM

EF 500mm f/4L IS USM EF 500mm f/4L IS II USM*3

EF 600mm f/4L IS USM EF 600mm f/4L IS II USM*3

EF 800mm f/5.6L IS USM*3 _

Compatible Lenses
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Zoom lenses
EF 16-35mm f/2.8L USM EF 16-35mm f/2.8L II USM*3

EF 17-35mm f/2.8L USM EF 17-40mm f/4L USM
EF 20-35mm f/3.5-4.5 USM EF 24-70mm f/2.8L USM
EF 24-70mm f/2.8L II USM*3 EF 24-85mm f/3.5-4.5 USM
EF 24-105mm f/4L IS USM EF 28-70mm f/2.8L USM
EF 28-90mm f/4-5.6 USM EF 28-90mm f/4-5.6 II USM
EF 28-90mm f/4-5.6 EF 28-90mm f/4-5.6 II
EF 28-90mm f/4-5.6 III EF 28-105mm f/3.5-4.5 USM
EF 28-105mm f/3.5-4.5 II USM EF 28-105mm f/4-5.6 USM
EF 28-105mm f/4-5.6 EF 28-135mm f/3.5-5.6 IS USM
EF 28-200mm f/3.5-5.6 EF 28-200mm f/3.5-5.6 USM
EF 28-300mm f/3.5-5.6L IS USM EF 55-200mm f/4.5-5.6 II USM
EF 55-200mm f/4-5.6 USM EF 70-200mm f/2.8L USM
EF 70-200mm f/2.8L IS USM EF 70-200mm f/2.8L IS II USM*3

EF 70-200mm f/4L USM EF 70-200mm f/4L IS USM*4

EF 70-300mm f/4-5.6L IS USM*3 EF 70-300mm f/4-5.6 IS USM
EF 70-300mm f/4.5-5.6 DO IS USM EF 75-300mm f/4-5.6 II*3

EF 75-300mm f/4-5.6 III*3 EF 75-300mm f/4-5.6 USM
EF 75-300mm f/4-5.6 II USM EF 75-300mm f/4-5.6 III USM
EF 90-300mm f/4.5-5.6 EF 90-300mm f/4.5-5.6 USM
EF 100-300mm f/4.5-5.6 USM EF 100-400mm f/4.5-5.6L IS USM

Macro lenses
EF 50mm f/2.5 Compact Macro*3 EF 100mm f/2.8 Macro USM
EF 100mm f/2.8L Macro IS USM*3 EF 180mm f/3.5L Macro USM
MP-E 65mm f/2.8 1-5x Macro 
Photo*3  _

Aberration correction will not apply to images shot with a combination 
of lenses *3 *4 *5 and EOS 5D or EOS 30D with the firmware versions 
below.
* You cannot attach an EF-S lens to EOS 5D.

*3 EOS 5D with firmware version 1.1.0 or earlier, EOS 30D with 
firmware version 1.0.5 or earlier

*4 EOS 5D with firmware version 1.1.0 or earlier, EOS 30D with 
firmware version 1.0.4 or earlier

*5 EOS 5D with firmware version 1.0.5 or earlier, EOS 30D with 
firmware version 1.0.4 or earlier

EF-S lenses
EF-S 60mm f/2.8 Macro USM EF-S 10-22mm f/3.5-4.5 USM
EF-S 15-85mm f/3.5-5.6 IS USM*3 EF-S 17-55mm f/2.8 IS USM
EF-S 17-85mm f/4-5.6 IS USM EF-S 18-55mm f/3.5-5.6
EF-S 18-55mm f/3.5-5.6 II EF-S 18-55mm f/3.5-5.6 III*3 
EF-S 18-55mm f/3.5-5.6 USM EF-S 18-55mm f/3.5-5.6 II USM
EF-S 18-55mm f/3.5-5.6 IS*3 EF-S 18-55mm f/3.5-5.6 IS II*3 
EF-S 18-135mm f/3.5-5.6 IS*3 EF-S 18-135mm f/3.5-5.6 IS STM*3

EF-S 18-200mm f/3.5-5.6 IS*3 EF-S 55-250mm f/4-5.6 IS*3

EF-S 55-250mm f/4-5.6 IS II*3  _

O You can also correct RAW images taken with the compatible lens 
even when the extender is attached.

O You can also correct RAW images shot with EF 50mm f/2.5 
Compact Macro fitted with Life Size Converter EF.

O The aberration correction function is not available for images shot 
with combinations of camera/lens other than those given under 
“Compatible Cameras” and “Compatible Lenses”. They are 
therefore not displayed and cannot be used.

O The chromatic aberration correction function is not available for 
multiple-exposure RAW images created on the camera.
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You can make corrections to any of the four aberrations as below, either 
one at a time or simultaneously.
O Peripheral illumination 
O Chromatic aberration (color fringing which occurs in the periphery of 

an image)
O Color blur (blue or red color blur which sometimes occurs at the edge 

of the highlighted area of an image)
O Distortions 

1 In the tool palette, select the [LENS] tab sheet.

2 Click the [Tune] button.

¿The [Lens aberration correction] window appears.

Making Corrections 3 Checkmark the items to be corrected.

¿The image is corrected and redisplayed.
O Check the results of corrections to peripheral illumination or 

distortions in the full view.
O Check the results of corrections to chromatic aberration and color 

blur by clicking the area on the image you want to check. In the 
top right of the window, the area is displayed at 200% in the 
enlargement display section (p.136).

O You can lessen the degree of correction by moving the slider to 
the left for the item you want to correct.

O You can respectively correct red chromatic aberration with the [R] 
slider of the [Chromatic aberration] or blue chromatic aberration 
with the [B] slider.

O To correct distortion aberration of images shot with a fisheye lens 
(EF 8–15mm f/4L USM Fisheye or EF 15mm f/2.8 Fisheye), four 
effects can be selected from the [Effect] list box in addition to 
[Shot settings] normally used for distortion correction.
The level of an effect can be adjusted with the adjustment slider 
located below [Distortion].
For detailed information on each effect, see “Effects of Distortion 
Aberration Correction for Fisheye Lenses” (p.66).
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O For images shot with EF 8–15mm f/4L USM Fisheye, a fine-tune 
slider is also displayed when you select [Emphasize Linearity] 
from the [Effect] list box. 
Adjust the amount of correction for distortion aberration with the 
adjustment slider, and then adjust with the fine-tune slider if more 
adjustment is required.

O When the list box for selecting an extender is displayed, select 
the extender attached at the time of shooting from the list box.

4 Click the [OK] button.
¿The [Lens aberration correction] window closes and the result of 

the corrections is applied to the image in the edit window and the 
image is redisplayed.

¿The result of the settings of the [Lens aberration correction] 
window is also displayed in the tool palette.

¿ In the main window, the [ ] mark is displayed on the image to 
indicate the lens aberration corrections (p.126).

Effects of Distortion Aberration Correction for 
Fisheye Lenses
O Shot settings

By selecting this option, only distortion aberration correction for 
correcting optical distortion is performed.

O Emphasize Linearity
This converts the image to a “central projection” style image. This 
projection method is used with general lenses.
Differing from fisheye lenses, central projection displays straight lines 
as straight lines.
By selecting this option, a wide-view panoramic image can be 
obtained. However, the periphery is stretched, resulting in decreased 
resolution.
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O Emphasize Distance
This converts the image to an “equidistant projection" style image. 
This projection method preserves distance relationships.
Equidistant projection displays the same distances from the center to 
the periphery as the same distances.
In particular, when shooting a celestial body such as the celestial 
sphere, any height above the horizon (declination) is captured at an 
equal interval. This method is therefore used in such photography as 
celestial photography (star maps, solar path diagrams, etc.).

O Emphasize Periphery
This converts the image to a “stereographic projection” style image. 
This projection method emphasizes the periphery.
Stereographic projection allows position relationships on a spherical 
surface, such as N, S, E, W on a map, to be displayed correctly. It is 
therefore used for world maps and monitoring cameras.
By selecting this option, the periphery is stretched and may result in 
decreased resolution. 

O Emphasize Center
This converts the image to an “orthogonal projection” style image. 
With this projection method, the center is more emphasized.
Since an orthogonal projection allows a subject of the same 
brightness to be displayed as occupying the same area in the image, 
this method has typical uses in photography for celestial luminance 
distributions and center-emphasized animal photography.
By selecting this option, the center is stretched and may result in 
decreased resolution.

While selecting any of the options [Emphasize Linearity], 
[Emphasize Distance], [Emphasize Periphery], or [Emphasize 
Center] will yield results similar to each of the projection methods, 
the conversion does not exactly apply each projection method in 
their precise sense.
Accordingly, care should be taken since they are not suited to 
scientific or other such purposes.
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O When correcting RAW images shot with the cameras in the table below, 
if shooting distance information has been saved to the image, the slider 
is set automatically according to this shooting distance information. 
However, if no shooting distance information is saved to the image, the 
slider is set automatically to the right end at infinity position and a [<!>] 
appears above the slider. 
If the image’s shooting distance is not infinite, you can minutely adjust 
the distance by operating the slider while looking at the screen.

O When correcting RAW images shot with the cameras in the table 
below, it is set automatically to the right end at infinity position. You 
can then minutely adjust the distance by operating the slider while 
looking at the screen if the shooting distance is not infinite.

O For RAW images shot with MP-E 65mm f/2.8 1-5x Macro Photo or  EF 
50mm f/2.5 Compact Macro with Life Size Converter EF, the slider 
indicator changes to [Magnification factor].

O [Shooting distance information] slider is applied to all the correction 
items with check marks.

EOS-1D X EOS-1D Mark IV EOS-1Ds Mark III

EOS-1D Mark III EOS 5D Mark III EOS 5D Mark II

EOS 7D EOS 60D EOS 50D

EOS 40D EOS REBEL 
T4i/650D

EOS REBEL 
T3i/600D

EOS REBEL 
T2i/550D

EOS REBEL
T1i/500D

EOS DIGITAL REBEL
XSi/450D

EOS REBEL
T3/1100D

EOS DIGITAL REBEL
XS/1000D

_

EOS-1D Mark II N EOS-1Ds Mark II EOS-1D Mark II

EOS-1Ds EOS-1D EOS 5D

EOS 30D EOS DIGITAL REBEL
XTi/400D DIGITAL

_

About Shooting Distance Information Slider
Select multiple images to correct in the main window. Display tool 
palette by clicking the [Tool palette] button (p.124) in the toolbar. If you 
perform correction procedures (p.65) when tool palette is displayed, you 
can apply the same corrections to all the images selected in the main 
window.
Also, you can apply same corrections by copying the recipe of the 
corrected image and pasting it onto the multiple images (p.41).

O Some noise appeared in the periphery of an image after 
correcting [Peripheral illumination] 
You can reduce the noise by using luminance and/or chromatic noise 
reduction of the noise reduction function (p.62). However, if you had 
applied high amount of [Peripheral illumination] correction to the 
images that have been shot at night or with a high ISO speed, the 
noise might not be reduced.

O The image appears with less resolution after correcting 
[Distortion] 
You can make the image similar to the one before correction by 
applying more sharpness with the sharpness adjusting function 
(p.31).

O The colors of the image became weaker after correcting [Color 
blur]
You can make the image similar to the one before correction by 
adjusting the color tone (p.29) and/or the color saturation (p.107) to 
make the color deeper.

O The result of [Color blur] correction cannot be detected
[Color blur] correction is effective for correcting blue or red color blur 
which occurs at the edge of the highlighted area of an image. If 
conditions do not match, correction cannot be made.

Additional information

Correcting Multiple Images at a Time

The periphery of the image may be truncated when [Distortion] 
correction is made.

For a list of the [Lens aberration correction] window functions, see 
p.136.
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Using the Digital Lens Optimizer
This function enables the resolution of images to be increased by 
removing any remaining aberration related to image-forming capability 
or any deterioration of resolution resulting from diffraction phenomena 
that are unavoidable as long as light must pass through the lens. These 
optical phenomena cannot be corrected under [Lens aberration 
correction] (p.63). Correction is achieved using the designed value of 
each lens. The images that can be corrected are RAW images shot 
using any of the following “compatible cameras” and “compatible 
lenses”. JPEG, TIFF, S-RAW, and M-RAW images cannot be corrected. 
To use this function, [Lens data] for the lens used to shoot images first 
needs to be downloaded to your computer.
Before using the Digital Lens Optimizer, it is recommended that you set 
[Sharpness] or [Strength] for [Unsharp mask] for images to 0.

*1 Requires firmware version 1.1.1
*2 Requires firmware version 1.0.6

EOS-1D X EOS-1D Mark IV EOS-1Ds Mark III
EOS-1D Mark III EOS-1D Mark II N EOS-1Ds Mark II
EOS-1D Mark II EOS-1Ds EOS-1D
EOS 5D Mark III EOS 5D Mark II EOS 5D*1 
EOS 7D EOS 60D EOS 50D
EOS 40D EOS 30D*2 EOS REBEL 

T4i/650D
EOS REBEL 
T3i/600D

EOS REBEL 
T2i/550D

EOS REBEL 
T1i/500D

EOS DIGITAL REBEL 
XSi/450D

EOS DIGITAL REBEL 
XTi/400D DIGITAL

EOS REBEL 
T3/1100D

EOS DIGITAL REBEL 
XS/1000D  _  _

Compatible Cameras

Wide angle lenses
EF 14mm f/2.8L II USM EF 24mm f/1.4L II USM
EF 35mm f/1.4L USM _

Standard and medium telephoto lenses
EF 50mm f/1.4 USM EF 50mm f/1.2L USM
EF 85mm f/1.2L II USM _

Telephoto lenses
EF 300mm f/2.8L IS II USM EF 400mm f/2.8L IS II USM
EF 500mm f/4L IS II USM EF 600mm f/4L IS II USM

Zoom lenses
EF 16-35mm f/2.8L USM EF 16-35mm f/2.8L II USM
EF 17-40mm f/4L USM EF 24-70mm f/2.8L USM
EF 24-70mm f/2.8L II USM EF 24-105mm f/4L IS USM
EF 28-300mm f/3.5-5.6L IS USM EF 70-200mm f/2.8L IS USM
EF 70-200mm f/2.8L IS II USM EF 70-200mm f/4L USM
EF 70-200mm f/4L IS USM EF 70-300mm f/4-5.6L IS USM
EF 100-400mm f/4.5-5.6L IS USM  _

EF-S lenses
EF-S 10-22mm f/3.5-4.5 USM EF-S 15-85mm f/3.5-5.6 IS USM
EF-S 17-55mm f/2.8 IS USM EF-S 17-85mm f/4-5.6 IS USM
EF-S 18-135mm f/3.5-5.6 IS EF-S 18-135mm f/3.5-5.6 IS STM
EF-S 18-200mm f/3.5-5.6 IS  _

Compatible Lenses

O The Digital Lens Optimizer is not available for images shot with 
an extender mounted on a compatible lens.

O You cannot use the Digital Lens Optimizer with multiple-exposure 
RAW images created on the camera.
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1 In the tool palette, select the [LENS] tab sheet, and 
check the status of [Lens data] for [Digital Lens 
Optimizer].

O [Not Available] is displayed for an image shot with a non-
compatible camera or lens, or for a non-compatible image such 
as a JPEG, TIFF, S-RAW, or M-RAW image. The function cannot 
be used for these images.

O If [No] is displayed, proceed to step 2. To use the function, you 
need to download [Lens data] for the lens used when shooting 
the image. It is recommended that you check the lens used when 
shooting the image beforehand. The lens used can be checked 
using the [Info] button in the toolbar on the main window (p.23).

O If [Yes] is displayed, proceed to step 4.

Before you click the [Update] button in step 2, Lens data [No] may 
be displayed instead of [Not Available] for non-compatible images.

Using the Digital Lens Optimizer 2 Click the [Update] button.

¿The [Add or Remove lens data] window appears.

O To use this function, an environment with Internet access 
(subscription to a provider, browser software installed, and an in-
place line connection) is required.

O An administrator-level privilege is required for this operation.
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3 Checkmark the checkbox for the lens used to shoot 
the image, and click the [Start] button.

¿The lens data is downloaded to your computer. 
¿When the downloading of the lens data ends, the indication for 

[Lens data] changes to [Yes].
O You can download the data for several lenses at the same time. 
O If you remove the check mark from the checkbox for already-

downloaded lens names and click the [Start] button, the lens data 
will be deleted from your computer.

Depending on the type, current state, etc. of software running on 
your computer, the download of the lens data may fail. If it occurs, 
wait for a while then try downloading the data again.

4 Click the [Tune] button.

¿The [Digital Lens Optimizer] window appears.
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5 Checkmark the [Setting] checkbox and adjust the 
image. 

O The [Setting] checkbox will be checkmarked if the image has the 
Digital Lens Optimizer already applied. Remove the checkmark 
and click the [Save] button to cancel the Digital Lens Optimizer.

O In the [Digital Lens Optimizer] window, images are displayed with 
[Sharpness] and [Unsharp mask] effects applied.

O When applying the Digital Lens Optimizer, the effect of 
[Sharpness] or [Unsharp mask] may become excessive. It is 
recommended that you set [Sharpness] or [Strength] for [Unsharp 
mask] for images to 0 before using the Digital Lens Optimizer. 
Adjust [Sharpness] or [Unsharp mask] again after applying the 
Digital Lens Optimizer to images.

O Use the slider to adjust the Digital Lens Optimizer effect.
O When [MAX] is displayed for the Digital Lens Optimizer level, the 

effect will remain the same even if you move the slider further to 
the right.

O You can change the display position of the check window by 
dragging the enlargement display position in the navigator 
window.  

O Even if you set shooting distance for a lens in this window, the 
value indicated for shooting distance in the [Lens aberration 
correction] window will not change.

O If no shooting distance information is saved to the image, the 
shooting distance slider is set automatically to the right end at 
infinity position and a [<!>] appears above the shooting distance 
slider.

O Images cannot be corrected for [Chromatic aberration] in [Lens 
aberration correction] if the Digital Lens Optimizer has been 
applied.

6 Click the [Save] button. 

¿The [Digital Lens Optimizer] window closes and correction 
results are applied to the image in the edit window.

¿Corrections made in the [Digital Lens Optimizer] window are also 
displayed in the tool palette.  

¿ In the main window, the [ ] mark is displayed on the image to 
indicate that the Digital Lens Optimizer is applied (p.126).

O After clicking the [Save] button, the application of the corrections 
to the image may take some time.

O The size of the image file will be larger after applying the Digital 
Lens Optimizer.
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Performing Automatic Dust Erasure Processing
The Dust Delete Data that is appended to images shot with the camera 
that can attach this data, can be used to automatically erase dust spots.

EOS-1D X EOS-1D Mark IV EOS-1Ds Mark III

EOS-1D Mark III EOS 5D Mark III EOS 5D Mark II

EOS 7D EOS 60D EOS 50D

EOS 40D EOS REBEL 
T4i/650D

EOS REBEL 
T3i/600D

EOS REBEL 
T2i/550D

EOS REBEL 
T1i/500D

EOS DIGITAL REBEL 
XSi/450D

EOS DIGITAL REBEL 
XTi/400D DIGITAL

EOS REBEL 
T3/1100D

EOS DIGITAL REBEL 
XS/1000D

1 In the main window, select an image appended with 
Dust Delete Data.

2 Click the [Stamp] button.

¿The copy stamp window appears.

Compatible Cameras

3 When the image has redrawn itself, click the [Apply 
Dust Delete Data] button.

¿Dust spots are erased in a single operation.

4 Click the [OK] button to return to the main window.
¿The [ ] mark (p.126) is displayed on an image from which dust 

spots have been erased.CO
PY
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O The dust-erased image can be reverted to its original condition 
at any time
A dust-erased image is displayed or printed as a dust-erased image. 
However, since the dust on the image is not actually erased, you can 
always revert to the original image by clicking the [Undo] button in the 
copy stamp window or performing the “Re-Editing an Image” 
procedure (p.43).

O Check dust erasure in the copy stamp window
Check dust erasure in the copy stamp window. Images before dust 
erasure are displayed in other windows and you will be unable to 
check them.

O Printing dust-erased images
You can print as a dust-erased image by printing it in DPP.

O The [Apply Dust Delete Data] button cannot be clicked
Even with an image that has Dust Delete Data attached to it in the 
camera, if there is no dust to remove by DPP from the image, the 
[Apply Dust Delete Data] button will be disabled.

O To erase dust spots that cannot be erased with the automatic 
dust erasure processing
In automatic dust erasure processing, dust spots are erased based on 
information relating to dust saved in the Dust Delete Data. However, 
there may be cases where you will not be able to erase dust spots 
depending on the type of dust. If this occurs, erase those dust spots 
using the repair function (p.75) or the copy stamp function (p.77).

O The image becomes a dust-erased image when converted and 
saved
The dust-erased RAW image actually becomes a dust-erased image 
when converted to a JPEG or TIFF image and saved (p.42).

Additional information

O Checking the dust erased spots
After step 3, you can display and check in detail the erased dust spots 
one by one by pressing the <F> key. (Press the <B> key to return to 
the previous dust spot.)

O Canceling a specified erased dust spot only
After step 3, you can press the <F> key or the <B> key to display the 
erased dust spot, and then press the <delete> key to cancel only the 
erased dust spot displayed.

O Switch between full screen display/normal screen display using 
shortcut keys
You can also switch between full screen display/normal screen 
display by pressing the < > + <F11> keys.

O Applying the dust erasure result to another image
You can apply dust erasure to the same place in another image by 
clicking the [Copy] button to copy the dust erasure results and then 
displaying the other image to which you want to apply the results and 
clicking the [Paste] button.

In the main window, you can also automatically erase dust spots in 
multiple images appended with Dust Delete Data.

Useful functions of the copy stamp window

For a list of the copy stamp window functions, see p.140.

Select multiple images appended with Dust Delete 
Data, and then select the [Adjustment] menu ` 
[Apply Dust Delete Data].
¿Dust spots in all the selected images are erased in a single 

operation.

Automatic Dust Erasure Processing in the Main Window
CO
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Manually Erasing Dust (Repair Function)
You can erase dust spots in an image by selecting them one by one. 

1 In the main window, select the image you want to 
erase dust spots.

2 Click the [Stamp] button.

¿The copy stamp window appears.

3 When the image has redrawn itself, double-click the 
point from where dust is to be erased.

¿The display changes to 100% view.
O The display position can be changed by dragging.

Double-
click

4 Click the button that matches the dust spot to be 
erased.
O If the dust spot is dark in color, click the [ ] button, and if 

the dust spot is light in color, click the [ ] button.
O When you move the cursor over the image, the dust erasure 

range appears as [ ].

5 Place the dust spot to be erased within the [ ] and 
click.

¿The dust spot within the [ ] is erased.
O Click on another part of the image to continue erasing dust spots 

in the image.
O To erase dust in another part of the image, click the button 

clicked in step 4 again to cancel dust erasure processing and 
perform the operation again from step 3.

O When the dust spot cannot be erased, [ ] is displayed.

6 Click the [OK] button to return to the main window.
¿The [ ] mark (p.126) is displayed on an image from which dust 

spots have been erased.

Click
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O Click several times when dust spots are not erased completely
Where unwanted dust spots are not erased even after performing 
step 5 once, they may be erased completely when you click several 
times.

O Mainly spots of dust can be erased with the repair function
Spots of dust can be erased with the repair function. You may be 
unable to erase lines of dust. In this case, use the copy stamp 
function (p.77).

O The dust-erased image can be reverted to its original condition 
at any time
A dust-erased image is displayed or printed as a dust-erased image. 
However, since the dust on the image is not actually erased, you can 
always revert to the original image by clicking the [Undo] button in the 
copy stamp window or performing the “Re-Editing an Image” 
procedure (p.43).

O Check dust erasure in the copy stamp window
Check dust erasure in the copy stamp window. Images before dust 
erasure are displayed in other windows and you will be unable to 
check them.

O Printing dust-erased images
You can print as a dust-erased image by printing it in DPP.

O The image becomes a dust-erased image when converted and 
saved
The dust-erased RAW image actually becomes a dust-erased image 
when converted to a JPEG or TIFF image and saved (p.42).

Additional information

O Checking the dust erased spots
After step 5, you can display and check in detail the erased dust spots 
one by one by pressing the <F> key. (Press the <B> key to return to 
the previous dust spot.)

O Canceling a specified erased dust spot only
After step 5, you can press the <F> key or the <B> key to display the 
erased dust spot, and then press the <delete> key to cancel only the 
erased dust spot displayed.

O Switch between full screen display/normal screen display using 
shortcut keys
You can also switch between full screen display/normal screen 
display by pressing the < > + <F11> keys.

O Applying the dust erasure result to another image
You can apply dust erasure to the same place in another image by 
clicking the [Copy] button to copy the dust erasure results and then 
displaying the other image to which you want to apply the results and 
clicking the [Paste] button.
To apply dust erasure to the same place in several other images, you 
can efficiently erase dust spots by clicking the images while holding 
down the < > key in the main window, or, by selecting multiple 
images by clicking the first image and then clicking the last image 
while holding down the <shift> key, and then displaying the copy 
stamp window.

Useful functions of the copy stamp window

For a list of the copy stamp window functions, see p.140.

For images shot with ISO speed range expansion set, noticeable 
noise may make it difficult to view dust spots in the copy stamp 
window, so using this function is not recommended.
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You can correct an image by pasting a section copied from another part 
of the image to an unwanted part of the image.

1 Follow steps 1 to 3 in “Manually Erasing Dust (Repair 
Function)” (p.75).

2 Specify the section to be copied.
O Click on the section that is to be the copy source while holding 

down the <option> key.
O To change the section that is to be the copy source, perform the 

operation above again.
O To fix the position of the copy source, checkmark [Fix Copy 

Source position].

3 Correct the image.
O Click or drag on the section you want to correct on the image. [+] 

in the window indicates the copy source and [ ] indicates the 
copy destination.

¿The copied image is pasted in the position to which it was 
dragged.

O For [Pen type], you can select from [Brush] (the pasted image’s 
borders simulate a brush) and [Pencil] (the pasted image’s 
borders are sharp).

4 Click the [OK] button to return to the main window.
¿The [ ] mark (p.126) is displayed on a corrected image.

Erasing Unwanted Parts of an Image (Copy Stamp Function)

Transferring a RAW Image to Photoshop
A RAW image can be converted to a TIFF image (16bit) and transferred 
to Photoshop.

Only one image can be transferred at a time. To send multiple images at 
a time, see p.100.

Setting Work Color Space
A different work color space (p.144) from the default settings (p.93) can 
be set for each image.

If you set an image with a color space different to the default setting and 
then subsequently change the default color space setting (p.93), this default 
setting will not be applied and the individually set color space will remain.

Since only the image processing conditions information changes, the 
color space of a RAW image can be changed at any time.

Select the [Tools] menu ` [Transfer to Photoshop].
¿Photoshop starts up and the transferred image is displayed.

A single image can be transferred at a time

O Compatible versions of Photoshop are CS or later.
O Transferred images are automatically converted to TIFF images 

(16bit) to which an ICC profile (p.143) is added. The ICC profile 
contains information about [Preferences] (p.93) or work color 
space set for each image as described below and the appropriate 
color information is relayed to Photoshop.

O When you quit Photoshop, only the original RAW image remains, 
and the transferred image will disappear. Saving the transferred 
image as a separate image in Photoshop is highly recommended.

O For CS4 or later versions of Photoshop, this function is not 
available if a 32-bit version is not installed.

Select the [Adjustment] menu ` [Work color space] ` 
color space to be set.
A color space set individually does not change even when the 
default setting is changed

The color space of a RAW image can be changed freely as 
many times as required
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Compositing Images
You can combine two images into a single image. You can further 
combine images by adding another image to the composited image. 
Since the composited image is saved as a separate image, the original 
images remain as they are.

O This function can be used with all image types (p.3) supported by 
DPP. However, images with more than 6666 × 4444 pixels are not 
supported.

O The color space of a composited image will be the color space of 
the background image.

O Image information is not appended to a composited image. 

1 Select a background image in the main window. 

O You can also select a background image from the edit window, 
edit image window, or [Collection] window.

2 Select the [Tools] menu ` [Start Compositing Tool].

¿The compositing tool window appears. 
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3 Select the image to combine. 
O Select the image to combine from the [Foreground Image] list 

box.

¿The selected image is displayed in the [Foreground Image] 
thumbnail display.

¿A preview of the combined background image and foreground 
image is displayed in the composite preview.

O The following images can be combined.
• When a background image is selected in the main window 

([Folder] window) or edit window: image in same folder as 
background image

• When a background image is selected in the [Collection] 
window: image in the [Collection] window

• When a background image is selected in the edit image 
window: image displayed in the thumbnail display area

O You can combine images of differing sizes.

4 Select a compositing method.
O Select a compositing method from the [Composite Method] list 

box.

¿The compositing method selected in the composite preview is 
applied.

O The compositing method can be selected from five types: Add, 
Average, Weighted, Lighten, and Darken. For details on each 
compositing method, see “Compositing Methods” (p.81). 

O If you select [Weighted], you can set the proportion of brightness 
of the image to be combined. Use the [Weight] slider at the 
bottom of the [Composite Method] list box or directly enter a 
value to set the brightness proportionally.

O By clicking the [100% view] button, the image is displayed at 
100% magnification (actual pixel size).
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5 Position the images.

You can also directly enter the position 
coordinates of the [Foreground Image] 
to align it.

Shift large amount (50 pixels)

Shift small amount (1 pixel)

Align image centers

O By default, the background image and the [Foreground Image] are 
displayed with their centers aligned.

O [Compose in RAW Format]
Checkmark the [Compose in RAW Format] checkbox as necessary.

O You can set [Compose in RAW Format] under the following 
conditions.
Both the background image and [Foreground Image] are RAW 
images, and, all the following conditions are met.
• The cameras used to shoot were of the same model
• The ISO speed setting at time of shooting was the same
• The highlight tone priority setting at time of shooting was the same
• The image sizes (original size) are the same

O The following functions are not available for images composited 
with [Compose in RAW Format]. 
• Auto Lighting Optimizer (p.61)
• Picture Style Auto (automatically set to Standard) (p.59)
• Selecting [Circle] for the aspect ratio when trimming (p.39)
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6 Click the [Save As] button. 

¿By clicking the [Save As] button, the [Convert and save] window 
(p.42) appears. Specify the required settings, and then click the 
[Save] button. 

O By clicking the [Continue] button, images are combined to create 
a new background image, and you can continue by combining 
another image.

O To finish, click the [Close] button.

O Add 
The brightnesses of the background image and [Foreground Image] 
are added and images are overlaid. 

O Average
Images are overlaid with negative exposure compensation being 
applied automatically. If you want to change the amount of exposure 
for individual images, select [Weighted].

O Weighted
Compositing method where brightness is set proportionally for the 
[Foreground Image].

O Lighten
The background image and the [Foreground Image] are compared, 
with only brighter portions being combined. 

O Darken
The background image and the [Foreground Image] are compared, 
with only darker portions being combined.

Compositing Methods

Creating HDR (High Dynamic Range) Images
You can create images with a wide dynamic range where clipping in 
highlights and shadows has been reduced, and images that appear like 
paintings. This is suited for scenes such as still-lifes and landscapes. 
This function is most effective when using three images with different 
exposures of the same scene (negative exposure, standard exposure, 
positive exposure) to create an HDR image. However, you can also 
create an HDR image from two images, or even only one.
Since an HDR image is saved as a separate image, the original images 
remain as they are.
* HDR stands for High Dynamic Range.

O This function can be used with all image types (p.3) supported by 
DPP. However, images with more than 6666 × 4444 pixels are not 
supported.

O Image information is not appended to an HDR image. 

1 Select an image in the main window.
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2 Select the [Tools] menu ` [Start HDR Tool].

¿The [Select Images] window appears. 
O You can also display the [Select Images] window from the edit 

window and edit image window.

3 Specify the required settings, then click the [Start 
HDR] button.

O To change the selected image, or add another image, click the 
[Browse] button and in the [Open] dialog box that appears, select 
the image file and click the [Open] button. 

O If you select two images of the same size, you can checkmark 
the [Auto Align] checkbox for auto image alignment. However, 
auto image alignment may not work properly with repetitive 
patterns (lattice, stripes, etc.) or flat, single-tone images.

¿By clicking the [Start HDR] button, the [Adjust Image] window 
appears.   

After using auto image alignment, the periphery of the images is 
partially deleted.
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4 Make required selections to adjust the image.

O Sliders in [Adjust Image]
[Tone/Color]

[Brightness]: Adjusts the overall brightness of the image. Move 
the slider to the right to brighten the image, and to 
the left to darken the image.

[Saturation]: Adjusts the overall color saturation of the image. 
Move the slider to the right to make the color 
deeper, and to the left to make the color weaker.

[Contrast]: Adjusts the overall contrast of the image. Move 
the slider to the right to make contrast stronger 
and to the left to make contrast weaker.

[Detail Enhancement]
[Strength]: Adjusts the overall contrast and contrast of 

details together. Move the slider to the right for a 
stronger effect.

[Smoothness]:Adjusts the overall smoothness of the image. 
Move the slider to the right for a smooth and 
natural impression.

[Fineness]: Adjusts the clearness of details. Move the slider 
to the right for a sharper outline.

O [Presets] and finishing effects
With [Presets], you can select from the five preset finishing 
effects below from a pulldown menu ([Natural] is selected by 
default), instead of operating the sliders individually. By selecting 
a finishing effect, each slider moves according to the setting. You 
can also operate and adjust the sliders after selecting an effect.
[Natural]: In high-contrast scenes, rendering in areas 

where highlights or shadows are usually clipped 
is corrected, for a finish with reduced highlight 
and shadow clipping.

[Art standard]: Gives a finish with painting-like tonality for an 
impressive image.

[Art vivid]: For a more vivid look than with [Art standard].
[Art bold]: For a more vivid look than with [Art standard], 

that makes the subject pop out.
[Art embossed]: Tones down sharpness more than [Art standard], 

for an old-fashioned feel.
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5 Click the [Save As] button. 

¿By clicking the [Save As] button, the [Convert and save] (p.42) 
window appears. Specify the required settings and click the 
[Save] button.  

Starting Up Map Utility
Map Utility is a software that allows you to view images shot on a GPS 
function-compatible Canon camera, including the shooting location and 
route travelled. After installing Map Utility to your computer, you can 
start it up from DPP.

Select the [Tools] menu ` [Start Map Utility].
¿Map Utility starts up.
O For information about Map Utility, refer to the Map Utility 

instructions, or to the Help for Map Utility.

Do not edit images with DPP and use Map Utility at the same time. 
Editing results may not be saved properly.

O Version 1.1.0 or later versions of Map Utility are compatible.
O Map Utility is not included on the EOS DIGITAL Solution Disk.
O [Start Map Utility] will not appear in the [Tools] menu if Map Utility 

is not installed to your computer.
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Printing with Shooting Information
You can freely lay out one image on one sheet of paper and print 
together with titles and shooting information, etc.

1 Select one image to be printed.

2 Select the [File] menu ` [Print with detailed setting].

3 Specify the required settings for printing, and then 
click the [Print] button.

O The image can be moved by dragging.
O Drag the four corners of the image to change the size.
O For the shooting information, click [ ] on the [Text] tab sheet 

and select the necessary items in the window that is displayed.

Print preview

Switches the settings tab sheet

The settings of each tab sheet in step 3 are memorized when the [Apply] 
button is clicked (excluding the contents of the [Text] tab sheet). The 
settings can be applied to another image when printing.

To maintain the settings

O You can set printer profiles (p.93).
O If CMYK simulation has been set, the image is printed in the set 

colors (p.93).
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Printing a Thumbnail List (Contact Sheet Printing)
You can print rows of multiple images on one sheet of paper.

1 Select images to be printed in a thumbnail list.

2 Select the [File] menu ` [Contact Sheet Prints].

3 Specify the required settings for printing, and then 
click the [Print] button.

Print preview

Switches the settings tab sheet

The settings of each tab sheet in step 3 are memorized when the [Apply] 
button is clicked (excluding the contents of the [Text] tab sheet). The 
settings can be applied to another image when printing.

To maintain the settings

O You can set printer profiles (p.93).
O If CMYK simulation has been set, the image is printed in the set 

colors (p.93).
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Printing RAW Images on a High-End Canon Printer

For high-end Canon inkjet printers that are compatible with the printing 
software Easy-PhotoPrint Pro, you can print with DPP by a simple 
operation that has the following features:
O Simple printing of RAW images
O Printing in faithful colors
O High quality printing using a wide color space of Adobe RGB, etc. and 

the wide color reproduction range of a high-end Canon inkjet printer

To print with DPP, first install Easy-PhotoPrint Pro version 1.3 or later on 
your computer.

1 Select the [File] menu ` [Plug-in printing] ` [Print 
with Easy-PhotoPrint Pro].
¿Easy-PhotoPrint Pro starts up.

2 Match on-screen image colors and printing result 
colors.
O Select [Custom] in [Print Quality], click the [Set] button, and in the 

window that appears, drag the slider to [1] at the right end, and 
then click the [OK] button to close the window.
Next, click the [Color Adjustment] button to display the [Color 
Adjustment] window and display the [Color Management] tab 
sheet. Set [Color Mode] to [Enable ICC Profile] and [Printer 
Profile] to [Auto], and then click the [OK] button to close the 
[Color Adjustment] window.

3 Specify any other required settings for printing, and 
then print.

Printing with a High-End Canon Inkjet Printer
O Print up to 1000 images at a time

You can print up to 1000 images selected in DPP at a time. When 
printing more than 1000 images, divide the printing into several jobs.

O Function set in DPP that is not applied to printing
Specified CMYK simulation (p.93) is not applied.

O The printed image’s color is not what you expected
In the Easy-PhotoPrint Pro window, click the [Color Adjustment] 
button to display the [Color Management] tab sheet, set [Rendering 
Intent] to [Perceptual] (p.144), and try printing.

O Printing with faithful colors
When a color space is set (p.77, p.93), it is automatically transmitted 
from DPP to Easy-PhotoPrint Pro, allowing you to print with faithful 
colors.

O Printing with a wide color reproduction
When the color space setting (p.77, p.93) is set to a color space wider 
than sRGB (such as Adobe RGB), the image is printed with a wider 
color gamut than an image that has an sRGB color space, with green 
and blue in particular being reproduced vividly.

Additional information

Advantages of printing with Easy-PhotoPrint Pro
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You can use DPP to print with the DPP-compatible Canon large-format 
imagePROGRAF printer. To print with DPP, first install imagePROGRAF 
Print Plug-In for Digital Photo Professional on your computer.

O A single image can be printed at a time
You can print a single image selected in DPP at a time. When printing 
multiple images, perform printing for each image individually.

O Functions set in DPP that are not applied to printing
Specified output resolution (p.89) and CMYK simulation (p.93) are not 
applied.

1 Select the [File] menu ` [Plug-in printing] ` Plug-In 
for the printer you use.
¿The Plug-In starts up.

2 Specify the required settings for photograph 
printing, and then print.

Additional information

Printing with a Large-Format Canon Printer
O Printing with faithful colors

When a color space is set (p.77, p.93), it is automatically transmitted 
from DPP to the Plug-In, allowing you to print with faithful colors.

O Printing with a wide color reproduction
When the color space setting (p.77, p.93) is set to a color space wider 
than sRGB (such as Adobe RGB), the color reproduction range of the 
imagePROGRAF printer is fully utilized and the image is printed with 
a wider color gamut than an image that has an sRGB color space, 
with green and blue in particular being reproduced vividly.

Advantages of printing with imagePROGRAF Print Plug-In 
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Specifying Preferences
You can change the various functions of DPP in the [Preferences] 
window. Check the contents of each window and set.
Also, depending on the item, a detailed explanation may be available, 
so refer to each window.

1 Select the [Digital Photo Professional] menu ` 
[Preferences].
¿The [Preferences] window appears.

2 Select the tab sheet, specify the settings, and then 
click the [OK] button.

You can specify the folder that opens when DPP is started up, image 
quality of displayed and saved RAW images, etc.

General Settings
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O Viewing and saving RAW images
You can select from two types of image quality for displaying/saving 
RAW images: high image quality with false color reduction processing 
and noise reduction function (p.62) used, or high speed without false 
color processing and noise reduction function used.

[High quality]
O False color reduction processing is automatically applied, and the 

image can be displayed/saved as a false color reduced-high quality 
image. Furthermore, you can use the noise reduction function (p.62) 
to reduce the luminance noise and chrominance noise.

O Because the effects of the false color reduction processing and noise 
reduction function are difficult to see in the [50% view] or [Fit to 
window] display of the edit window and edit image window, use 
[100% view] or [200% view] to check.

O We recommend that you normally set [High quality] for a balance 
between image quality and display speed.

[View images at high speed (moiré reduction off)] of [High quality]
O If you checkmark [View images at high speed (moiré reduction off)], 

when the image is displayed in the edit window or the edit image 
window, false color reduction processing is not applied. However, you 
can use the noise reduction function.

O As the setting is the same as [High quality] other than for image 
display, the image undergoes false color reduction processing when it 
is saved.

[High speed]
O Since false color reduction processing is not applied, the display 

speed of a RAW image in the edit window or the edit image window, 
and the time it takes to save a RAW image is shorter than with [High 
quality].

O You cannot use the noise reduction function (p.62).
O Depending on the image, it may be displayed/saved with false color 

or noise being noticeable.

For images shot with ISO speed range expansion set, the difference 
in image quality between [High quality] and [High speed] becomes 
remarkable. To check the image quality of images shot with ISO 
speed range expansion, make sure to set [High quality] and check 
the images in the edit window or edit image window.

O JPEG image quality
[Remove block noise and mosquito noise]
O You can improve the quality of a JPEG image by reducing the noise 

particular to JPEG images.
This setting is also effective when RAW images are converted to 
JPEG images and saved (p.42, p.99) and for JPEG images that have 
been saved with a different name.

The higher the JPEG image’s compression rate, the more noise is 
reduced. When the compression rate is low, the effect of noise reduction 
is negligible.

O Default value of output resolution
You can set the resolution for RAW images converted and saved as 
JPEG or TIFF images (p.42, p.99).

The extent of the improvement in noise reduction
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You can specify settings relating to the display.

View Settings O Sort order in main window
You can set the order of images which have been rearranged in the 
main window to be maintained or not maintained (p.21).
If you checkmark the checkbox, the order of the rearranged images is 
maintained even if you quit DPP or select another folder in the folder 
area.
If you remove the check mark, the order of the rearranged images is not 
maintained and reverts to the previous order when you quit DPP or 
select another folder in the folder area.

O Highlight/shadow warning
Highlighted/shaded areas that exceed the set range can be displayed 
on the image as warning indicators (p.55).
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You can specify settings for the tool palette.

O Default settings of RGB Tone curve mode
You cannot apply changes to the settings until you re-open the folder.

Even if the default setting is changed, the new default setting is not 
applied to edited (i.e., adjusted using the tool palette, trimmed, dust-
erased) images. Change each one individually.

Changes are not applied to the edited image

Tool Palette O Modified Picture Style settings
You can select whether the [Color tone], [Color saturation], [Contrast], 
[Unsharp mask] and [Sharpness] settings will be changed or retained, 
when you change the Picture Style.
O If you checkmark the checkbox, the [Color tone], [Color saturation], 

[Contrast] and [Sharpness] settings will be changed to match the 
camera’s preset settings, when you change the Picture Style.

O If you remove the check mark, the [Color tone], [Color saturation], 
[Contrast] and [Sharpness] settings will be retained, even if you 
change the Picture Style.

O Default noise reduction settings
You can set a default beforehand for the noise reduction level. 

RAW Images
• When [Apply camera settings] is selected, you can pre-set a noise 

reduction level that suits the camera settings beforehand as the 
default.

• When [Set as defaults] is selected, you can pre-set a preferred 
default setting for the noise reduction level beforehand.

JPEG/TIFF Images
• You can set a desired default noise reduction level beforehand.

For images not having a recipe attached, the default set here for noise 
reduction level is applied. However, if you want to apply settings to 
images in the opened folder, you need to re-open the folder after making 
settings here. For images with a recipe attached, the noise level 
recorded in the recipe remains as it is and the default for noise reduction 
level set here is not applied.

In instances where the same level of noise occurs in several images, 
such as images shot with high ISO speed, setting an appropriate default 
noise reduction setting enables you to apply a batch noise reduction 
default to all the images displayed in DPP (excluding images with a 
recipe attached). This eliminates the need to apply noise reduction to 
each individual image. And, since you always shoot with the same 
conditions, it is also useful when you want to set the same noise 
reduction level for all shot images.

Advantages of setting a noise reduction default
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You can specify settings relating to color management, such as settings 
for work color space, conditions for color matching, etc.

Color Management O Default settings of Work color space
You can select from five types of color space (p.144) that is applied as a 
default setting in RAW images. Color space that has been set is applied 
as the color space when a RAW image is converted and saved (p.42, 
p.99) or printed (p.43, p.46, p.49, p.85 to p.88).
O If you have changed the setting, and you restart DPP, the new setting 

is applied as the default setting color space.
O You can check color space that has been set in an image in the main 

window (p.124, p.125), the edit window (p.127), and the edit image 
window (p.133).

Even if the default setting is changed, the new default setting is not 
applied to edited (i.e., adjusted using the tool palette, trimmed, dust-
erased) images. Change each one individually.

O Display setting (color setting of the monitor)
Where a profile (p.143) is attached to the monitor you are using, you can 
display an image in more faithful colors by setting the profile.
O Select the [Monitor profile], click the [Browse] button and in the dialog 

box that appears, select a profile for your monitor.

If you use a profile created using a third-party monitor color reader, 
images can be displayed in even more precise colors.

Changes are not applied to the edited image

You can set a color space that is different from the default settings 
for each image (p.77).

Precise coloring with a third-party monitor color reader
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O Setting of printing profile (color setting of the printer)
Where a profile (p.143) is attached to the printer you are using to print 
images, you can print an image and simulate the colors displayed on 
screen by setting the profile. The profile that has been set is applied to 
all printing (p.49, p.85, p.86) except for printing using a Canon inkjet 
printer (p.43, p.46) or linked printing (p.87, p.88).

Even if you set a printer profile, if you use the color adjustment function 
of the printer driver, the image may print in colors different from those 
displayed on screen.

If you are printing using a Canon inkjet printer (p.43, p.46) or using 
linked printing (p.87, p.88), a profile is set automatically even when the 
[Printing profile] setting is not performed. This allows you to print faithful 
colors easily.

The adjustment function of the printer driver should not be 
used

Automatic settings for printing using EPP EX, EPP, and 
linked printing

O Setting of CMYK simulation profile
You can select the color when printing in the CMYK environment of a 
printing machine, etc. from four types of profiles (p.144) and perform 
simulation on screen.
O When CMYK simulation has been set, [CMYK] appears (p.124, p.125, 

p.127, p.133) in the bottom of the main window, edit window and edit 
image window, and colors can be checked.

O To temporarily cancel CMYK simulation, press the <space> key.

O Rendering intents when using Easy-PhotoPrint
You can set a rendering intent (matching method) (p.144) for printing 
using Easy-PhotoPrint (p.46).
O The rendering intent is ordinarily set to [Relative Colorimetric].
O When colors with [Relative Colorimetric] are not satisfactory, set to 

[Perceptual].
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Useful Functions for Processing Large Numbers of RAW Images
For users shooting a large amount of RAW images, the convenient 
function of batch processing large amounts of RAW images is explained 
here.

Utilizing Adjustment Contents (Recipe) ...................  96
Saving Recipes as a File ............................................ 97
Loading and Pasting Recipes..................................... 97
Copying a Recipe and Applying to Another Image..... 97

Batch Apply White Balance to Images (Personal White 
Balance) ..................................................................  98

Registering Personal White Balance.......................... 98
Applying Personal White Balance .............................. 98

Batch Save as JPEG or TIFF Images (Batch 
Processing)..............................................................  99
Batch Transfer Images to Image Editing Software  100
Batch Change the File Name of Images................  101

Changing the File Name of Images in the Order in the 
Main Window............................................................ 101
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Utilizing Adjustment Contents (Recipe)
All the adjustment contents (recipe) made using the tool palette can be 
saved as an individual recipe file (extension “.vrd”) and loaded and 
applied to another image.
You can edit images efficiently by selecting and adjusting one image 
from images shot with the same shooting environment and batch 
applying the adjustment results to a large number of images.

RAW image data 
Image processing conditions information

Contents adjusted using the tool 
palette can be handled 
individually as a recipe file 
(extension “.vrd”).

The adjustment contents of JPEG or TIFF images (p.103) can be 
saved as a recipe file (extension “.vrd”) and loaded and applied to 
another image in the same way as with RAW images.

O Recipe data includes tool palette contents
Recipe data includes adjustments made with the tool palette ([RAW], 
[RGB], [NR/ALO] and [LENS]). For this reason, other editing content 
such as trimming or dust-erasure (copy stamp) is not included in the 
recipe data.

O Recipes adjusted with the [RAW] tool palette can only be applied 
to RAW images
Adjustments in the [RAW] tool palette, which can only be made for 
RAW images, are not applied to a JPEG or TIFF image even if they 
are pasted.

Additional information
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When you do not know the contents of a recipe file, paste it to an image 
and check the settings in the tool palette. When only a few settings are 
adjusted, we recommend you use a file name that describes the 
contents or that you separately record the adjustments as text 
information.

1 Select an edited image, and then select the [Edit] 
menu ` [Save recipe in file].
¿The [Save] dialog box appears.

2 Select the destination folder, enter a file name, and 
then click the [Save] button.

Check the contents of a recipe file by pasting to an image

1 Select the image to which a recipe is to be applied, 
and then select the [Edit] menu ` [Read and paste 
recipe from file].
¿The [Open] dialog box appears.

2 Select a recipe and click the [Open] button.
¿The recipe is applied to the image.

Saving Recipes as a File

Loading and Pasting Recipes

You can copy a recipe of an edited image and then apply it to another 
image.

1 Select the image from which a recipe is to be copied 
and then select the [Edit] menu ` [Copy recipe to 
clipboard].
¿The recipe is copied.

2 Select the image to which the recipe is to be applied 
and then select the [Edit] menu ` [Paste recipe to 
selected image].
¿The recipe is applied to the image.

Copying a Recipe and Applying to Another Image
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Batch Apply White Balance to Images (Personal White Balance)
The white balance adjustments made to a RAW image shot in a specific 
shooting environment can be registered as personal white balance. You 
can then perform efficient white balance adjustment by applying this 
personal white balance to a large number of RAW images shot in the 
same shooting environment.

1 Adjust the white balance (p.27, p.28, p.56).
O To adjust white balance, select a setting other than [Shot 

settings] from the [White balance adjustment] list box (p.27). You 
will be unable to register the adjustments if you select [Shot 
settings]. 

2 In the [RAW] tool palette, click the [Register] button.
¿The [Register personal white balance] dialog box appears.

3 Select the button number to be registered from the 
list and click the [OK] button.

Registering Personal White Balance

You cannot change or adjust white balance with multiple-exposure 
RAW images created on the camera.

1 In the main window, select the image to which white 
balance is to be applied.

2 Click the [Tool palette] button on the toolbar.
¿The tool palette appears.

3 Click the personal white balance number button that 
is to be applied.

¿Personal white balance is applied to all the selected images.

Applying Personal White Balance
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Batch Save as JPEG or TIFF Images (Batch Processing)
You can batch convert and save edited RAW images to highly versatile 
JPEG or TIFF images.
The images are saved as separate images, so the RAW images remain 
unaffected.

1 In the main window, select multiple images to be 
converted.

2 Click the [Batch process] button on the toolbar 
(p.124).
¿The [Batch settings] window appears.

3 Specify the required settings, and then click the 
[Execute] button.

¿The batch processing dialog box appears and saving begins.
¿When all the images are saved, the [Terminate] button appears in 

the batch processing dialog box.

4 In the processing dialog box, click the [Terminate] button.

In the [Batch settings] window, you cannot perform [Save] or [Save As] 
(p.41, p.119) to edited RAW images.

DPP’s RAW image development processing technology is continually 
being improved upon so that you can perform the latest image 
processing more appropriately.
Meaning that, between two differing versions of DPP, processing results 
may differ very slightly even if with the same RAW image data, or the 
results of significant editing of RAW image data with an attached recipe 
may be different.
When you want to save the developing or editing results of the version 
you are currently using as it is, it is recommended that you convert and 
save images as JPEG image or TIFF images. 

O While saving is being performed, you can continue working in 
another window
Since the saving function operates independently in the background, 
you can continue with an operation in another window such as the 
main window or the edit window during the saving process.

O To convert all images and save, do not select an image in the 
main window
If you do not perform step 1 and perform step 2 with no image 
selected in the main window, all the images displayed in the main 
window will be converted and saved.

Saving images with recipe is not possible

To save the developing/editing results for the version you are currently using

Skillful batch saving

If the message [Insufficient memory.] appears, too many images are 
selected at the same time. Decrease the number of selected images.

O If you have selected [New file name] in [File name], [Sequence 
number] has to be set.

O By saving as explained on this page, a trimmed image (p.38, 
p.111) or dust-erased image (p.73 to p.77, p.114 to p.118) 
actually becomes a trimmed image or dust-erased image.

O For a list of [Batch settings] window functions, see p.141.
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Batch Transfer Images to Image Editing Software
You can transfer multiple images to image editing software. Unlike 
[Transferring a RAW Image to Photoshop] (p.77), you transfer images 
that have first been converted and saved as a seperate image, so the 
transferred image will not disappear after quitting the destination 
software. The software used here as an example is Adobe Photoshop 
CS.

1 In the main window, select multiple images to be 
transferred.

2 Click the [Batch process] button on the toolbar 
(p.124).
¿The [Batch settings] window appears.

3 Perform settings required for transferring (e.g. file 
format).

4 Click the [Browse] button.

¿The [Open] dialog box appears.

5 Select Photoshop CS.
O In the [Open] dialog box, select a Photoshop CS file or an alias 

and click the [Open] button.
¿The [Open] dialog box closes and [Image transfer settings] in the 

[Batch settings] window is set to Photoshop CS.

6 Checkmark [Open image using software].

7 Click the [Execute] button.
¿The processing dialog box appears and batch transfer begins.
¿When the first image has been transferred, Photoshop CS starts 

up and transferred images are displayed in transferred order.

If the message [Insufficient memory.] appears, too many images are 
selected at the same time. Decrease the number of selected 
images.
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Batch Change the File Name of Images
1 In the main window, select multiple images of which 

the file names are to be changed.

2 Select the [Tools] menu ` [Start Rename tool].
¿The rename window appears.

3 Specify the required settings (p.142) and click the 
[Execute] button.

¿Processing begins and the file names are changed.

If a file name in red text has appeared in [Modified File Name], the file name 
has been duplicated. Changes cannot be made if even one file name has 
been duplicated. Change the settings so that duplication does not occur.

Changes cannot be made when the file name is duplicated

The name of the movie files cannot be changed in DPP.

O You cannot start up the rename tool from the [Collection] window 
(p.36, p.125). 

O For a list of the rename window functions, see p.142.

When you change the order of the images in the main window, you can 
change in one operation the names of the files for the images, in the 
order they were rearranged.

1 Change the order of the images in the main window 
(p.21).

2 In the main window, select multiple images of which 
the file names are to be changed.

3 Select the [Tools] menu ` [Start Rename tool].

4 Select [Fit to main window].

5 Specify the required settings (p.142).
O To copy an image, checkmark [Copy & Rename].

6 Click the [Execute] button.
¿The file names are changed and the order in the main window is 

maintained.

Changing the File Name of Images in the Order in the Main Window

If the message [Insufficient memory.] appears, too many images are 
selected at the same time. Decrease the number of selected 
images.
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Editing JPEG and TIFF Images
DPP is software mainly aimed for advanced RAW image editing, but it 
also has JPEG and TIFF image editing functions. Here, the editing and 
saving of JPEG and TIFF images are explained.

Editing JPEG and TIFF Images.............................  103
About the RGB Tool Palette ..................................... 103
Automatically Adjusting Brightness and Color (Tone 
Curve Assist) ............................................................ 104
Adjusting Brightness and Contrast ........................... 105
Adjusting Color Tone Using Click White Balance..... 106
Adjusting Hue, Saturation and Sharpness................ 107
Tone Curve Adjustment............................................ 108
Adjusting Dynamic Range ........................................ 109

Reducing Noise .....................................................  110
Trimming and Adjusting the Angle of an Image.....  111
Performing Automatic Dust Erasure Processing ...  114

Compatible Cameras...........................................  114
Automatic Dust Erasure Processing in the Main 
Window ...............................................................  115

Manually Erasing Dust (Repair Function)..............  116
Erasing Unwanted Parts of an Image (Copy Stamp 
Function)................................................................... 118

Compositing and High Dynamic Range.................  118
Starting Up Map Utility...........................................  118
Saving Editing Results...........................................  119

Saving Editing Content to an Image......................... 119
Saving as a Separate Image .................................... 119

Applying Editing Contents to Another Image.........  119
Printing ..................................................................  119
Re-Editing an Image..............................................  120
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Editing JPEG and TIFF Images
With DPP, you can adjust JPEG and TIFF images in the same way as 
RAW images using the [RGB] and [NR/ALO] tool palettes.
Because adjustment made with the tool palette (recipe) only changes 
the image processing conditions, the “original image data itself” remains 
unaffected. Therefore, there are no problems with image deterioration 
that arise with editing and you can readjust your images any number of 
times.

In DPP all the adjustments (image processing conditions information) 
made with the tool palette can be saved in the image as data called a 
“recipe” (p.119), or can be saved, downloaded and applied to other 
images as a separate recipe file (extension “.vrd”) (p.96, p.119).

Image processing conditions information
JPEG, TIFF image data 

Contents adjusted using the tool 
palette can be handled 
individually as a recipe file 
(extension “.vrd”) (p.96, p.119).

With the functions in the [RGB] tool palette, you can adjust JPEG and 
TIFF images with the same functions as ordinary image editing 
software.
However, because the adjustment width of the adjustment functions in 
the [RGB] tool palette is wider than the [RAW] tool palette, the image 
color may be saturated, or the image quality may deteriorate if you 
adjust too much. Therefore, take care not to adjust your images to an 
excessive degree.
You can adjust RAW images with the functions in the [RGB] tool palette. 
However, for functions other than tone curve adjustment (p.108) and 
automatic adjustment (p.104), we recommend adjusting RAW images 
using the same functions available in the [RAW] tool palette.

About the RGB Tool Palette
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In order to make the image a desirable standard image, automatically 
adjust the image tone curve (p.143). You can select the degree of 
automatic adjustment from “Standard” and “High”.

Click the desired automatic adjustment button.
O Standard: Standard automatic adjustment. Suitable for most 

images.
O High: Use when the effect achieved in standard automatic 

adjustment is not strong enough.

¿The tone curve changes as adjusted.

Automatically Adjusting Brightness and Color (Tone Curve Assist)

Reverts the tone curve 
to the original settings

High

Standard

The result of automatic adjustment (tone curve assist) may not be as 
expected with the following images:
• Images which have been shot with the proper exposure
• Images where the brightness is unbalanced
• Images which are too dark
• Images which have extreme backlighting

Images not suitable for automatic adjustment (tone curve 
assist)

If you click the [ ] button, the tone curve as well as the [Hue] 
and [Saturation] revert to the default settings. Take care when 
adjusting the [Hue] and [Saturation] individually (p.107).
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The brightness and contrast of an image can be adjusted.

Adjusting Brightness and Contrast

Drag the sliders left or 
right

Enter numerical values

O Brightness: Move the slider to the right to make an image 
brighter and to the left to make an image darker.

O Contrast: Used to adjust modulation and degree of contrast 
of color. Move the slider to the right to make 
contrast of an image stronger and to the left to 
make contrast weaker.

The adjustment range is –100 to +100 (in 1-stop increments when 
entering a value).
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You can adjust white balance using a selected part of an image as the 
standard for white to make the image appear natural. Using click white 
balance is effective when using it in parts of an image where white color 
tone has changed under the influence of a light source.

1 Click the [ ] button.

Adjusting Color Tone Using Click White Balance 2 Click on a point that is to be the standard for white.

¿The color of the image is adjusted with the point you selected as 
the standard for white.

O If you click on another point in the image, the white balance is 
adjusted again.

O To finish click white balance, click the [ ] button again.

The coordinates of the cursor position and the RGB values (8-bit 
conversion)

When there are no white areas in your image, you can adjust the white 
balance by clicking on a grey point of the image in step 2. This has the 
same adjustment result as selecting a white point.

When there are no white areas in your image

O The image is adjusted based on the average value of 5 × 5 pixel 
range from the clicked point.

O The histogram display changes according to adjustment. You can 
also fix the histogram display to the display before any 
adjustments (p.92).
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You can adjust hue (tone) and saturation and make the overall 
atmosphere of an image harder or softer.

Adjusting Hue, Saturation and Sharpness

Drag the sliders left or right

Enter numerical values

O Hue: Move the slider to the right to make color tones 
more yellow, and to the left to make color tones 
redder.

O Saturation: Move the slider to the right to make the color 
deeper, and to the left to make the color weaker.

O Sharpness: Move the slider to the right to make an image 
harder, and to the left to make an image softer.

Adjust sharpness with the window view set to [100% view], [50% view] 
or [200% view]. If the view is set to [Fit to window] (full view), the 
sharpness will seem unnatural.

Sharpness is unnatural

The adjustment range is –30 to 30 for hue, 0 to 200 for saturation, 
and 0 to 500 for sharpness (in 1-stop increments when entering a 
value).
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You can adjust the brightness, contrast and color of a specific area by 
changing the tone curve (p.143).

1 Select the tone curve mode and interpolation 
method.

Tone Curve Adjustment

<control> + click inside 
the graph to display the 
menu

2 Make adjustments.

O The horizontal axis shows the input level and the vertical axis 
shows the output level.

O The maximum number of [ ] is 8.
O To delete a [ ], double-click on the [ ].

Adjusts each channel

Click to add a [ ] (point)
Adjust by dragging [ ]

Batch adjusts RGB

O The histogram display changes according to adjustment. You can 
also fix the histogram display to the display before any 
adjustments (p.92).

O The tone curve mode and interpolation method for a tone curve 
can also be changed in [Preferences] (p.92).
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Dynamic range (width of gradation expression) from dark points to bright 
points in an image can be adjusted.

O The horizontal axis shows the input level and the vertical axis shows 
the output level.

Adjusting Dynamic Range

Move to the 
left
Input highlight 
points

Reverts the 
image to the 
original 
settings

Move to the 
right
Input shadow 
points

Output 
highlight point 
numerical 
value

Move downwards
Output highlight points

Output shadow 
point numerical 
value

Move upwards
Output shadow points

Input shadow 
point numerical 
value

Input highlight 
point numerical 
value

O The setting range of shadow points is 0 to 247 (in 1-stop 
increments when entering a value).

O The setting range of highlight points is 8 to 255 (in 1-stop 
increments when entering a value).

O The histogram display changes according to adjustment. You can 
also fix the histogram display to the display before any 
adjustments (p.92).
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Reducing Noise
You can reduce noise that arises in JPEG and TIFF images that have 
been shot at night or with a high ISO speed.

1 Select the [NR/ALO] tab sheet from the tool palette in 
the edit window or edit image window.

2 Click the [NR Preview] button.

¿The [NR Preview] window appears.

3 Adjust an image.

O You can set a noise reduction level from within a range of 0 to 20. 
The larger the setting, the larger the noise reduction effect.

O The noise reduction effect can be checked when an image is 
displayed at 100% in the NR check window.

O You can change the display position of the NR check window by 
dragging the enlargement display position in the navigator 
window.

Navigator 
window

Enlargement 
display 
position

NR check window

Drag the 
sliders

4 Click the [Apply] button.
¿Noise reduction is applied to the image and the image is 

redisplayed.

After selecting multiple images in the main window, you can set the 
same noise reduction level for the images without displaying the [NR 
Preview] window, by adjusting the noise reduction level in the [NR/ALO] 
tool palette (p.129) using the [Luminance noise reduction] and 
[Chrominance noise reduction] sliders, and then clicking the [Apply] 
button.

To set the same noise reduction level for several images

O If [Luminance noise] has been set, resolution may be reduced 
along with reduction of noise.

O If [Chrominance noise] has been set, color bleeding may occur 
along with reduction of noise. 

O You can set the batch processing settings for noise reduction 
beforehand, using [Default noise reduction settings] in the [Tool 
palette] tab sheet in the [Preferences] (p.92). This is particularly 
useful for applying noise reduction to all the images in a folder at 
once, such as batch noise reduction for images with high ISO 
speeds. However, where images have a recipe attached, the 
noise level recorded in the recipe is applied.

O For a list of [NR Preview] window functions, see p.131.
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Trimming and Adjusting the Angle of an Image
You can trim only the part of an image you need, or change the 
composition of an image where an image shot horizontally becomes 
vertical. You can also adjust the angle of an image before trimming. If 
you select [Circle] for [Aspect ratio], the area outside the specified range 
will only be masked in black and the image will not be trimmed.

1 Select the image to be trimmed.

2 Open the trimming/angle adjustment window.
O Click the [Trimming Angle] button.

¿The trimming/angle adjustment window appears.
¿Editing can be done once the image is displayed clearly in the 

trimming/angle adjustment window.

3 Adjust the angle of the image as needed.

O If you click [Center on Screen], you can display the trimming 
range in the center of the window.

O If you click the [OK] button after adjusting only the angle of the 
image, the image will be trimmed at the largest possible trimming 
range.

When aspect ratio information is attached to an image shot with the 
EOS-1D X, EOS-1D Mark IV, EOS-1Ds Mark III, EOS-1D Mark III, 
EOS 5D Mark III, EOS 7D, EOS 60D, EOS REBEL T4i/650D or 
EOS REBEL T3i/600D, the trimming range based on the aspect 
ratio information is displayed.

Trimming/angle adjustment window

Use the mouse (click S/T) to adjust the angle or 
directly enter the adjustment angle* (0.01-degree 
increments; adjustable range: -45 to +45 degrees)

Click
(rotate 
image left 
or right in 
90-degree 
increments)

Drag* (0.01-degree increments; 
adjustment range: -45 to +45 degrees)

Largest 
possible 
trimming 
range

* You cannot adjust the angle of images that exceed 9999 x 6666 
pixels in size.CO
PY
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4 Select a ratio and drag the trimming range.

O The trimming range can be moved by dragging.
O You can enlarge or reduce the size of the trimming range by 

dragging the four corners of the trimming range. (Not available 
when [Circle] is selected.)

O List of aspect ratios (width : height)

[Free]: You can trim an image to any size, regardless of the 
selectable ratio.

[Custom]: You can trim an image at the specified ratio.
[Circle]: The area outside the specified range is masked in 

black. The image is not trimmed.

Cancel

Select a 
trimming 
ratio

Drag the 
trimming 
range

5 Click the [OK] button to return to the main window.
¿The trimming range frame is displayed in the trimmed image 

(p.126).
¿When the trimmed image is displayed in an edit window or the 

edit image window, it is displayed in its trimmed form.
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O The trimmed range can be reverted to its original condition at 
any time
A trimmed image is displayed or printed as a trimmed image. 
However, since the image is not actually trimmed, you can always 
revert to the original image by clicking the [Reset] button in the 
trimming/angle adjustment window or performing the “Re-Editing an 
Image” procedure (p.120).

O Display of the trimmed image in each window
• Main window: The frame showing the trimming range is 

displayed on the image (p.126).
• Edit window: The image is displayed in its trimmed condition.
• Edit image window: The thumbnail image is the same as the main 

window display, and the enlarged image is the 
same as the edit window display.

O Printing a trimmed image
You can print as a trimmed image by printing it in DPP.

O The image becomes a trimmed image when saved as a separate 
image
The trimmed JPEG or TIFF image actually becomes a trimmed image 
when saved as a separate image (p.119).

O Images that have aspect ratio set will be displayed as trimmed 
images
When aspect ratio information is attached to a RAW image shot with 
EOS-1D X, EOS-1D Mark IV, EOS-1Ds Mark III, EOS-1D Mark III, 
EOS 5D Mark III, EOS 7D, EOS 60D, EOS REBEL T4i/650D or EOS 
REBEL T3i/600D, the set trimming range based on the aspect ratio 
information is displayed. Since the image is not actually trimmed, you 
can change the trimming range or revert to the condition before 
trimming.
However, when a JPEG image is shot in a [4:3], [16:9] or [1:1] aspect 
ratio set with the EOS 5D Mark III, EOS 60D, EOS REBEL T4i/650D 
or EOS REBEL T3i/600D, its trimming range cannot be changed nor 
reverted to the condition before trimming, since the image is actually 
trimmed and saved in the set trimming ratio.*
When reverting to the condition before trimming is performed based 
on the aspect ratio information at the time of shooting, click the 
[Reset] button. Also, if you want to cancel all the trimming range, click 
the [Clear] button (p.135).

About trimmed images
* For JPEG images shot with EOS 5D Mark III and [Add cropping 

information] set in Custom Functions, aspect ratio information is 
only set and the image is not actually trimmed.

O Switch between screens using the keyboard 
You can also switch between full screen display/normal screen 
display by pressing the < > + <F11> keys.

O Operate using the menu
Each operation can also be performed with the menu which appears 
by clicking on the image while holding down the <control> key.

O Apply the trimmed range to another image
You can apply the trimmed range to another image by clicking the 
[Copy] button to copy the trimmed range, displaying another image 
and then clicking the [Paste] button.
To batch apply a copied trimming range to multiple images, select the 
trimmed image and the multiple images to which you want to apply 
the trimmed range in the main window, and display the trimming/angle 
adjustment window. With the trimmed image displayed, click the 
[Copy] button and then click the [Apply All] button. This will apply the 
trimming range to all the images selected when the trimming/angle 
adjustment window is displayed.

Convenient functions of the trimming/angle adjustment 
window

For a list of the trimming/angle adjustment window functions, see 
p.135.

For images shot with ISO speed range expansion set, noticeable 
noise may make it difficult to view image details in the trimming/
angle adjustment window, so using this function is not 
recommended.
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Performing Automatic Dust Erasure Processing
The Dust Delete Data that is appended to images shot with the camera 
that can attach this data, can be used to automatically erase dust spots.

EOS-1D X EOS-1D Mark IV EOS-1Ds Mark III

EOS-1D Mark III EOS 5D Mark III EOS 5D Mark II

EOS 7D EOS 60D EOS 50D

EOS 40D EOS REBEL 
T4i/650D

EOS REBEL 
T3i/600D

EOS REBEL 
T2i/550D

EOS REBEL 
T1i/500D

EOS DIGITAL REBEL 
XSi/450D

EOS DIGITAL REBEL 
XTi/400D DIGITAL

EOS REBEL 
T3/1100D

EOS DIGITAL REBEL 
XS/1000D

1 In the main window, select an image appended with 
Dust Delete Data.

2 Click the [Stamp] button.

¿The copy stamp window appears.

Compatible Cameras

3 When the image has redrawn itself, click the [Apply 
Dust Delete Data] button.

¿Dust spots are erased in a single operation.

4 Click the [OK] button to return to the main window.
¿The [ ] mark (p.126) is displayed on an image from which dust 

spots have been erased.

Dust Delete Data is not attached to images having settings specified 
during RAW processing on the camera for distortion correction, 
chromatic aberration correction, etc. As a result, you cannot perform 
automatic dust erasure processing on such images.
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O The dust-erased image can be reverted to its original condition 
at any time
A dust-erased image is displayed or printed as a dust-erased image. 
However, since the dust on the image is not actually erased, you can 
always revert to the original image by clicking the [Undo] button in the 
copy stamp window or performing the “Re-Editing an Image” 
procedure (p.120).

O Check dust erasure in the copy stamp window
Check dust erasure in the copy stamp window. Images before dust 
erasure are displayed in other windows and you will be unable to 
check them.

O Printing dust-erased images
You can print as a dust-erased image by printing it in DPP.

O The [Apply Dust Delete Data] button cannot be clicked
Even with an image that has Dust Delete Data attached to it in the 
camera, if there is no dust to remove by DPP from the image, the 
[Apply Dust Delete Data] button will be disabled.

O To erase dust spots that cannot be erased with the automatic 
dust erasure processing
In automatic dust erasure processing, dust spots are erased based on 
information relating to dust saved in the Dust Delete Data. However, 
there may be cases where you will not be able to erase dust spots 
depending on the type of dust. If this occurs, erase those dust spots 
using the repair function (p.116) or the copy stamp function (p.118).

O The image becomes a dust-erased image when saved as a 
separate image
The dust-erased JPEG or TIFF image actually becomes a dust-
erased image when saved as a separate image (p.119).

Additional Information

O Checking the dust erased spots
After step 3, you can display and check in detail the erased dust spots 
one by one by pressing the <F> key. (Press the <B> key to return to 
the previous dust spot.)

O Canceling a specified erased dust spot only
After step 3, you can press the <F> key or the <B> key to display the 
erased dust spot, and then press the <delete> key to cancel only the 
erased dust spot displayed.

O Switch between full screen display/normal screen display using 
shortcut keys
You can also switch between full screen display/normal screen 
display by pressing the < > + <F11> keys.

O Applying the dust erasure result to another image
You can apply dust erasure to the same place in another image by 
clicking the [Copy] button to copy the dust erasure results and then 
displaying the other image to which you want to apply the results and 
clicking the [Paste] button.

In the main window, you can also automatically erase dust spots in 
multiple images appended with Dust Delete Data.

Useful functions of the copy stamp window

For a list of the copy stamp window functions, see p.140.

Select multiple images appended with Dust Delete 
Data, and then select the [Adjustment] menu ` 
[Apply Dust Delete Data].
¿Dust spots in all the selected images are erased in a single 

operation.

Automatic Dust Erasure Processing in the Main Window 
CO
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Manually Erasing Dust (Repair Function)
You can erase dust spots in an image by selecting them one by one. 

1 In the main window, select the image you want to 
erase dust spots.

2 Click the [Stamp] button.

¿The copy stamp window appears.

3 When the image has redrawn itself, double-click the 
point from where dust is to be erased.

¿The display changes to 100% view.
O The display position can be changed by dragging.

Double-
click

4 Click the button that matches the dust spots to be 
erased.
O If the dust spot is dark in color, click the [ ] button, and if 

the dust spot is light in color, click the [ ] button.
O When you move the cursor over the image, the dust erasure 

range appears as [ ].

5 Place the dust spot to be erased within the [ ] and 
click.

¿The dust spot within the [ ] is erased.
O Click on another part of the image to continue erasing dust spots 

in the image.
O To erase dust in another part of the image, click the button 

clicked in step 4 again to cancel dust erasure processing and 
perform the operation again from step 3.

O When the dust spot cannot be erased, [ ] is displayed.

6 Click the [OK] button to return to the main window.
¿The [ ] mark (p.126) is displayed on an image from which dust 

spots have been erased.

Click
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O Click several times when dust spots are not erased completely
Where unwanted dust spots are not erased even after performing 
step 5 once, they may be erased completely when you click several 
times.

O Mainly spots of dust can be erased with the repair function
Spots of dust can be erased with the repair function. You may be 
unable to erase lines of dust. In this case, use the copy stamp 
function (p.118).

O The dust-erased image can be reverted to its original condition 
at any time
A dust-erased image is displayed or printed as a dust-erased image. 
However, since the dust on the image is not actually erased, you can 
always revert to the original image by clicking the [Undo] button in the 
copy stamp window or performing the “Re-Editing an Image” 
procedure (p.120).

O Check dust erasure in the copy stamp window
Check dust erasure in the copy stamp window. Images before dust 
erasure are displayed in other windows and you will be unable to 
check them.

O Printing dust-erased images
You can print as a dust-erased image by printing it in DPP.

O The image becomes a dust-erased image when saved as a 
separate image
The dust-erased JPEG or TIFF image actually becomes a dust-
erased image when saved as a separate image (p.119).

Additional information

O Checking the dust erased spots
After step 5, you can display and check in detail the erased dust spots 
one by one by pressing the <F> key. (Press the <B> key to return to 
the previous dust spot.)

O Canceling a specified erased dust spot only
After step 5, you can press the <F> key or the <B> key to display the 
erased dust spot, and then press the <delete> key to cancel only the 
erased dust spot displayed.

O Switch between full screen display/normal screen display using 
shortcut keys
You can also switch between full screen display/normal screen 
display by pressing the < > + <F11> keys.

O Applying the dust erasure result to another image
You can apply dust erasure to the same place in another image by 
clicking the [Copy] button to copy the dust erasure results and then 
displaying the other image to which you want to apply the results and 
clicking the [Paste] button.
To apply dust erasure to the same place in several other images, you 
can efficiently erase dust spots by clicking the images while holding 
down the < > key in the main window, or, by selecting multiple 
images by clicking the first image and then clicking the last image 
while holding down the <shift> key, and then displaying the copy 
stamp window.

Useful functions of the copy stamp window

For a list of the copy stamp window functions, see p.140.

For images shot with ISO speed range expansion set, noticeable 
noise may make it difficult to view dust spots in the copy stamp 
window, so using this function is not recommended.
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You can correct an image by pasting a section copied from another part 
of the image to an unwanted part of the image.

1 Follow steps 1 to 3 in “Manually Erasing Dust (Repair 
Function)” (p.116).

2 Specify the section to be copied.
O Click on the section that is to be the copy source while holding 

down the <option> key.
O To change the section that is to be the copy source, perform the 

operation above again.
O To fix the position of the copy source, checkmark [Fix Copy 

Source position].

3 Correct the image.
O Click or drag on the section you want to correct on the image. [+] 

in the window indicates the copy source and [ ] indicates the 
copy destination.

¿The copied image is pasted in the position to which it was 
dragged.

O For [Pen type], you can select from [Brush] (the pasted image’s 
borders simulate a brush) and [Pencil] (the pasted image’s 
borders are sharp).

4 Click the [OK] button to return to the main window.
¿The [ ] mark (p.126) is displayed on a corrected image.

Erasing Unwanted Parts of an Image (Copy Stamp Function)
Compositing and High Dynamic Range
You can composite images also using JPEG and TIFF images in the 
same way as RAW images as described below.
O Compositing Images (p.78) 
O Creating HDR (High Dynamic Range) Images (p.81) 

Starting Up Map Utility 
You can start up Map Utility using the procedure below.
O Starting Up Map Utility (p.84) 
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Saving Editing Results

All the contents (recipe) adjusted with the tool palette (p.103 to p.110) 
as well as the trimmed range (p.111) and dust-erasure (p.114 to p.118) 
information can be saved to a JPEG or TIFF image, or to a separate 
JPEG or TIFF image.

Select the [File] menu ` desired item.

¿Your adjustments are saved to the image.

Saving Editing Content to an Image
If a JPEG or TIFF image is adjusted with the tool palette (p.103 to p.110) 
and then saved in the same way as a RAW image as described below, 
the image can be saved as a separate image with the adjustments 
(recipe) applied to it.
Furthermore, if a trimmed image (p.111) or dust-erased image (p.114 to 
p.118) is also saved in the same way, it actually becomes a trimmed or 
dust-erased image.
O Saving as a JPEG or TIFF Image (p.42)
O Batch save as JPEG or TIFF images (batch processing) (p.99)
By saving as a separate JPEG or TIFF image as explained above, the 
adjustments made with the tool palette are applied, and some image 
deterioration that accompanies editing/saving occurs as when editing 
with ordinary image editing software.

Applying Editing Contents to Another Image
You can copy the adjustment contents (recipe) of JPEG and TIFF 
images that have been adjusted with the tool palette and apply them to 
another image with the procedures below, in the same way as with RAW 
images.
O Applying adjustment contents to another image (p.41)
O Utilizing adjustment contents (recipe) (p.96)

Printing
Edited JPEG and TIFF images can be printed with the procedures 
below as with RAW images.
O Printing (p.43)
O Printing with shooting information (p.85)
O Printing a thumbnail list (contact sheet printing) (p.86)
O Printing RAW images on a high-end Canon printer (p.87)

Saving as a Separate Image
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Re-Editing an Image
Only the image processing conditions are changed in images adjusted 
with the tool palette (p.103 to p.110), so the “original image data itself” 
remains unaffected. Also, the trimming range or dust-erasure 
information of a trimmed image (p.111) or dust-erased image (p.114 to 
p.118) is simply saved to the image.
For this reason, you can undo any adjustments saved (p.119) to the 
image, trimming range and dust-erasure information, and revert to the 
condition when last saved, or when the image was shot.

1 Select the image that is to be re-edited.

2 Select the [Adjustment] menu ` desired item.

¿The image reverts to the conditions of the selected item.
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Reference
This reference section has been provided to enhance your experience 
using DPP.
It contains various troubleshooting solutions, how to delete DPP from 
your computer, explanations of the various windows and a glossary.
An Index is provided at the end of the chapter for you to easily find 
information you are looking for.

Troubleshooting.....................................................  122
Deleting the Software (Uninstalling) ......................  123
List of Main Window (Folder Window) Functions ..  124
List of Main Window (Collection Window) Functions...  125
Image Frame Information in the Main Window and Edit 
Image Window.......................................................  126
List of Edit Window Functions ...............................  127
List of Tool Palette Functions ................................  128
List of NR Preview Window Functions...................  131
List of Quick Check Window Functions .................  132
List of Edit Image Window Functions ....................  133
List of Convert/Save One Image Window Functions .....  134
List of Trimming/Angle Adjustment Window Functions ..  135
List of Lens Aberration Correction Window Functions ...  136
List of Digital Lens Optimizer Adjustment Window 
Functions ...............................................................  137
List of Compositing Tool Window Functions...............  138
List of HDR Window (Adjust Image) Functions .....  139
List of Copy Stamp Window Functions..................  140
List of Convert/Save Multiple Images Window (Batch 
Processing) Functions ...........................................  141
List of Rename Window Functions ........................  142
Glossary ................................................................  143
Index......................................................................  145
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Troubleshooting
If DPP is not operating correctly, refer to the items below.

O You cannot install software unless you are logged into an account with 
Administrator privileges. Log in again into an account with 
Administrator privileges. For how to log in and how to specify 
Administrator settings, refer to the User’s Manual for the Macintosh 
computer you are using or for OS.

O DPP does not operate correctly on a computer if its system 
requirements are not met. Use DPP on a computer with compatible 
system requirements (p.3).

O Even if your computer has the RAM capacity (memory) described in 
the system requirements (p.3), if other applications are running at the 
same time as DPP, you may not have sufficient RAM (memory). Quit 
any applications other than DPP.

O Depending on the card reader and computer OS used, SDXC cards 
might not be correctly detected. In such a case, connect your camera 
and computer with the provided interface cable, and transfer the 
images to your computer using EOS Utility (provided software).

O Images that are not supported by DPP do not display. There are 
various types of JPEG and TIFF images, so JPEG images other than 
Exif 2.2, 2.21 or 2.3 compatible images and TIFF images other than 
Exif compatible images may not display properly (p.3).

O When a dust-erased image (p.73 to p.77, p.114 to p.118) is displayed 
in a window other than the copy stamp window, it is displayed as it 
was before dust erasure was performed. Check dust-erased images 
in the copy stamp window.

Installation could not be completed correctly

DPP does not work

The card reader does not detect the SD card.

Images do not display properly

O The JPEG and TIFF images cannot be adjusted using the image 
adjustment function of the [RAW] tool palette. Adjust these images 
with the [RGB] tool palette (p.128).

O You cannot paste (apply) rotation (p.10, p.25, p.124, p.132, p.133), 
trimming (p.38, p.111), dust erasure (copy stamp) (p.73 to p.77, p.114 
to p.118) of an image to another image as a recipe. Trim the image or 
erase dust of the image using the copy/paste function in each window 
and rotate each image individually.

O The adjustment contents (recipe) of RAW images that has been 
adjusted with the [RAW] tool palette cannot be applied to JPEG or 
TIFF images (p.128).

O The Auto Lighting Optimizer (p.61) is a function that is only available 
for RAW images shot with EOS-1D X, EOS-1D Mark IV, EOS 5D 
Mark III, EOS 5D Mark II, EOS 7D, EOS 60D, EOS 50D, EOS REBEL 
T4i/650D, EOS REBEL T3i/600D, EOS REBEL T2i/550D, EOS 
REBEL T1i/500D and EOS REBEL T3/1100D. You cannot apply the 
Auto Lighting Optimizer’s adjustment contents to RAW images shot 
with other cameras.

O A RAW image which has a color space other than sRGB set (p.77, 
p.93) and is then converted and saved as a JPEG or TIFF image will 
appear weak in color when viewed in software that is only compatible 
with sRGB color space. In this case, set the RAW image color space 
to sRGB, convert again to a JPEG or TIFF image and save, and then 
view this image.

An image could not be adjusted

A recipe could not be pasted (applied) to another image

Color appears weak in the image when viewed with 
other software
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O If the color of the monitor that displays an image is not adjusted 
correctly, or if a profile for a printer that is to print images, has not 
been set up, the color of the image displayed on screen and the color 
of the printed photograph may differ greatly. If the color of the monitor 
that displays images is corrected (p.93) and a profile for a printer is 
set up correctly (p.93), the color of a printed photograph and the color 
of an image on screen can be more closely matched. Using a Canon 
printer (p.43, p.46) or linked printing (p.87, p.88) automatically sets up 
printer profiles, so you only need to set the color of the monitor to 
bring the colors closer together.

O When printing using Easy-PhotoPrint and the Easy-PhotoPrint 
automatic compensation function and the various types of image 
adjustment functions are operating, colors are not printed correctly. 
Cancel all Easy-PhotoPrint image adjustment functions (p.47).

O Even if you set a printer profile, if you use the color adjustment 
function of the printer driver, the image may print in colors different 
from those displayed on screen. Do not use the color adjustment 
function of the printer driver.

O If a large number of images are printed in batches, printing may stop 
in the middle or the images may not be printed. Reduce the number of 
images to print or increase the memory on your computer.

O Delete [CRW_YYYY.THM] (camera index display image) if it remains 
in the folder from which images have been deleted (p.49).
* Numbers are entered for [YYYY] in the file name.

O A JPEG image set to Adobe RGB and shot with EOS 10D and EOS 
DIGITAL REBEL/300D DIGITAL may not display image information 
(p.10, p.23).

The colors of the image displayed on screen and 
the colors of the printed image do not match

Printing a large number of images in batches cannot be performed

A file remains in the folder after images are deleted

The image information does not display

Deleting the Software (Uninstalling)
O Quit any applications before uninstalling the software.
O Log into the account used when installation was performed.
O When you have moved the folders and the software to be deleted to 

the Trash, select the [Finder] menu ` [Empty Trash] and empty the 
Trash. You cannot reinstall the software until you have emptied the 
Trash.

1 Display the folder in which the software is saved.
O Open the [Canon Utilities] folder.

2 Drag the folder for the software to be uninstalled to 
the Trash.

3 Select [Finder] menu on the desktop ` [Empty Trash].
¿The software is deleted.
O When uninstallation ends, restart your computer.

You cannot retrieve data that you have emptied into the Trash and 
deleted, so be particularly careful when deleting data.
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List of Main Window (Folder Window) Functions (p.10)

*1 To switch between show/hide, select the [View] menu ` [Toolbar].
*2 The images inside the folders selected here are displayed in a 

thumbnail list on the right.
*3 Displays the coordinates of the cursor position and the RGB values (8-bit 

conversion) when click white balance was performed with the tool palette.

*4 The item selected in [Viewing and saving RAW images] (p.89) of the 
[Preferences] window is displayed.

*5 You can switch between the [Folder] and [Collection] windows.

Shows/hides the folder area

Folder area*2

Folder path

Shows/hides the tool palette (p.128)
Selects all images

Switches to the edit image 
window (p.133)

Cancels selection of all images

Image rotation 
(90 degree units)

Toolbar*1
Batch conversion/
saving 
(p.99, p.100, p.141)[Folder] tab sheet*5

[Collection] tab sheet*5

CMYK simulation 
display (p.93)Display mode*4

Number of displayed imagesRecipe attachment status (p.96)
Number of selected imagesImage color space and work 

color space*3 (p.77, p.93)

Rating (p.19)

Check mark (p.19)

Displays the quick check window (p.132)
Displays the copy stamp window (p.140)

Displays the trimming/
angle adjustment 
window (p.135)

Image information (p.23)
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Shows/hides the tool palette Selects all images
Cancels selection of all images

Image rotation 
(90 degree units)

Toolbar
Batch conversion/
saving

[Folder] tab sheet
[Collection] tab sheet*1

CMYK simulation 
displayDisplay mode

Number of displayed imagesRecipe attachment status
Number of selected images

Switches to the edit image 
window

*1 The total number of images added to the [Collection] window is 
displayed in the ( ) in the [Collection] tab sheet. Accordingly, when an 
image is added that is displayed as a single image (p.22), twice the 
total number of displayed images is displayed.

*2 Displays the coordinates of the cursor position and the RGB values (8-
bit conversion) when click white balance was performed with the tool 
palette.

Image color space and work 
color space*2 (p.77, p.93)

Displays the quick check window 
Displays the copy 
stamp window 

Displays the trimming/
angle adjustment 
window 

Image information 

Rating

Check mark

List of Main Window (Collection Window) Functions (p.36)
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*1 Does not display with [Small thumbnail].
*2 Displays in RAW+JPEG images displayed as a single image (p.22).

[RAW] is displayed in RAW images. 
(In [Small thumbnail] (p.10), [R] is displayed.)

*3 Does not display with [Medium thumbnail] or [Small thumbnail].

*4 When aspect ratio information is attached to an image shot with 
EOS-1D X, EOS-1D Mark IV, EOS-1Ds Mark III, EOS-1D Mark III, 
EOS 5D Mark III, EOS 7D, EOS 60D, EOS REBEL T4i/650D or EOS 
REBEL T3i/600D, the image is displayed as a trimmed image.

*5 Displayed on images shot on a GPS function-compatible Canon 
camera.

Information displayed when [Large thumbnail] (p.10) is selected

Check mark 
(p.18, p.19)

Brightness 
adjustment 
value*1 (p.26)

White balance icon*1 (p.27)

Copy stamp 
mark 
(p.73 to p.77, 
p.114 to p.118)

Aperture*3

Shutter speed*3

File name

Image type*2

Unsaved editing content mark

Trimming 
range*4 
(p.38, p.111)

Lens 
aberration 
correction 
mark (p.65)

Rating mark 
(p.18, p.19)

Digital Lens 
Optimizer mark 
(p.69 to p.72)

GPS mark*5

Image Frame Information in the Main Window and Edit Image Window (p.10, p.34)
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*1 To switch between show/hide, select the [View] menu ` [Tool palette].
*2 Displays the coordinates of the cursor position and the RGB values (8-

bit conversion).

*3 RAW images are displayed with [RAW].
*4 The item selected in [Viewing and saving RAW images] (p.89) of the 

[Preferences] window is displayed.

Path and file name of image Tool palette*1 (p.128, p.129, p.130)

Information display*2
Display mode*4

CMYK simulation display (p.93)

Image color space*3 and work color space (p.77, p.93)

List of Edit Window Functions (p.11, p.25)
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List of Tool Palette Functions

* If an image is displayed enlarged, the enlargement display position can be 
moved by dragging. The enlargement display position appears when 
[Docking display] (p.92) has been set and the edit image window (p.133) 
has been enlarged.

RAW Tool Palette (p.25)

Brightness adjustment (p.26)

RGB Tool Palette (p.60)

Automatic adjustment
(tone curve assist) (p.33, p.104)

White balance adjustment 
(p.27, p.28, p.56)

Picture Style settings (p.26, p.59)

Dynamic range adjustment (p.57)

Color tone and color saturation 
adjustment (p.29)

Sharpness adjustment (p.31)

Contrast adjustment (p.29)

Enlargement display position*

Click white balance (p.106)

Dynamic range adjustment (p.109)

Brightness and contrast 
adjustment (p.105)

Hue and Saturation adjustment 
(p.107)

Sharpness adjustment (p.107)

Enlargement display position*

Tone curve adjustment 
(p.58, p.108)

Linear setting (p.29)
Shadow/highlight adjustment (p.57)
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* If an image is displayed enlarged, the enlargement display position can 
be moved by dragging. The enlargement display position appears 
when [Docking display] (p.92) has been set and the edit image window 
(p.133) has been enlarged.

NR/ALO Tool Palette 

Auto Lighting Optimizer (p.61)

Apply noise reduction button (p.62)

Enlargement display position*

Chrominance noise reduction for 
JPEG and TIFF images (p.110)

NR/ALO Tool Palette 

Enlargement display position*

(When a RAW image is selected) (When a JPEG or TIFF image is selected)

Luminance noise reduction for 
JPEG and TIFF images (p.110)

Luminance noise reduction for 
RAW images (p.62)
Chrominance noise reduction for 
RAW images (p.62)

Apply noise reduction button (p.110)
Displays the [NR Preview] window 
(p.110, p.131)

Displays the [NR Preview] window 
(p.62, p.131)
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LENS Tool Palette 

Amount of Digital Lens Optimizer (p.70)

Lens data status (p.70)

Lens aberration correction adjustment button (p.65)

Lens aberration correction (p.65)

Lens data Update button (p.70)

Digital Lens Optimizer adjustment button (p.71)
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List of NR Preview Window Functions (p.62, p.110)

Apply noise reduction 
button

Enlargement display 
position

* When you select a JPEG or TIFF image and display the [NR Preview] 
window, [TIFF/JPEG] appears and you can reduce luminance noise 
and chrominance noise for the JPEG and TIFF images.

Navigator window

Luminance noise 
reduction

Chrominance noise 
reduction

Image type*

NR check window
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List of Quick Check Window Functions (p.16, p.18)

Check marks (p.18)

Check mark display

Removes check 
marks (p.18)

Image rotation 
(90 degree units)

Switches between 
displayed images

Displays the image 
in full screen*2

File name of image
50% view/100% view (moiré reduction off)/full view*1

*1 You can select 50% view/100% view (moiré reduction off) by selecting 
[Preferences] in the [Digital Photo Professional] menu and using 
[Quick check tool display] in the [View settings] tab sheet. You can 
also move the display position in the enlarged display by dragging the 
image.

*2 To return to the normal screen, press the <esc> key.

Displays the image 
information window 
(p.24)

Displays the AF 
points (p.16)

Rating mark display

Rating (Reject) (p.18)

Rating (p.18)
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List of Edit Image Window Functions (p.34, p.36)

*1 RAW images are displayed with [RAW].
*2 Displays the coordinates of the cursor position and the RGB values 

(8-bit conversion).
*3 Displays images selected in the main window. The image selected 

here is enlarged and displayed on the right.

*4 You can set the grid spacing with [Grid pitch] in the [Preferences] (p.91).
*5 The item selected in [Viewing and saving RAW images] (p.89) of the 

[Preferences] window is displayed.

Shows/hides thumbnail display area
Shows/hides tool palette

Shows/hides grid*4

Enlargement ratio of displayed image

Switches to main window 
(p.124)

Switches between 
displayed images

Image rotation 
(90 degree units)

Batch conversion/
saving
(p.99, p.100, 
p.141)

Toolbar

Thumbnail display area*3

Display mode*5

Information display*2

Tool palette 
(p.128)

Image color space*1 and work color space 
(p.77, p.93)

CMYK simulation display (p.93)

Image path and 
file name

Image information (p.23)
Displays the copy stamp window 
(p.73 to p.77, p.114 to p.118, p.140) 

Displays the trimming/
angle adjustment window 
(p.38, p.111, p.135)
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List of Convert/Save One Image Window Functions (p.42)

*1 The setting range is 1 to 60,000 dpi.
*2 Color space (p.77, p.93) information that is set in an image is attached 

to an ICC profile.
Even if you remove the check mark from images that have been set to 
Apple RGB, ColorMatch RGB or Wide Gamut RGB color space (p.77, 
p.93), the ICC profiles are embedded automatically. 

*3 The setting range is 1 to 10. The higher the numerical value, the higher 
the image quality becomes.

*4 The larger of the two values set in [Width] and [Height] is applied to the 
longer edge of an image and change its size.

Types of image

Type of image Extension
Exif-JPEG .JPG

Exif-TIFF 8bit .TIF
TIFF 16bit .TIF

Exif-Tiff 8bit+Exif-JPEG .TIF/.JPG
TIFF 16bit+Exif-JPEG .TIF/.JPG

File name

Resolution*1

Embeds of ICC profiles*2 (p.143)

Size changing*4

Save destination

Save

JPEG compression rate*3
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List of Trimming/Angle Adjustment Window Functions (p.38, p.111)

Full screen display/returns to normal screen

Ratio of trimming range (you can also enter 
numerical values if you have selected [Custom])*1

Upper left coordinates of trimmed range (you 
can also enter numerical values)
Size of trimmed range (you can also enter 
numerical values)

Copies the trimmed range and applies (pastes) 
it to another image*2

Displays borders around a trimmed range

Switches between displayed images*2

Level of opacity outside a trimmed range

*1 If [Free] has been selected in the [Aspect ratio] list box, you can also 
drag the borders of the trimmed range to change its range.

*2 Operates when you have selected multiple images and the trimming/
angle adjustment window is displayed.

Trimming range

Applies the copied trimming range to all other 
images*2

Cancels all the trimming (aspect ratio) information

Reverts to the condition when the image was shot

Angle of image adjusted
(Drag bar, use the mouse to click S/T or enter 
numerical values to set angle)

Shows/hides grid lines
(Drag bar to set distance between grid lines)

Image rotation (90-degree increments)

Displays the trimming range in the center of the 
window
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List of Lens Aberration Correction Window Functions (p.65)

*1 The area you clicked on the image (Enlargement display position) is 
displayed at 200%.

Peripheral illumination correction

Chromatic aberration correction

Color blur correction

Shooting distance information 
slider*2 (p.68)

Shows/hides position of 
enlargement display section

Grid display

Enlargement display section*1

Reverts to the condition when the 
image was shot

Corrects blue chromatic aberration

Corrects red chromatic 
aberration

Enlargement display position 
(Navigator display)

O When the list box for selecting an extender is displayed in the 
[Lens aberration correction] window, select the extender 
attached at the time of shooting from the list box.

Distortion correction

O To correct distortion aberration of images shot with a fisheye lens, 
four effects can be selected from the [Effect] list box in addition to 
[Shot settings] normally used for distortion correction.

*2 For RAW images shot with MP-E 65mm f/2.8 1-5x Macro Photo or EF 
50mm f/2.5 Compact Macro with Life Size Converter EF, the slider 
indicator changes to the zoom magnification.
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List of Digital Lens Optimizer Adjustment Window Functions (p.69)

*1 The area you clicked on the image being enlarged (Enlargement display position) is displayed at 100%.

Shooting distance slider (p.72)

Digital Lens Optimizer adjustment (p.72)

Enlargement display position (Navigator display)

Enlargement display section*1 
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List of Compositing Tool Window Functions (p.78)

100% display (p.79)

Select foreground image (p.79)

Thumbnail display for foreground 
image (p.79)

Select composite method (p.79)
Use RAW compositing (p.80)

Weighting slider (p.79)

Alignment controls (p.80)

Continue compositing (p.81)
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List of HDR Window (Adjust Image) Functions (p.81)

Select an effect (p.83)

Adjust tone/color (p.83)

Adjust detail emphasis (p.83)CO
PY
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List of Copy Stamp Window Functions (p.73 to p.77, p.114 to p.118)

Full screen display/returns to normal screen

Restores/redoes the image

Switches between displayed images*

Copies the dust erasure range or copy range and 
applies (pastes) it to another image

* Operates when you have selected multiple images and the copy 
stamp window is displayed.

Applies Dust Delete Data (p.73, p.114)
Types of dust to be erased (p.75, p.116)
Specifies the copy source (p.77, p.118)
Fixes the copy source position (p.77, p.118)
Types of stamps (p.77, p.118)
Sets the size of the dust erasure range (p.75, 
p.116) or copy range (p.77, p.118) in a range of 
5 to 100 (in one pixel units) (you can also enter 
a numerical value)

CO
PY



141

1
2
3
4
5

Introduction

Contents at 
a Glance

Basic 
Operation

Advanced 
Operation

Advanced 
Image Editing 
and Printing

Editing 
JPEG/TIFF 

Images

Index

Processing 
Large Numbers 

of Images

Reference

List of Convert/Save Multiple Images Window (Batch Processing) Functions (p.99)

*1 The setting range is 1 to 60,000 dpi.
*2 Color space (p.77, p.93) information that is set in an image is attached 

to an ICC profile.
Even if you remove the check mark from images that have been set to 
Apple RGB, ColorMatch RGB or Wide Gamut RGB color space (p.77, 
p.93), the ICC profiles are embedded automatically.

*3 The setting range is 1 to 10. The higher the numerical value, the higher 
the image quality becomes.

*4 The larger of the two values set in [Width] and [Height] is applied to the 
longer edge of an image and change its size.

*5 Appears when you click the [Batch process] button (p.124, p.133) 
without an image selected in the main window or the edit image 
window. To convert RAW images only, instead of clicking the [Execute] 
button, click this button.

File names of images to be 
batch saved Embeds ICC profiles*2 (p.143)

Resolution*1

Size changing*4

Images to be converted are limited to RAW images*5

Save destination

JPEG compression rate*3

File name

Types of image

Type of image Extension
Exif-JPEG .JPG

Exif-TIFF 8bit .TIF
TIFF 16bit .TIF

Exif-Tiff 8bit+Exif-JPEG .TIF/.JPG
TIFF 16bit+Exif-JPEG .TIF/.JPG

Save

Batch transfer to other image 
editing software (p.100)
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List of Rename Window Functions (p.101)

Order in which images are sorted

Sets the new file name

Sets the format of information 
in the file nameCheck mark to apply the same 

name to RAW images and JPEG 
images recorded simultaneously

Check mark to copy the images
Click the [Browse] button and set 
the save destination
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Glossary
RAW image
EOS DIGITAL camera RAW images are recorded in an uncompressed 
14bit or 12bit format.
Because RAW images are special images in an undeveloped status, 
you need software with development processing functions such as DPP 
in order to view them. The advantage of the undeveloped RAW images 
is that you can make a variety of adjustments to RAW images with 
almost no deterioration of the image.
* “RAW” meaning “in a natural condition” or “not processed or refined”.

JPEG image
The most ordinary image in non-reversible compressed 8bit format. 
The advantage of this is that by saving at a high compression rate, the 
file size can be small, even for image data that has a high pixel count. 
Because during saving and compression part of the data is thinned out 
to make the file size small, every time you edit or save, the image 
deteriorates.
With DPP, even if you repeat editing/saving, only the recipe data is 
modified, and no overwriting or compression occurs so the original 
image data does not deteriorate.
* JPEG is an abbreviation of “Joint Photographic Experts Group”.

TIFF image
Bitmap-format image recorded in a 8bit/16bit uncompressed format.
Because TIFF images are in uncompressed format, they are suitable for 
saving an image while maintaining the original high image quality.
* TIFF is an abbreviation of “Tagged Image File Format”.

Recipe
The “Image processing conditions information” for RAW images that can 
be edited in DPP is called a “recipe”.
Further, in DPP, you can perform image editing on JPEG and TIFF 
images that use “recipes” as with RAW images.

bit number
Binary unit of information volume in the color of an image. The number 
shows the number of bits per pixel.
The larger the number of bits, the more the color numbers and the 
gradation becomes smoother. A one-bit image is a black-and-white 
image.

Color Management System (Color Matching)
Digital cameras that shoot images, monitors that display images, and 
printers that print images each have a different way of creating color. For 
this reason, there may be a difference between the color of an image 
when viewed on a monitor and when printed.
A color management system is a system for managing color in order to 
bring these colors closer together. With DPP, you can more closely 
match color between different devices using ICC profiles between 
different devices.

ICC profiles
ICC profiles are files containing color information such as color 
characteristics and color space for various devices, set by the ICC 
(International Color Consortium). Most devices such as the monitor we 
use to view images or the printer we use to print images can be 
managed (color management) using these ICC profiles and the color 
between different devices can be more closely matched.
DPP has color management that uses these ICC profiles.

Tone Curve
A tone curve shows values before adjustment (input) as the horizontal 
axis on a graph, and the values after adjustment (output) as the vertical 
axis. Since the values of before adjustment and after adjustment are the 
same before any adjustment is made, the tone curve displays as a 
straight line from bottom left to top right, and by changing this tone 
curve, you can adjust in detail the image’s brightness, contrast and 
color. The more you go right on the horizontal axis, the more the plus 
value it becomes, and the higher you go on the vertical axis, the more 
the plus value it becomes.
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Color space
A color space is the reproducible color range (color gamut 
characteristics). DPP supports the following five kinds of color space.
sRGB : Standard color space for Windows. Widely used for 

the standard color space of monitors, digital 
cameras, and scanners.

Adobe RGB : A wider color space than sRGB. Mainly used for 
printing for business purposes.

Apple RGB : Standard color space for Macintosh. A slightly 
wider color space than sRGB.

ColorMatch RGB : A slightly wider color space than sRGB. Mainly 
used for printing for business purposes.

Wide Gamut RGB : A wider color space than Adobe RGB.
Refer to the color chart below for the color area of each color space.

Color chart of color spaces compatible with DPP

Color range that can be 
seen by the human eye

Gamma 
value

White point 
(color temp.)

sRGB 2.2 6500K(D65)
Adobe RGB 2.2 6500K(D65)
Apple RGB 1.8 6500K(D65)
ColorMatch RGB 1.8 5000K(D50)
Wide Gamut RGB 2.2 5000K(D50)

CMYK simulation profiles
A profile that simulates colors when printing in a CMYK environment 
(printing machine, etc.). With DPP, you can simulate color with four 
types of profile.
Euro Standard : Profile normally used for book printing in 

Europe, suitable for simulation of standard 
European printing.

JMPA : Profile normally used for book printing, etc. in 
Japan, suitable for simulation of magazine 
advertising standard color printing.

U.S.Web Coated : Profile normally used for book printing in 
North America, suitable for simulation of 
North American standard printing.

JapanColor2001 type3 : Profile becoming a standard in the Japanese 
printing industry, suitable for simulation of 
JapanColor standard printing.

Rendering intent
Rendering intents are color conversion methods when printing an image. 
The conversion method of each rendering intent is shown below.
Perceptual : Before and after conversion, all colors are 

converted to maintain the relationship between 
colors. Even where colors slightly change, you 
can print a natural-looking image which has 
maintained color harmony. However, 
depending on the image, the saturation may 
change overall.

Relative Colorimetric : There will not be much conversion to colors 
which are similar before and after conversion, 
but colors which are not similar are converted 
appropriately. Because there are little changes 
to similar colors which comprise most of an 
image, you can print a natural-looking image in 
which the saturation has not changed greatly. 
However, depending on the image, there are 
cases where the overall tone of an image 
changes somewhat as colors which are not 
similar and highlights change.
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Index
A
Adjust JPEG Images.........................................................................  103
Adjust RAW Images............................................................................  25
Adjust TIFF Images...........................................................................  103
Adjusting (JPEG or TIFF Image)

Automatic Adjustment (Tone Curve Assist)................................  104
Brightness ..................................................................................  105
Click White Balance ...................................................................  106
Contrast......................................................................................  105
Dynamic Range..........................................................................  109
Hue.............................................................................................  107
RGB Tool Palette .......................................................................  128
Saturation ...................................................................................  107
Sharpness ..................................................................................  107
Tone Curve Adjustment..............................................................  108

Adjusting (RAW image)
Apply Adjustments........................................................................  97
Automatic Adjustment (Tone Curve Assist)..................................  33
Brightness ....................................................................................  26
Brightness of Highlights................................................................  57
Brightness of Shadows.................................................................  57
Click White Balance .....................................................................  28
Color Saturation ...........................................................................  29
Color Temperature .......................................................................  56
Color Tone....................................................................................  29
Color Wheel..................................................................................  56
Contrast........................................................................................  29
Copy Adjustments ........................................................................  97
Dynamic Range............................................................................  57
Filter Effect ...................................................................................  30
Monochrome ................................................................................  30
Personal White Balance ...............................................................  98
Picture Style .................................................................................  26
Picture Style File ..........................................................................  59
RAW Tool Palette.......................................................................  128
Save Adjustments ........................................................................  97
Tone Curve Adjustment................................................................  58
Toning Effect ................................................................................  30
Tool Palette ........................................................................  128, 129
White Balance ..............................................................................  27

Adjustment Contents (Recipe)..................................................... 96, 143
Adobe RGB ....................................................................................... 144
Apple RGB......................................................................................... 144
Arrange Images ............................................................................. 20, 21
Auto Lighting Optimizer ....................................................................... 61
Automatic Adjustment (Tone Curve Assist)................................. 33, 104
Automatic Dust Erasure Processing.............................. 73, 74, 114, 115

B
Batch Apply White Balance to Images (Personal White Balance)....... 98
Batch Change the File Name of Images............................................ 101
Batch Convert/Save Images (Batch Process) ..................................... 99
Batch Process (Batch Save JPEG and TIFF Images)................. 99, 141
Batch Process of Multiple Images

Change File Name ...................................................................... 101
Convert/Save (Batch Process).............................................. 99, 141
Personal White Balance................................................................ 98
Recipe Data .................................................................................. 96
Transfer....................................................................................... 100

Batch Settings Window........................................................ 99, 100, 141
Batch Transfer Images ...................................................................... 100
Batch Transfer Images to Image Editing Software ............................ 100
Before/After Comparison Display ........................................................ 53
bit Number ......................................................................................... 143
Bookmark ............................................................................................ 51
Brightness.................................................................................... 26, 105

C
Change File Name............................................................................. 101
Changing the File Name of Images in the Order in the Main 
Window.............................................................................................. 101
Check Mark ................................................................... 18, 19, 126, 132
Chromatic Aberration Correction ......................................................... 65
Chrominance Noise Reduction (JPEG, TIFF Images)....................... 110
Chrominance Noise Reduction (RAW Images) ................................... 62
Click White Balance..................................................................... 28, 106
CMYK Simulation .................................................................. 93, 94, 144
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Collection Window ..................................................................  6, 36, 125
Color Blur Correction ..........................................................................  65
Color Chart........................................................................................  144
Color Management (Color Matching)................................................  143

Color Setting of the Monitor (Profiles) ..........................................  93
Color Setting of the Printer (Profiles)......................................  93, 94
Color Space................................................................................  144
ICC Profiles ................................................................................  143

Color Management (Preferences).......................................................  93
Color Saturation ..................................................................................  29
Color Setting of the Monitor (Profiles).................................................  93
Color Setting of the Printer (Profiles) ............................................  93, 94
Color Space ......................................................................................  144

Adobe RGB ................................................................................  144
Apple RGB .................................................................................  144
Color Space Setting for Each Image ............................................  77
ColorMatch RGB ........................................................................  144
Default Setting of Color Space .....................................................  93
sRGB..........................................................................................  144
Wide Gamut RGB.......................................................................  144

Color Space Setting for Each Image...................................................  77
Color Temperature..............................................................................  56
Color Tone ..........................................................................................  29
Color Wheel ........................................................................................  56
ColorMatch RGB...............................................................................  144
Compatible Cameras with the Lens Aberration Correction Function ..  63
Compatible Lenses with the Lens Aberration Correction Function .....  63
Compositing Images ...........................................................................  78
Contact Sheet Printing (Printing a Thumbnail List) .............................  86
Contrast ......................................................................................  29, 105
Convert to JPEG or TIFF Image and Save ...................  42, 99, 134, 141
Convert/save One Image Window ..............................................  42, 134
Copy Stamp (Image Correction) .................................................  77, 118
Copy Stamp Window ............................................  73, 75, 114, 116, 140
Copying and Pasting (Applying) Recipes............................................  97
Correct Images (Copy Stamp Function) .....................................  77, 118
Creating a Folder ................................................................................  50

D
Default Noise Reduction Settings........................................................ 92
Default Setting of Color Space ............................................................ 93
Delete Images ..................................................................................... 49
Deleting

Delete Images............................................................................... 49
Delete the Software .................................................................... 123

Deleting DPP (Uninstalling) ............................................................... 123
Detailed Setting Printing (Printing with Shooting Information)............. 85
Digital Lens Optimizer ......................................................................... 69
Display

Before/After Comparison Display.................................................. 53
Enlarged Display (Edit Window) ........................................... 11, 127
Enlarged Display (Quick Check Window) ............................. 16, 132
Shooting Information Display .................................................. 10, 23
Single Image Display .................................................................... 22
Synchronize Edit Window ............................................................. 54
Thumbnail Display (Main Window)........................................ 10, 124
Thumbnail Display and Enlarged Display 
(Edit Image Window)............................................................. 34, 133

Distortion Correction............................................................................ 65
Downloading an Image to Your Computer ............................................ 7

Downloading Images from a Camera ............................................. 7
Downloading Images from a Card Reader...................................... 9

Downloading Images ............................................................................. 7
Downloading Images from a Camera .................................................... 7
Downloading Images from a Card Reader ............................................ 9
Dust Delete Data ........................................................... 73, 74, 114, 115
Dust Erasure Processing

Automatic Dust Erasure Processing ..................................... 73, 114
Image Correction (Copy Stamp Function) ............................ 77, 118
Manual Dust Erasure (Repair Function) ............................... 75, 116

Dynamic Range ........................................................................... 57, 109

E
Edit Image Window...................................................................... 34, 133
Edit Window................................................................................. 11, 127
Editing................................................................................................ 145JAdjusting
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Enlarged Display (Edit Window) .................................................  11, 127
Enlarged Display (Quick Check Window) .........................................  132
EOS Utility.............................................................................................  7

F
False Color Reduction ..................................................................  89, 90
Filter Effect..........................................................................................  30
Folder Window..............................................................................  6, 124

G
General Settings (Preferences) ..........................................................  89

H
HDR (High Dynamic Range) Images ..................................................  81
Help.......................................................................................................  0
Highlight Area Warning Indicator ........................................................  55
Hue ...................................................................................................  107

I
ICC Profiles.......................................................................................  143
Image Frame Information (Image Marks) .........................................  126
Image Marks (Image Frame Information) .........................................  126
Image Quality

Default Noise Reduction Settings.................................................  92
False Color Reduction............................................................  89, 90
Improve the Quality of an Image (Main Window) .........................  23
Noise Reduction of a JPEG Image (Luminance, Chrominance)  110
Noise Reduction of a RAW Image (Luminance, Chrominance) ...  62
View and Save a RAW Image ................................................  89, 90

Image Shooting Information Display .............................................  10, 23
Improve the Quality of an Image (Main Window)................................  23

J
JPEG Image......................................................................................  143

L
Lens Aberration Correction .................................................................  63
Lens Aberration Correction Window ...........................................  65, 136
LENS Tool Palette ............................................................................  130
Linear ..................................................................................................  29
Loading and Pasting (Applying) Recipes ............................................  97

Luminance Noise Reduction (JPEG, TIFF Images) .......................... 110
Luminance Noise Reduction (RAW Images) ....................................... 62

M
Main Window............................................................................... 10, 124
Manual Dust Erasure (Repair Function) ...................................... 75, 116
Map Utility............................................................................................ 84
Monochrome........................................................................................ 30

Filter Effect .................................................................................... 30
Toning Effect ................................................................................. 30

Move or Copy Folders ......................................................................... 51
Move or Copy Images ......................................................................... 50

N
Noise Reduction (JPEG or TIFF Image)............................................ 110
Noise Reduction (RAW Image) ........................................................... 62
Noise Reduction of a JPEG Image (Luminance, Chrominance) ....... 110
Noise Reduction of a RAW Image (Luminance, Chrominance) .......... 62
NR Preview Window............................................................ 62, 110, 131
NR/ALO Tool Palette ......................................................................... 129

O
Organize Images ................................................................................. 49
Organizing Images .............................................................................. 49

Create a Folder ............................................................................. 50
Delete Images............................................................................... 49
Move or Copy Folders................................................................... 51
Move or Copy Images................................................................... 50
Register Folders as Bookmarks.................................................... 51

P
Peripheral Illumination Correction ....................................................... 65
Personal White Balance ...................................................................... 98
Picture Style ........................................................................................ 26
Picture Style File.................................................................................. 59
Preferences ......................................................................................... 89

Color Management ....................................................................... 93
General Settings ........................................................................... 89
Tool Palette................................................................................... 92
View Settings ................................................................................ 91
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Printing
Printing a Thumbnail List (Contact Sheet Printing) ......................  86
Printing One Sheet of Paper ..................................................  14, 49
Printing Using Easy-PhotoPrint ....................................................  46
Printing Using Easy-PhotoPrint EX ..............................................  43
Printing with a High-End Canon Printer........................................  87
Printing with a Large-Format Canon Printer .................................  88
Printing with a Printer other than Canon Printers .........................  49
Printing with Canon Inkjet Printers .........................................  43, 46
Printing with Easy-PhotoPrint Pro ................................................  87
Printing with Shooting Information (Detailed Setting Printing)......  85
Rendering Intents when Using Easy-PhotoPrint ....................  93, 94

Printing a Thumbnail List (Contact Sheet Printing) .............................  86
Printing One Sheet of Paper .........................................................  14, 49
Printing Using Easy-PhotoPrint...........................................................  46
Printing Using Easy-PhotoPrint EX.....................................................  43
Printing with a High-End Canon Printer ..............................................  87
Printing with a Large-Format Canon Printer .......................................  88
Printing with a Printer other than Canon Printers................................  49
Printing with Canon Inkjet Printers................................................  43, 46
Printing with Easy-PhotoPrint Pro.......................................................  87
Printing with Shooting Information (Detailed Setting Printing) ............  85

Q
Quick Check Window..................................................................  16, 132
Quitting DPP .......................................................................................  14

R
Rating....................................................................................  18, 19, 132
RAW Image.......................................................................................  143
RAW Tool Palette .............................................................................  128
Re-Adjusting an Image ...............................................................  43, 120
Recipe.........................................................................................  96, 143
Recipe File ..........................................................................................  96
Re-Editing an Image ...................................................................  43, 120
Registering Folders as Bookmarks .....................................................  51
Rename Window.......................................................................  101, 142
Rendering Intent (Matching Method) ................................................  144

Rendering Intents when Using Easy-PhotoPrint ..................... 93, 94
Rendering Intents when Using Easy-PhotoPrint ........................... 93, 94
Repair (Manual Dust Erasure)..................................................... 75, 116
RGB Tool Palette............................................................................... 128
Rotate Images ............................................... 10, 25, 124, 125, 132, 133

S
Saturation .......................................................................................... 107
Save

Batch Convert/Save Images (Batch Process)....................... 99, 141
Convert to JPEG or TIFF Images and Save ......................... 42, 134
Save...................................................................................... 41, 119
Save As................................................................................. 41, 119
Save JPEG or TIFF Image as a Separate Image ....................... 119
View and Save RAW Images.................................................. 89, 90

Save As ....................................................................................... 41, 119
Saving Recipes.................................................................................... 97
Select Images.......................................................................... 10, 16, 34
Shadow Area Warning Indicator.......................................................... 55
Sharpness ................................................................................... 31, 107
Shooting Information Display......................................................... 10, 23
Shortcut Keys ........................................................................................ 0
Single Image Display........................................................................... 22
Single Image Display of RAW and JPEG Image ................................. 22
Sorting Images

Check marks ........................................................................... 18, 19
Ratings.................................................................................... 18, 19

sRGB................................................................................................. 144
Starting up DPP..................................................................................... 6
Supported Images ................................................................................. 3
Synchronization (Edit Window)............................................................ 54
Synchronize Edit Windows .................................................................. 54
Synchronize Images ............................................................................ 54
System Requirements ........................................................................... 3

T
Thumbnail Display (Main Window) .............................................. 10, 124

Change the Display....................................................................... 10
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Thumbnail Display and Enlarged Display (Edit Image Window).........  34
Thumbnail Display of Images (Main Window).....................................  10

Change the Display ......................................................................  10
TIFF Image .......................................................................................  143
Tone Curve .......................................................................................  143
Tone Curve Adjustment ..............................................................  58, 108
Tone Curve Assist (Automatic Adjustment) ................................  33, 104
Toning Effect.......................................................................................  30
Tool Palette

LENS Tool Palette......................................................................  130
NR/ALO Tool Palette..................................................................  129
RAW Tool Palette.......................................................................  128
RGB Tool Palette .......................................................................  128

Tool Palette (Preferences) ..................................................................  92
Transfer

Batch Transfer Images to Image Editing Software.....................  100
Transfer an Image to Photoshop..................................................  77

Transfer an Image to Photoshop ........................................................  77
Trimming and Adjusting the Angle of an Image ..........................  38, 111
Trimming/Angle Adjustment Window..................................  38, 111, 135

U
Unsharp mask.....................................................................................  32

V
View Settings (Preferences) ...............................................................  91

W
White Balance.....................................................................................  27

Click White Balance .............................................................  28, 106
Color Temperature .......................................................................  56
Color Wheel..................................................................................  56
Personal White Balance ...............................................................  98

Wide Gamut RGB .............................................................................  144
Work Color Space...............................................................................  77

About This Instruction Manual
O It is prohibited to reproduce, in whole or part, the contents of this 

Instruction Manual without permission.
O Canon may change without notice the software specifications and 

contents of this Instruction Manual.
O The software screens and displays printed in this Instruction Manual 

may differ slightly from the actual software.
O The content of this Instruction Manual has been reviewed thoroughly. 

However, if you should notice any errors or omissions, please contact 
a Canon Service Center.

O Please note that irrespective of the above-mentioned, Canon does 
not take responsibility for the outcome of the operation of the 
software.
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O Macintosh is a trademark of Apple Inc., registered in the United States 

and other countries.
O Adobe and Photoshop are registered trademarks or trademarks of 

Adobe Systems Incorporated in the United States and/or other 
countries.
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